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tributors may be used to endorse or promote products derived from this software

without specific prior written permission.

Dragon 12 Installation and User Guide

v



THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CON-

TRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUD-

ING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-

CLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CON-

TRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER

CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANYWAYOUT OF THE USE OF THIS SOFTWARE, EVEN IF

ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Dave Barry in Cyberspace, © Copyright 1996 by Dave Barry. Published by Crown Publishers.

2001: A Space Odyssey, © Copyright 1968 by Arthur C. Clarke. Published by New Amer-

ican Library.

3001: The Final Odyssey, © Copyright 1997 by Arthur C. Clarke. Published by Har-

perCollins Publishers.

Dogbert's Top Secret Management Handbook, © Copyright 1996 by United Feature Syndicate,

Inc. Published by HarperBusiness, a division of HarperCollins Publishers.

Success Is a Journey: 7 Steps to Achieving Success& in the Business of Life, © Copyright 1999 by

Jeffrey J. Mayer. Published by McGraw Hill.

Charlie and the Chocolate Factory, © Copyright 1964 by Roald Dahl. Published by Alfred A.

Knopf, Inc. and Penguin Books.

Charlie and the Great Glass Elevator, © Copyright 1972 by Roald Dahl. Published by Alfred

A. Knopf, Inc. and Penguin Books.

To Be a Man, © Copyright 1997 by Eugene and Miranda Pool.

The Captain of Battery Park, © Copyright 1978 by Eugene Pool. Published by Addison-Wes-

ley.

QR code is trademarked by Denso Wave, inc.

libqrencode 3.1.1 - QR Code encoding library - Copyright (C) 2006, 2007, 2008, 2009,

2010 Kentaro Fukuchi.

Reed-Solomon code encoder - Copyright (C) 2002, 2003, 2004, 2006 Phil Karn, KA9Q.

Copyright © 2007 James Newton-King

Permission is hereby granted, free of charge, to any person obtaining a copy of this soft-

ware and associated documentation files (the "Software"), to deal in the Software without

Copyright

vi



restriction, including without limitation the rights to use, copy, modify, merge, publish,

distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom

the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or

substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THEWAR-

RANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE

AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPY-

RIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIA-

BILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,

ARISING FROM, OUT OF OR IN CONNECTIONWITH THE SOFTWARE OR

THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Dragon 12 Installation and User Guide

vii





Contents

Copyright iii

Chapter 1: What's New in Dragon Version 12 17
Chapter 2: Installing Dragon 25

Installation and User Profile Creation 25
Dragon system requirements 26
What you should know before installing 28
Installation Prerequisites 30
Installing Software - Typical Installation 31
Installing Software - Custom Installation 32
Modifying application settings for all users 34
Modifying formatting options for all users 35
Creating your user profile 36
Setting up, positioning, and checking your microphone 38
Training a new user profile 39
Adapting to your writing style and scheduling tuning 41
How Dragon automatically configures user profiles 43
Upgrading User Profiles 43
Version 12 File Structure 45
Accessing log files, samples, and tools 47
Activating Dragon 48

Chapter 3: Getting Started 50
About Dragon 50
Using Dragon Help 51
About dictation 52
About the Results Display 53

Using the DragonBar 55
The DragonBar 55
The Text Control Indicator 59
Displaying the DragonBar 59
Controlling the DragonBar 61

Using the Microphone 63
Choose a speech device 63
Position your microphone properly 65

Using the Dragon Sidebar 67

Contents

ix



Using the Dragon Sidebar 67
The Dragon Sidebar tabs 70
Dragon Sidebar Tips 72

Chapter 4: Dictating Text 73
Dictation Basics 73
Undoing actions 74
Correcting text errors as you dictate 75
Dictation commands 76
Typing or spelling text 77
Spelling words 78
Dictating numbers 80

Using the Dictation Box 83
Using the Dictation Box 83
Using Dictation Box in unsupported applications 83
Turning off the Dictation Box 83
Unsupported applications 83
Transferring your text 84
The Full Text Control Indicator 84
Dictating in unknown text fields 85
Editing text in unknown text fields 85
Defining how the Dictation Box works in different applications 85
Unexpected behavior or text in the Dictation Box 86
Dictation Box Settings 86

Using DragonPad 89
About DragonPad 89
Changing the way text wraps on your screen 89

Chapter 5: Making Corrections 90
Correcting dictation - workflow 90
Using Smart Format Rules 93
Correcting text - quick reference 93
Choosing the correct text 95
Correcting misrecognized commands 96

Chapter 6: Revising Text 97
Using Direct Editing commands 98
Handling multiple text matches 99
Revising text - quick reference 103

Moving around in a document 106
Moving the insertion point 106
Moving to specific words 108

Contents

x



Moving to the beginning or end of a document or line 108
Using "Go Back" to move the cursor 109

Selecting text 110
Selecting text - quick reference 110
Selecting characters and words 110
Selecting specific words or phrases 111
Selecting lines and paragraphs 112
Selecting text again 113
Changing an incorrect text selection 113

Deleting, Cutting, and Copying Text 115
Cutting, copying, and pasting 115
Deleting dictated text 115
Deleting characters, words, lines, or paragraphs 116
Deleting by backspacing 116

Formatting 118
Formatting text 118
Formatting numbers 120
Setting font name, size, and style 120
Aligning text 121
Adding new lines and paragraphs 121
Hyphenating words 121
Joining words 122
Setting Auto-Formatting Options 122
Using Smart Format Rules 122
Creating Word Properties 123

Chapter 7: Working in Programs 127
Scrolling in popular programs 128
Using the Microsoft Office ribbon 128

About spoken commands in word processing programs 132
About spoken commands in word processing programs 132
Dictating in your word processor 132

Working with Microsoft Word 134
Basic document commands in Microsoft Word 134
Selecting text 139
Formatting text in Microsoft Word 140

Email Programs 142
Supported e-mail programs 142
Working in e-mail programs 142
Dictating e-mail and Web addresses 144

Contents

xi



Dictating E-mail and Calendar commands 145
Commands for Microsoft Outlook Express, Windows Mail, and Windows Live Mail 147

Microsoft Outlook 149
Working with Microsoft Outlook 149
Reading and sending e-mail with Microsoft Outlook 149
Making appointments in Microsoft Outlook 151
Adding contacts in Microsoft Outlook 151
Writing notes in Microsoft Outlook 152
Using other Microsoft Outlook commands 152

Microsoft Excel 155
Working with Microsoft Excel 155
Dictating in Microsoft Excel with Full Text Control 155
Basic commands for Microsoft Excel 156
Formatting a Microsoft Excel spreadsheet 159
Working with cell contents in Microsoft Excel 160

Chapter 8: Working with Web applications 163
Using Rich Internet Application extensions 163
Browser requirements for Web application support 165
Enabling Web application support 165
How to tell if Web application support is active 167
Using Gmail 168
Using Hotmail 170
Editing text in a supported Web application 173
Using Dragon's Web capabilities without RIA 175
If you have problems using Web application support 176

Chapter 9: Working with Web browsers 181
Working with a Web browser 181
Searching the Web by voice 182
Web browser commands 186
Internet Explorer commands 189
Using tabs in Firefox 191

Chapter 10: Working on Your Desktop 193
Starting and exiting programs 193
Using Windows Desktop commands 195
Controlling menus 197
Selecting buttons and dialog box options 198
Selecting tabs in a dialog box 199
Resizing and closing windows 199
Selecting and opening icons 200

Contents

xii



Scrolling in windows and lists 200
Searching your Desktop by voice 201
Switching between programs and windows 202

Chapter 11: Controlling the Mouse and Keyboard 205
Controlling the keyboard 205
Moving the mouse pointer 207
Positioning the mouse pointer with MouseGrid 208
Clicking and dragging the mouse 209

Chapter 12: Improving recognition accuracy 211
Top 10 ways to improve accuracy 211
Using Smart Format Rules 213
Adjusting Speed vs. Accuracy 220

The Dragon Accuracy Center 221
Using the Accuracy Center 221
About the Accuracy Assistant 222
Running the Acoustic and Language Model Optimizer 222

Recognition Modes 224
Using Recognition Modes 224
Switching recognition modes 226

Teaching Dragon to Understand You Better 227
Training misrecognized commands 227
Training individual words and phrases 228
Using punctuation with written and spoken forms 228
Supplemental training 229

Personalizing your Dragon Vocabulary 231
About personalizing your Vocabulary 231
Adding words or phrases to your Vocabulary 232
Using punctuation with written and spoken forms 232
Learning from specific documents 233
Importing lists of words or phrases 234
Adding words with the Spelling window 235
Learn From Sent E-mails 235
Adding contact names to the Vocabulary 236
Deleting words 237
Using the Don't Recognize That Word Command 239

Managing Vocabularies 240
About Vocabularies 240
Opening Vocabularies 250
Adding a Vocabulary to a User Profile 251

Contents

xiii



Deleting Vocabularies 252
Renaming Vocabularies 252
Importing Vocabularies 253
Exporting Vocabularies 254

Chapter 13: Using the Command Browser 255
About the Command Browser 255
Opening the Command Browser 256
Finding commands in the Command Browser 257
Training commands in the Command Browser 259

The Dragon Glossary 261
.DRA files (definition) 261
Dragon Accuracy Center (definition) 261
Accuracy Slider (definition) 261
Accuracy Tuning (definition) 261
Acoustic and Language Model Optimization (definition) 261
Acoustic Optimizer (definition) 262
Active vocabulary (definition) 262
Advanced Scripting (definition) 262
Anchored (definition) 262
AutoTranscribe Folder Agent (definition) 262
Base Vocabulary (definition) 262
Basic Text Control (definition) 263
Backup dictionary (definition) 263
Command Browser (definition) 264
Command Mode (definition) 264
Correction menu (definition) 264
Correction-only mode (definition) 264
Custom word (definition) 264
Data Collection (definition) 264
Data Distribution Tool (definition) 265
Dictation Box (definition) 265
Dictation Mode (definition) 265
Dictation Source (definition) 265
Direct Editing commands (definition) 265
DragonPad (definition) 265
Dragon Templates with Voice Fields (definition) 265
Dragon Voice Shortcuts (definition) 266
Enterprise Profile Management (definition) 266
Field (definition) 266

Contents

xiv



Full Text Control (definition) 266
Hidden Mode (definition) 266
Language Model (definition) 267
Language Model optimization (definition) 267
Language Model Optimizer (definition) 267
Local Roaming User Profile (definition) 267
Master Roaming User Profile (definition) 267
MSI (definition) 267
Multiple Dictation Sources (definition) 267
NaturalText (definition) 267
Natural Language Commands (definition) 268
Normal Mode (definition) 268
Nothing But Speech (definition) 268
Numbers Mode (definition) 268
Performance Assistant (definition) 268
Press <key> command (definition) 268
QuickStart (definition) 268
Recognition Modes (definition) 269
Results Box (definition) 269
Results Display (definition) 269
Rich Internet Application (RIA) extensions (definition) 269
Roaming User Profile (definition) 269
Sample Commands (definition) 269
Say What You See (definition) 269
Scripting (definition) 270
Section 508 certified (definition) 270
Unknown text field (definition) 270
Windows shortcut (definition) 270
Spell Command (definition) 270
Spell Mode (definition) 270
Spoken Form (definition) 270
Structured Commands (definition) 271
Text Control Indicator (definition) 271
Templates (definition) 271
TTS (definition) 271
Unanchored (definition) 271
User Profile (definition) 271
Utterance (definition) 272
Variable (definition) 272

Contents

xv



Vocabulary (definition) 272
Vocabulary Editor (definition) 272
VocTool 272
Voice Notations (definition) 272
Wave Data (definition) 272
Web application support (definition) 272
Word Category (definition) 272
Word Properties (definition) 272
Written Form (definition) 273

Index 275

Contents

xvi



Dragon 12 Installation and User Guide

Chapter 1: What's New in
Dragon Version 12

Here is a list of new features in Dragon 12. You'll find the information under the following

categories:

n Dragon is now easier to use

n Changes that make Dragon faster and more accurate

n How you'll be more productive with Dragon

n And there's more

Dragon is now easier to use
Smart Format Rules:
Set up auto-formatting and word properties on the fly

When you make a correction related to formatting, such as abbreviations, titles, units of meas-

ure, or alternate written forms, Dragon displays its Smart Format Rules box, offering to

change one of its Auto-Formatting Options or Word Property settings.

You can change settings yourself from the Auto-Formatting Options dialog box or the Vocab-

ulary Editor, as in previous versions. The Smart Format Rules feature simply "reaches out" to

you, making it quick and easy for you to adjust the settings you care about.

Here is an example of the Smart Format Rules dialog box:

For more information, see Using Smart Format Rules.
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Rich Internet Application support:
Enhanced experience for Gmail and Hotmail

In addition to its existing functionality for Web browsers, Dragon 12 includes browser

extensions – also known as plug-ins or add-ons – for the popular Web-based applications

Gmail and Hotmail. These extensions give you Full Text Control in text fields, and enable

spoken commands for important tasks.

Important: In Dragon 12.0, this feature works with

n Internet Explorer 9 (32-bit)

n Mozilla Firefox 12 or higher, and

n Google Chrome 16 or higher

For more information, see Using Rich Internet Application extensions.

Require "Click":
Always, sometimes, or never

Now you say "Click" by default

To distinguish commands from dictation, Dragon now waits for you to say "Click <menu

name >" or "Click <tab name>" to open menus or tabs on the Microsoft Office ribbon, or

"Click <button name or list box name>" to select dialog box controls. For example, to open the

Home tab on the ribbon, you would say "Click Home" rather than just "Home."

Now you can require "Click" for menus or controls separately

Also, the former combined Require "Click" option has been divided to give you finer con-

trol. In previous releases, this feature controlled both menu and control commands – now

you can turn off either option individually.

For example, you could set up Dragon to require that you say "Click" before opening a File

menu and have it turned off inside dialog boxes. See Require "Click" to select menus and

Require "Click" to select buttons and other controls in the Dragon Help.

The Dictation Box:
It's there when you need it

When you start to dictate in an unknown text field, a text area where Dragon doesn’t have

Full Text Control, such as in Microsoft PowerPoint, Dragon now automatically opens the

Dictation Box, where you do have Full Text Control. Once your text is ready, you use the

box’s Transfer button, and Dragon closes the box and inserts your content into the text

field where you started.

The option to automatically open the Dictation Box can be turned on and off in the

Options dialog box, Miscellaneous tab.

Note: If this option is disabled, you can open the Dictation Box using its hotkey or by say-

ing "show Dictation Box."
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Wireless dictation with Android devices:
Use your Android as a microphone

The Remote Microphone app released with Dragon 11.5 for iPhone and other iOS devices is

now available for Android. Once the app is installed on the Android device, you can set up

your device with Dragon and use it as a wireless microphone over Wi-Fi.

In Dragon Premium and higher editions, you can add the device to an existing user profile.

See Adding a mobile device to your user profile in the Dragon Help.

Otherwise, you can create a new profile for your Android device. See Using a mobile device

as a wireless microphone and Creating a User Profile in the Dragon Help.

Setting up a smart device is faster with a barcode

When you set up an Android or iOS smart device for use as a wireless microphone, Dragon

offers a barcode, so you can just point your device’s camera at the computer screen to cap-

ture the information that the Dragon Remote Microphone Application needs. See Preparing

for communication in the Dragon Help.

Open Top Website:
A new command to find the most popular web sites

The new command "Open Top Website for <keywords>" directly opens the top-ranked page

for the keywords you include when you dictate the command. See Searching the Web by

voice.

DragonBar in the System Tray:
New command opens the menu

If you like to set the DragonBar to display from the Tray Icon only, now you can display it

by voice as well. Just say "Open Dragon’s tray menu.” See Controlling the DragonBar.

Changes that make Dragon faster and more accurate
Disable unused voice commands:
Turn off what you're not using and Dragon runs faster

If you don't use commands to open programs and folders, or to control menus, buttons, and

other controls in your programs, now Dragon has options to turn them off. With Dragon no

longer listening for those types of commands, the speed of dictation recognition increases.

n To turn off control of Start menu and Desktop items, on the DragonBar go to Tools >

Options > Commands, and turn off and Enable launching from the Desktop.

n To turn off control of menus, buttons, or other controls in one or more programs, on

the DragonBar go to Tools > Options > Miscellaneous > Voice-enable menus, but-

tons, and other controls. You can turn off control of all programs or selected programs

on the list, which includes Microsoft Outlook, Lotus Notes, Internet Explorer, Micro-

soft Word and WordPad, Microsoft Excel, WordPerfect, Notepad, and Dragon Nat-

urallySpeaking for Windows.

Optimization reminders:
Give your vocabulary a tune-up

Dragon can now help you to improve its accuracy and speed by using a new reminder win-

dow that prompts you to scan your local computer system and adapt your vocabulary based
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on words and writing styles in typical documents and your sent e-mail messages. By learning

words and typical phrasing that you use, dictation can be faster and more accurate. See Let

Dragon learn from documents and messages in the Dragon Help.

Also, the two Dragon Vocabulary tools that you'll be using to make these improvements –

the former Increase Accuracy From E-Mail and Add Words From Documents tools – are

renamed in this release as "Learn From Sent E-mails" and "Learn From Specific Doc-

uments." In addition to the reminder option, you can click Tools on the DragonBar to run

them when you choose.

Optimizing the Language model:
Make Dragon smarter

Dragon also provides an option to save language model information when you save your

user profile. The Acoustic and Language Model Optimizer accumulates this data from ses-

sion to session and Dragon prompts you to save your language model periodically. The first

prompt appears the day after you create your profile and then a week later.

BestMatch V speech model:
Maximize your computer's resources

If you have a computer with two or more processors and more than 4 GB of RAM, Dragon

automatically selects the BestMatch V speech model for you when you create your user pro-

file. BestMatch V performs two recognition passes in parallel and, for U.S. English profiles,

assigns the Medium vocabulary. See About speech and acoustic models in the Dragon Help.

Enhanced Bluetooth wireless support:
Dragon supports the best new devices

Dragon now takes advantage of wideband Bluetooth to provide higher wireless accuracy

compared to 8 kHz Bluetooth.

If you plug in the USB adaptor for a certified wideband Bluetooth microphone, such as the

Plantronics “Calisto II” BT-300, before you open Dragon, the list of audio sources on the

New User wizard and the New Dictation Source dialog box will contain the option

“Enhanced Bluetooth.”

NOTE

If you are upgrading a user profile for use with a 16 kHz Bluetooth microphone, you must

add the microphone to the profile as a new dictation source.

Please see Using multiple dictation sources with a single User Profile in the Dragon Help.

See Begin profile upgrading and Creating a User Profile.

How you'll be more productive with Dragon
Exporting custom words with their properties:
The flexibility of XML

You can choose to export word properties in XML format when you export custom word

lists for reuse in other user profiles. Exported word lists do not include trained pro-

nunciations.
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For more information, see Export Custom Words window and Import list of words or

phrases in the Dragon Help.

List all windows:
Now includes Dragon

Dragon's "List All Windows" command now includes Dragon windows (Dictation Box,

Vocabulary Editor, Command Browser, and others). And if you want to see just the Dragon

windows, you can say "List windows for Dragon," like you can say "List windows for Inter-

net Explorer." See Switching between programs and windows.

AutoTranscribe Folder Agent:
Better file formats and e-mail notifications

The AutoTranscribe Folder Agent, which automatically schedules transcriptions of record-

ings found in a particular folder into text files, formerly offered only .TXT as an output for-

mat. Now output is available in .DOC and .RTF formats.

Administrators can also now set up automatic e-mail notification from the command line

when a transcription job completes, as explained in Dragon NaturallySpeaking Admin-

istrator's Guide. Say "Switch to DragonBar" then "Help" then "User Documentation."

Remote Desktop Connection:
Install Dragon on a server and dictate from anywhere

Now Dragon Professional and Dragon Legal support remote dictation on Windows com-

puters running Windows Server 2008 R2 or Windows 7 Ultimate Server. Use remote dic-

tation when you need to connect to a remote computer to enter your dictation over a

Remote Desktop Connection, and Dragon is installed there instead of on your local com-

puter. Multiple instances of Dragon can run simultaneously on the remote computer if it is a

server.

See the Dragon NaturallySpeaking Administrator's Guide. Say "Switch to DragonBar" then

"Help" then "User Documentation."

And there's more
Faster restores of user profiles:
Automatic backups

If Dragon was unable to open your user profile, it presents the Launch Restore window,

where you can choose from available automatic backups.

See Dragon couldn't open your user profile in the Dragon Help.

The interactive tutorial:
Make friends with your Dragon

Dragon now features an interactive tutorial, which provides short, progressive simulations so

that you can practice the basics of dictation, correction, spelling, and editing. The interactive

tutorial is automatically presented at the end of profile creation. You can also access it at any

time from the DragonBar’s Help menu.

To provide an optimal environment for beginners, some of Dragon’s usual capabilities are dis-

abled in the interactive tutorial. For instance, you cannot use your voice to click buttons.

Say or click "Switch to DragonBar," then "Help," then "Interactive Tutorial."
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More helpful Help menu:
Find everything you need in one place

The DragonBar’s Help menu provides access to many Help tools, including the Accuracy

Center, the Performance Assistant, Dragon's Help, the Tip of the Day, the Sidebar, and the

tutorials. You'll also find Web links for software updates, to Dragon on the Web, and Tech-

nical Support pages, and for online registration.

The Help menu also includes a link for User Documentation, where you can find user

guides, including the Dragon Administrator Guide, the Dragon Workbook, cheat sheets,

and instructional videos. You can access the Help at any time by saying "Give me help."

You can also say "Search the help for <xyz>".

See Using Help.

Change the Sidebar font size

Now you can change the size of text in Dragon's Sidebar – make the text smaller if you

want to make the Sidebar thinner and prevent the text for the commands from wrapping, or

you can make the text larger to reduce eye strain. See Using the Dragon Sidebar.

Enhanced Performance Assistant:
More helpful if you need to speed up Dragon

The Performance Assistant, a Help tool you can use to boost Dragon's and your computer's

speed, is now linked from the Accuracy Center and includes many new options for turning

off commands you may not need, such as

See Welcome to the Performance Assistant in the Dragon Help.

Tip of the Day:
Bigger and better

The Tip of the Day, which displays by default when you open a Dragon user profile, and is

available from the Help menu and Sidebar, is now more readable, and its redesigned win-

dow adds a Back button so that you can browse through the tips in either direction.

User Profile properties:
See all your dictation sources

The User Profile Properties dialog box now lists multiple dictation sources, such as if you

use both a headset and a smart device as a microphone or recorder.

New text-to-speech voices:
More choices, more natural

Dragon now provides more natural text-to-speech voices. To try it, select some text in an

editable document and say "Read That."

The feature is not intended for non-editable text, such as news text on a Web page.

See Using text-to-speech in the Dragon Help. You can set options in The Options dialog

box Playback/Text-to-speech tab.
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Multiple text matches:
Option to turn it off

Dragon's multiple text matching feature enables you to apply changes to multiple instances of

matching text in your documents. Dragon now includes an option to turn the feature off as

required. See Enable multiple text matches and Handling multiple text matches.

Removed and changed commands:

The following commands have been removed or changed in Dragon V12:

n "Find a Web site (on | about | for ) [the] <specific topic or Web site>"

You can continue to use "Open top Web site (on | about | for ) [the] <specific topic or

Web site>" command.

For more information, see Searching the Web by voice.

n The e-mail commands “mail it to…”, “send this to…”, and “forward that

to…” have been removed.

You can continue to use “e-mail the selection to…” command.

For more information, see Dictating E-mail and Calendar commands in the

Dragon Help.
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Installation and User Profile Creation
Introduction

This chapter presents how to install and set up Dragon, and then how to train Dragon to

understand your voice.

The installation process checks to make sure your system meets the minimum system require-

ments needed for Dragon. These system requirements are listed in the information that came

with your copy of Dragon. If your system does not meet these requirements, Dragon will not

be installed.
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Multiple users on one computer

Dragon is licensed on a “per individual” basis. You are permitted to install the software on

more than one computer (such as on a desktop and a laptop computer, or on a work and a

home computer), but you cannot use the software concurrently on more than one com-

puter. You are permitted to create multiple voice profiles, so long as each voice profile is

for you. If someone else wants to create a voice profile, that person must purchase a sep-

arate Dragon license.

Volume license agreements are available.

Plugging in the microphone

To use Dragon, you will need to plug in your microphone.

If you are not sure how to plug in your microphone, consult the documentation that came

with your microphone.

Note:

If you already have speakers for your computer, you can also use these to playback recorded

speech instead of your headphones.

Dragon system requirements
During the installation process, the software checks that your system meets the following

requirements. If they are not met, Dragon will not be installed. Note that at least 1 GB of

RAM is required for installation in Windows XP and at least 2 GB of RAM are required for

other supported operating systems. See Operating systems and RAM, below.

When you create a User Profile, Dragon recommends the Vocabulary that best fits your

computer's speed and memory. You can choose a smaller Vocabulary if you are using a Gen-

eral Vocabulary, and you want faster recognition of your dictation and do not need to use a

Large Vocabulary.

Note

This edition of Dragon does not support dictation directly into Electronic Medical Record

(EMR) Systems. For EMR support, please use Dragon Medical Edition.

Core Processor
Minimum

Intel® Pentium® 1 GHz or equivalent AMD processor or 1.66 GHz Atom® processor

(SSE2 instruction set required).

Recommended

Intel Pentium 2.4 GHz (dual 1.8 GHz core processor) or equivalent AMD processor.

Note

Streaming SIMD Extensions (SSE) are not supported.
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Processor cache

Minimum: 512 KB

Recommended: 2 MB

Operating systems and RAM

Operating
system 32-bit 64-bit

RAM

Minimum
Rec-

ommended*

Windows 7
(SP1 or higher)

√ √ 2 GB 4 GB

Windows Vista
(SP2 or higher)

√ √ 1 GB 2 GB

Windows XP
Home (SP3 or
higher)

√ x 1 GB 2 GB

Windows XP
Professional
(SP3 or higher)

√ x 1 GB 2 GB

Windows
Server 2008
SP2

√ √ 2 GB 4 GB

Windows
Server 2008 R2
(SP1 or higher)

N/A √ 2 GB 4 GB

Notes
Windows Vista, Windows XP SP2 and Windows XP 64-bit, Windows Server 2008 SP1, Win-
dows 2000, Windows 2000 Server, and Windows Server 2003 are not supported and instal-
lation is blocked on those systems.
* If your computer has less than the recommended RAM, Dragon will install but displays a
message recommending that you install additional RAM for optimum performance.

Your computer and Dragon's speech model selection

If Dragon sets your speech model to BestMatch III, it also turns off Natural Language Com-

mands (please see More commands) and sets the Speed vs. Accuracy Slider for Fastest

Response, which reduces the number of words or phrases examined during speech rec-

ognition, displaying results faster but with less accuracy.

If your computer has two or more processors and other required resources, Dragon selects

the dual-pass BestMatch V speech model during user profile creation.

For the list of available speech models, see Advanced - Choose Models in the Dragon Help.
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Free hard disk space

n 2.5 GB minimum for custom installations in English versions where you install only

the program files and one set of speech files. Installations can range from 800 MB

(Standard Edition) to 2.5 GB (Medical Edition).

n 2.8 GB minimum for non-English versions.

Microphone

Nuance-approved noise-canceling headset microphone. For a complete listing of Dragon-

compatible audio input devices, visit the Hardware Compatibility List on the Dragon Sup-

port Web pages.

Sound card

Sound card capable of supporting 22 kHz 16-bit audio recording.

Screen resolution

The following minimum screen resolutions are recommended for optimal display of Dragon

on your Windows Desktop:

Computer class Minimum Resolution

Desktop 1024 x 768

Laptop 1024 x 768

Netbook 1024 x 600

For Windows Vista and Windows 7, the maximum recommended display magnification is

150 per cent.

Other requirements

n Microsoft Internet Explorer 7 or higher (free download available at www.m-

icrosoft.com).

Note: To use Web application support, Dragon requires Internet Explorer version 9

(32-bit mode only).

n DVD-ROM drive required for installation.

n An Internet connection for product activation.

What you should know before installing
Installing Dragon to a custom location

The default installation directory for Dragon is:

C:\Program Files\Nuance\NaturallySpeaking12
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During the installation procedure, you can choose to install Dragon to a different directory or

drive on your machine.

Choosing a different directory during installation only installs the Dragon program files to

that location.

Regardless of where you install the Dragon program files, Dragon always installs the lan-

guages and vocabularies that you selected during the installation to the C: drive, as well as cre-

ating the location where your users profiles will be created. These profiles can consume a

large amount of disk space on your C: drive. For more information on the Dragon installation

directories, see Version 12 File Structure.

You can customize your installation to reduce the amount of disk space used on your C:

drive by not installing unwanted languages and vocabularies. For more information, see

Installing software — Custom Installation.

Installing on Windows Vista/Windows 7

Dragon Version 12 is compatible with all editions of Windows Vista.

If you upgrade a machine from a previous version of Windows to Windows Vista/Windows

7 and that machine has Version 10.x or 11.x of Dragon installed, that version of Dragon will

not work after upgrading to Windows Vista. All your user profiles from these previous ver-

sions remain intact and can be upgraded when you install Dragon Version 12 or higher.

Coexistence with other Dragon products
Coexistence with previous versions of Dragon

You can have only one version of Dragon installed on your system.

Note:

Running Version 10.x, 11.0, or 11.5 concurrently with Version 12 is not supported.

Coexistence with the Dragon SDK Client Edition

You can install Dragon SDK Client Edition 12 on the same machine where Dragon 12 is

installed. In addition, Dragon 12 and Dragon SDK Client Edition 12 can share users and

vocabularies.

You can only run one product at a time. For example, if you are running Dragon, you cannot

run any of the SDK Client tools or samples.

Note:

Coexistence of Version 12 with Dragon SDK Client Edition Version 10.x, or 11.x is not supported.
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Installation Prerequisites
Before installing the software

1. Close all open applications.

2. Turn off or disable antivirus software; the installation process can sometimes trigger a

false virus report.

Note: You must have Administrator rights to install or uninstall Dragon on Windows XP,

Windows Vista, or Windows 7. Administrator rights are not required to create a user profile

or use the software after installation.

On Windows XP Professional, Windows Vista, and Windows 7 systems, if as an admin-

istrator you want to create a Dragon user profile for a Windows limited user (user with

restricted privileges), you must log on using that Windows limited user account before cre-

ating the Dragon user profile.

If you create a Dragon user profile for a limited user while logged in as a Windows admin-

istrator, the limited user will not be able to access that user profile. These restrictions also

apply to an upgrade installation.

3. Choose the type of installation to carry out.

Choose whether to install the entire product or only particular features of the product, as

explained in the next section.

You can also carry out an MSI installation. Refer to the online Dragon System Admin-

istrator Guide PDF or Help file for details.

Choosing type of installation

When you install Dragon, you can either do a complete (typical) installation or a custom

installation. Nuance recommends you do a complete installation unless you are experienced

with the product. The table below tells more about each installation type.

TYPE DESCRIPTION

Typical/
Complete

Installs all options and speech profiles. Requires the maximum disk space.

Custom Lets you select particular options and vocabularies to install. Can greatly reduce the disk
space required. During a custom installation, in the Professional andMedical editions, you
can modify settings that are then applied to all user profiles created with this installation,
includingWindows limited account users.

Note:

If you decide not to install some Dragon components by selecting Custom installation, you can install them

later by running the Setup program again and choosing Modify.

If you are installing the product for multiple users, you should choose a Custom installation

rather than a Typical/Complete installation. To carry out a custom installation, proceed to
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Installing software — Custom Installation. Otherwise, proceed with Installing software —

Typical Installation.

Installing Software - Typical Installation
To install all features of Dragon:

1. Insert the Dragon DVD into your DVD drive.

If the installation does not start automatically, use Windows Explorer to find and double-

click setup.exe on the DVD.

Note:Windows Vista: When you start the installation on Windows Vista, you may see the message say-

ing A program needs your permission to continue. Click Continue to start the installation.

2. After the Windows Installer begins, it installs:

n Visual C++ Version 9.0 Runtime

3. After the Wizard begins, click Next to proceed to the License Agreement page. Read the text

and select I accept the terms..., then click Next.

4. Enter your User Name and Organization, and the Serial Number supplied to your installation.

5. (Optional) When the Setup Type page appears, click the Change button and choose where

to install the product.

If no earlier versions of Dragon are installed on your system, the default directory is:

C:\Program Files\Nuance\NaturallySpeaking12

For a list of directories created by installation, see Version 12 File Structure.

6. While you are still on the Setup Type page, select Typical.

7. Click Install to start the installation.

8. When prompted, click Finish to complete the installation. (If you are prompted to restart

your computer, restart it now.)

9. Select Start > All Programs > Dragon NaturallySpeaking 12 > Dragon NaturallySpeaking 12.

The DragonBar appears on your desktop.

10. (optional) If you have users from Version 10.x or 11.x that you would like to upgrade

before proceeding, refer to Upgrading User Profiles.

11. If you have no previously existing users, the Profile Creation wizard starts immediately

after you run the product. Proceed to Creating your User Profile to set up a User Profile,

then continue as instructed, to train that user profile.

You are now ready to create a User Profile, as explained under Creating your User Profile.
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Installing Software - Custom Installation
To install portions of Dragon or to install it for multiple user pro-
files:

1. Insert the Dragon DVD into your DVD drive.

If the installation does not start automatically, use Windows Explorer to find and double-

click setup.exe on the DVD.

Note:Windows Vista: When you start the installation on Windows Vista, you may see the message say-

ing A program needs your permission to continue. Click Continue to start the installation.

2. After the Windows Installer begins, it installs:

n Visual C++ Version 9.0 Runtime

3. After the Wizard begins, click Next to proceed to the License Agreement page. Read the

text and select I accept the terms..., then click Next.

4. Enter your User Name and Organization, and the Serial Number supplied to your instal-

lation.

5. (Optional) When the Setup Type page appears, click the Change button and choose

where to install the product.

If no earlier versions of Dragon are installed on your system, the default directory is:

C:\Program Files\Nuance\NaturallySpeaking12

For a list of directories created by installation, see Version 12 File Structure.

6. While you are still on the Setup Type page, select Custom for the type of installation.

Note: If you decide not to install some Dragon components by selecting Custom installation, you can

install them later by running the Setup program again and choosing Modify.

7. Click Next and you see a tree where you can select any particular feature of the product

and click the down arrow to its left to choose where/when to install it:

n Install now, on local hard drive

n Install now, with all subfeatures on local hard drive

n Install when it is needed on a just-in-time basis

These options are particularly useful for installing multiple languages and/or multiple vocab-

ularies.

For example, see the selections for the Southeast Asian English vocabulary shown in the illus-

tration below.

32



Dragon 12 Installation and User Guide

Installing other languages, dialects, and specialized vocabularies To install user files for the

other languages or dialects supplied with your edition, choose Custom on the Setup Type

page. The user files for each language or dialect contain both spellings and pronunciations

specific to that region. For example, users who wish to dictate US English spellings—includ-

ing users with accents—should install the US (American) English user files.

8. Click Next again and, if you do not have the Professional edition, skip to the next step.

Otherwise, choose any check boxes under Additional options to have additional dialog boxes

pop up at the end of the installation, where you can make changes that affect all users dic-

tating on this computer.

Modify the application’s settings for all users

Displays theOptions dialog box at the end of the installation; here you set several options for
all user profiles at once (see online Help for details). Useful for an installation in a shared area;
for example, in a conference room or in an examining room where multiple healthcare pro-
fessionals could dictate.

Modify the administrative settings

Displays the Administrative Settings dialog box at the end of the installation, where you set
up the Roaming User feature, where to backup your files, andwho can modify com-
mands/vocabularies.

Modify the formatting options

DisplaysAuto-Formatting dialog box at end of installation, where you apply uniform for-
matting to all documents dictated at this installation; for example, formats for dates, times, and
phone numbers. You also set whether to expand contractions, apply abbreviations, and insert
commas automatically. See online Help for more details.

9. Click Next.

10. Click Install to start the installation.

11. When the installation completes, proceed with any of the following sections that apply to

your custom installation:

n Modifying application settings for all users

n Modifying administrative settings

n Modifying formatting options for all users

12. When you are prompted to register the product, select one of the registration options.
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13. Click OK to register the product and click it again to proceed.

14. Check Yes, check for program updates after the setup completes to download any updates after the

setup completes and click Finish to complete the installation.

15. If you chose to upgrade user profiles earlier, when the message about upgrading your

user profiles pops up, click OK. (The message might tell you that the installation will not

be complete until after your system is restarted.)

16. If you were told you need to reboot in order to complete the installation, reboot your

computer now.

17. Select Start > All Programs > Dragon NaturallySpeaking 12 > Dragon NaturallySpeaking 12.

The DragonBar appears on your desktop.

18. (optional) If you have users from Version 10.x or 11.x that you would like to upgrade

before proceeding, refer to Upgrading User Profiles. Otherwise, if you have no pre-

viously existing users, the Profile Creation wizard starts immediately and you can create a

User Profile as explained under Creating your User Profile.

Modifying application settings for all users
If you checked offModify the application’s settings for all users during a custom installation, the

Options dialog box opens immediately after the installation completes.

Note:

If you did a typical installation, open the Options dialog box by running Dragon and selecting Tools >

Options.

In the Options dialog box, you see several tabs you can use to set up various aspects of dic-

tating with the product:

For more information on each tab, see the online Help.

Modifying administrative settings

Note: If you did a typical installation, open the Administrative Set-
tings dialog box by running Dragon without opening a user and
selecting Tools > Administrative Settings.

In the Administrative Settings dialog box, you see these tabs:

n Roaming—To set up roaming users.

n Miscellaneous—To create backup/distribution directories and control who can mod-

ify custom commands.
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n Scheduled Tasks—To schedule voice recognition optimization and data collection for

improved accuracy, and let users modify the schedule.

For details, refer to the Help by clicking the Help button

Modifying formatting options for all users
If you chose to modify formatting options on the Custom Setup page during a custom instal-

lation, the Auto-Formatting dialog box opens after the installation completes.

Note:

If you did not do a custom installation, to set up formatting: Run Dragon, open a user, and select Tools >

Formatting.

The Auto-Formatting dialog box for all versions of Dragon NaturallySpeaking appears as

shown below.

Choose the options to apply to your dictated documents.
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Creating your user profile
Before you can begin using Dragon, you must let Dragon create a user profile for each per-

son or healthcare provider who is dictating.

Your user profile stores acoustic information about your voice that Dragon uses to rec-

ognize what you say. This profile also stores any changes you make to the standard vocab-

ulary—any special words, names, acronyms, and abbreviations you add.

When you launch the software for the first time, the Profile Creation wizard starts and leads

you through creating your user profile:

Note:

If you upgraded a single user from an earlier version, Dragon opens that user’s profile. If

you upgraded multiple users, it displays profiles for all upgraded users in the Open User

dialog box.

To create a user profile

1. In the Creating a user profile page, click Next in the lower right corner to proceed.

2. Proceed through the wizard, filling in the information it requests and clicking Next to

proceed.

When the wizard asks for your name, you can enter your first name only, a nickname, or

your first and last name.

The wizard asks for your age to help Dragon work with vocal differences it associates

with different age ranges.
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The wizard also asks for region of the world you live in to help Dragon interpret your

speech based on regional differences.

3. When the Help Dragon understand how your pronounce words page appears, select your accent.

The accents you can choose from are:
n Standard — Select if your accent is not covered by another choice or your

are not sure which accent to select.

n Australian accented English

n British accented English

n Indian accented English

n Inland Northern US (Great Lakes area)— Upstate New York through the

Chicago area

n SEAsian accented English—South East Asian

n Southern US— Most of Southern United States, including Texas

n Spanish accented English

Determining your own accent can be difficult. For example, say you grew up in one part of

the United States but have lived long enough in another part to lessen your original regional

accent. If you have any doubt about picking an accent, select Standard and allow Dragon to

learn your accent.

If you do not select a specific accent (in other words, you select the Standard accent), you

may want to perform Acoustic Optimization after using the product for several hours. Acous-

tic Optimization updates your user profile with accumulated acoustic data from any cor-

rections and additional training you may have done. Running Acoustic Optimization will

increase your overall accuracy. In the process of increasing your accuracy, Acoustic Opti-

mization may select a different accent for you.

If you select a specific accent, Acoustic Optimization will still increase your overall accuracy,

but will not change your accent. Once you have selected a specific accent for a user, you can-

not change it later.

Dragon lets you create and train users in multiple languages. If you have purchased an edition

with support for more than one language, you can add languages by later choosing Custom dur-

ing the installation and having the Dragon DVD available to install the language files during

the process of creating user profiles.

4. When the How do you talk to your computer? page appears, select your type of microphone

from the list ofMicrophones. If you record your speech using a recording device, select a

recorder from the list of Recorders.

5. In the Review your choices page, be sure the information is correct before you proceed.

6. Dragon automatically chooses a speech model to use as the foundation for your individual

user profile. It also selects the vocabulary it uses to recognize words correctly based not

only on their sound, but also on their context. However, if you want to select a particular

speech model and vocabulary, you can click the Advanced button and in the Choose models

page select a:
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n Speech model from the drop-down list for Speech model. Dragon uses

the speech model to adapt to your voice during training. Dragon auto-

matically recommends the type of speech model and vocabulary that is

appropriate for your computer’s speed/memory. Usually, you should fol-

low Dragon’s recommendation

n Type of vocabulary from the Vocabulary type list:
n Medium— Requires at least 512 MB of RAM.

n Large— Requires at least 1 GB of RAM.

n Empty Dictation— (Professional edition only) Vocabulary

with a language model but without any words, designed

for experienced users or resellers who want to create

highly specialized vocabularies.

7. Click OK to save your selections in the Choose models page and return to the Profile Cre-

ation wizard.

8. Click the Create button in the lower right corner of the page to create your user profile.

When Dragon finishes creating your user profile, it takes you through the next part of the

process. Proceed to Setting up/positioning your microphone.

Setting up, positioning, and checking your
microphone
When Dragon finishes creating your user profile, it displays the Position your microphone prop-

erly page, where it begins to lead you through the process of setting up your microphone.

Following the wizard’s instructions, position your microphone.

Positioning the microphone correctly is important. If the microphone is out of place,

Dragon might not be able to hear you clearly and make mistakes.

Consistent positioning is also important. Make sure that you position the microphone the

same way each time you dictate.

Here are some tips on using particular types of microphones:

Using a headset microphone

n Position the microphone about a half-inch (approximately the width of your thumb)

from your mouth and a little off to the side. The microphone should not touch your

mouth, but it can be almost touching your lips.

n If you need to move the microphone out of the way, lift the “boom” up and over

your head, rather than bending it out of position or removing the headset.

Using a handheld microphone

n Hold the microphone one to three inches from your mouth and a little off to the

side.
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n If the volume display on the DragonBar turns red, try holding the microphone slightly

farther from your mouth.

Using an array microphone

n Position the array 18 to 30 inches from/pointed at your mouth.

n Avoid blocking the path between your mouth and the array, for example by holding a

book or paper in front of your face.

n Avoid having any source of noise or signal other than your voice directly facing the

array within at least 15 feet.

After you have positioned the microphone, click Next to continue with Checking microphone

volume/sound quality.

Checking microphone volume/sound quality

After you have positioned the microphone and clicked Next, you see the Dragon will adjust

your volume page.

1. Click the Start Volume Check button and then read aloud the text displayed in the box.

2. When the program beeps to indicate it has finished checking the volume, click Next.

3. When the Dragon will test the quality of your sound system page appears, click Start Quality Check

and then read aloud the text displayed in the box.

4. The program beeps when it has finished evaluating the sound quality of your system. If

Dragon displays Passed, click Next to continue.

Note:

Windows Vista or XP: If you get a Sound level is too low error while creating a Dragon user pro-

file, to boost the microphone’s volume:

1. Select Start > Control Panel > Sound and Audio Devices.

2. On the Voice tab, click the Volume... button underVoice recording to open the

Recording Control dialog box.

3. Set the volume level for the appropriate input device type.

Continue with Training a new user profile.

Training a new user profile
Immediately after you create your profile, before you begin dictating, you train Dragon to

understand your voice.

Performing training either during or after creating a user profile enhances your recognition

accuracy. In initial training you read aloud for several minutes from one of the available texts.

Note:

For information on training a mobile user, see (link).
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If you skipped training earlier to open a user profile, from the DragonBar menu, select Pro-

file > Open User Profile and select your name in the list; then click Open to proceed. Since

you have not completed training, options for Training appear.

To train a new user

1. When the Read text aloud to train Dragon page of the wizard appears, choose from these

training options:
n Show the text with prompting

n Show the text without prompting

n Skip training (not recommended)

2. In the Read Training Text page of the wizard, click Go.

3. If you chose the first training option (Show text with prompting):
n A yellow arrow showing you where to start reading appears.

n Click Go and begin reading the text. To take breaks while you’re training

the program, click Pause.

Note: To advance through the first two screens, you must say the sentences without

pausing. For the rest of the screens, it’s okay to pause in the middle of a sentence.

n When the words change color, it means the computer has heard and rec-

ognized them.

n If you need to re-read the same words, click Redo, then re-read them. If

the computer still doesn’t get it, just click Skip. Otherwise, click Next to

continue.

4. If you chose the second training option (Show text without prompting):
n In the Read Training Text page, under Choosing text to read, choose a text to

read aloud and click Next.

n When the Text Display page appears, choose how you want to read the

text, from the screen or from a printed page. If you choose to read from

a printed page, click Print to print the text.

n Click Next to continue.

n If you chose to read the text from the screen, the Speaking to the computer

page appears and advises you to position your microphone.

n After you position your microphone, click Train to begin.

n In the Speaking to the Computer popup, click Begin Training and read the

text in the box.

n Click Next page to proceed from page to page.

5. When the list pops up, choose a text to read aloud and click OK.

You need to read for only about 5 minutes to train Dragon to recognize your voice.

You can take breaks during this training by clicking Pause. Don’t worry if you make mis-

takes or laugh. You should try to read exactly what you see on the screen, but it’s okay if
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you read something incorrectly. The computer either ignores the mistake or positions the

yellow arrow at the beginning of the text for you to reread it.

The progress bar shows how much text is left to dictate.

Note: During training, dictating punctuation is not necessary.

6. When you’ve read enough, the Training wizard displays a congratulations message. Click

OK and Dragon starts adapting to your voice.

Proceed to Adapting to your writing style, scheduling tuning.

Adapting to your writing style and scheduling
tuning
After it adapts to your voice, Dragon’s Accuracy wizard appears and prompts you to first

adapt Dragon to your writing style, then schedule regular Acoustic and Language Model tun-

ing, and optionally schedule Data Collection.

Adapting to your writing style (Let Dragon search for words and
add them now)

Dragon can analyze your writing style to increase your overall recognition accuracy. This tool

scans documents in your My Documents directory—Microsoft Word, Corel WordPerfect,

text files, html files, and rich text files (.rtf).

Adapting to your writing style can add 5 to 30 minutes to user training. Close all other pro-

grams when you run this step.

Note:

Though we recommend that you run this part of the New User Wizard, if you plan to skip

this step, select Skip this step rather than Cancel.

1. In the Let Dragon search for words and add them now page of the Accuracy wizard, to have

Dragon search for words and phrases you use in your email messages, select the Sent E-

mails check box. To have Dragon search your word processing and text files, select the My

Documents check box.

2. Click Start to initiate the search for words. While scanning your files, the dialog box dis-

plays the process’s status. When Dragon finishes searching, it displays a message telling

you to click Next to continue.

Let Dragon automatically improve your accuracy

After it adapts to your writing style, the Accuracy wizard gives you the option of setting up a

schedule to automatically run Acoustic and Language Model tuning processes:
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Note:

Acoustic and Language Model tuning processes add commonly used word sequences the

user dictates as well as acoustic data from any corrections and additional training the user

executes. Scheduling tuning processes helps Dragon learn from you and makes your dic-

tation more accurate.

1. In the Let Dragon automatically improve your accuracy page, to have Dragon periodically tune

your user profile to improve your accuracy, be sure to check the Automatically improve accu-

racy check box. If you do not change the schedules, by default Dragon initiates Acoustic

tuning every Monday at 2 AM and Language Model tuning every day at 3 AM.

2. If you want to have Dragon tune your user profile at a different time or more or less

often, click the Change Schedule button and, in the Select Time and Frequency dialog box, set

the schedules on both the Acoustics and Language Model tabs. The schedules do not have to

be the same. As a rule, you should try to run these processes when you are not dictating

and run the Language Model tuning more often.

3. Be sure that you check the Enable check box on both the Acoustics and Language Model tabs

or the tuning processes occur on the default schedule, rather than the schedule you set.

4. Click Next to continue.

Scheduling data collection (Help us improve Dragon)

After it lets you set the schedule for accuracy tuning, the Accuracy wizard lets you set

whether or not to collect data and schedule when it should be collected:

Note:

When you set Data Collection to run, it collects up to 500 MB of acoustic data and text from

your dictation sessions. Once the data is collected, you have the option of sending it to

Nuance to help improve the accuracy of future versions of Dragon. No personal infor-

mation is ever sent to Nuance and participation in data collection is completely voluntary.

1. In the Help us improve Dragon page, you can choose:
n Run Data Collection

n Don’t run Data Collection but remind about this later

n Don’t run Data Collection

2. If you choose Run Data Collection, click Change Schedule and set what time and how often

the data is sent to Nuance in the Select Time and Frequency dialog box (Daily, Weekly or

Monthly). If you do collect data, by default Dragon initiates the process every Wednesday

at 12:30 AM.

3. Be sure that you check the Enable check box in the Select Time and Frequency dialog box or

the collected data is sent to Nuance on the default schedule, rather than on the schedule

you set.

4. Click Next to continue.

5. When the Congratulations, your profile is ready to use page appears, you can now:
n Choose to run the tutorial.

n Learn about the many improvements in Version 12.
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n Modify how Dragon presents itself to you.

n Begin dictating.

6. Click Finish to close the wizard.

To upgrade existing user profiles before dictating, proceed to Upgrading User Profiles.

How Dragon automatically configures user
profiles
After you create a user, Dragon automatically analyzes your hardware and changes the default

settings of your users to optimize performance.

Depending on your hardware, you might receive a message that the amount of RAM (mem-

ory) on your computer is relatively low for the operating system. When you use Dragon on

such a computer, try not to have more than one or two applications open.

Upgrading User Profiles
If you chose to upgrade existing users during the installation, the User Upgrade Wizard appears

the first time you run Version 12.

Note:

If you do not want to upgrade users right now, you can exit from the wizard and do it later.

Otherwise, you can start the User Upgrade Wizard from the Windows Start menu at any time.
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To upgrade existing users:

1. To start the User Upgrade Wizard, select Start > All Programs > Dragon NaturallySpeaking 12

> Dragon NaturallySpeaking Tools > Upgrade Users. The User Upgrade Wizard appears.

2. On the Select Users to Upgrade page, modify the list of users to include users that you want

to upgrade. The wizard starts by including all users in the current folder as candidates to

upgrade. You add users to the list by clicking the Add button and browsing for additional

users in other locations. You remove users from the list by selecting them and clicking

the Remove button. After the list contains only the users you want to upgrade, click Next.

3. Click Next and choose the location for the upgraded user profiles. As the User Upgrade

Wizard modifies your user files to work with the newest version, it can place the

upgraded user in another location while keeping the old files untouched, in case you

need them again.

4. Click the Browse button in the Choose Destination page of the wizard to select the location

for the upgraded user profiles. If you do not set a location, Dragon places the profiles in

the default location (see Version 12 File Structure).

5. (Optional) If you want to make changes to the user locations, base vocabularies, and/or

acoustic models, click the Advanced button and the Advanced Options dialog box opens.

In this dialog box, you can make finer adjustments to how the wizard upgrades particular

users. You see a list of the users being upgraded. For each user you see the user name,

old location, vocabulary, and one or more acoustic models.
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When you click on the location line of a user in the list, the New Location text box below

the list becomes available. You can click Browse and select a new location.

When you click on the vocabulary line of a user in the list, the New Base Vocabulary text

box below the list becomes available. You can choose a new base vocabulary from the

drop-down list.

When you click on the acoustic model line of a user in the list, the New Acoustic Model text

box below the list becomes available. You can choose a new combination language, lan-

guage model, and accent from the drop-down list.

6. Click OK to return to the wizard.

7. Click Next to proceed to the Upgrade Users page where you click Begin to begin the upgrade

process. Expect to wait approximately 5 minutes for each user being upgraded.

8. When the upgrade process is complete, click Finish.

Version 12 File Structure
Note:

File locations shown apply to installations in the default location.

The next two sections tell you where Dragon places files on your computer. The locations

vary, depending on your operating system.

Windows XP Pro/XP Home/Windows Server 2008 directory struc-
ture

You can specify this location during the installation:

C:\Program Files\Nuance\NaturallySpeaking12

\Ereg

\Help

\Program

\Tutorial (optional)

You cannot change this location—Dragon always installs these directories to your \Documents

and Settings directory:
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C:\Documents and Settings\All Users\Application Data \Nuance\N-
aturallySpeaking12\

\Data

\Data\Training

\results

\Roaming Users

\Users

C:\Documents and Settings\<username>\Application Data \Nuance\N-
aturallySpeaking12\Results

Windows Vista and Windows 7 directory structure

You can specify this location during the installation:

C:\Program Files\Nuance\NaturallySpeaking12

\Ereg

\Help

\Program

\Tutorial (optional)

You cannot change this location—Dragon always installs these directories to your \Doc-

uments and Settings directory:

C:\ProgramData\Nuance\NaturallySpeaking12

\Data

\Data\Training

\results
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\Roaming Users

\Users

C:\Users\<username>\AppData\Roaming\Nuance \Na-
turallySpeaking12\Results

Cleaning up after uninstalling

The following files remain on your machine after you uninstall:

\Windows\Speech\

n VText.dll

n Vdict.dll

n WrapSAPI.dll

n XTel.dll

n Xcommand.dll

n Xlisten.dll

n Xvoice.dll

n spchtel.dll

n speech.cnt

n speech.dll

n speech.hlp

n vcauto.tlb

n vcmd.exe

n vcmshl.dll

n vtxtauto.tlb

Dragon installs these files for Microsoft SAPI4 support. You do not need these files if you

do not have other speech applications that require SAPI4. If you do have applications that

require SAPI4 support, you might need to re-install those applications if you remove these

files.

Accessing log files, samples, and tools
You can open log files and samples from the desktop:

n Dragon log file (dragon.log) — Select Start > Programs > Dragon NaturallySpeaking 12 >

Show Dragon Log.

n NaturallySpeaking setup files (dgnsetup.log) — Select Start > Programs > Dragon Nat-

urallySpeaking 12 > Show Setup Log.

47



Chapter 2: Installing Dragon

n Structured command samples — Select Start > Programs > Dragon NaturallySpeaking 12

> MyCommands Samples. (Professional edition only)

n Tools — Select Start > All Programs > Dragon NaturallySpeaking 12 > Dragon Nat-

urallySpeaking Tools. (Professional edition only)

Activating Dragon
The first time you start Dragon, you will be prompted to activate your copy of the program.

If you do not activate the program, you will be able to start Dragon several times. Without

activation, when you start Dragon for the sixth time, it will no longer open and you won't

be able to use the program until you activate it.

Nuance strongly recommends that you activate automatically.

To automatically activate Dragon

1. Start Dragon. This displays the Activation dialog box.

2. Click "Activate Now." This displays the Activation Screen.

You can also choose "Activate Later," which will prompt you to activate each time you start

Dragon. If you start the program five times without activating, Dragon will be disabled.

3. Click "Activate Automatically." This automatically activates Dragon and requires no fur-

ther action from you.

To manually activate Dragon

1. Start Dragon. This displays the Activation dialog box.

2. Click "Activate Now." This displays the Activation Screen.

3. Click "Activate Manually." This displays the Enter Key dialog box.

4. To complete the manual activation, click on the URL listed at the top of the dialog box.

This URL opens the Nuance activation page.

5. On the Nuance activation page, click "Generate Activation Key" to create an Activation

Key.

6. Once activation key appears, select the entire number and copy it (CTRL+C). Click the

first field of the Enter Key dialog box and paste (CTRL+V). This pastes the entire

number into the Activate Key field

7. Click OK to complete the activation.

Notes

n You must be connected to the Internet to activate Dragon Professional. The acti-

vation process sends only your product serial number and a number that uniquely

identifies the machine where Dragon is being installed. No personal information is

transmitted to Nuance.

n If you make any hardware changes on a machine where Dragon is installed, you may

be prompted to activate again. To preserve your activation status you can uninstall
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Dragon, making sure to keep your User Profiles when prompted, before you make

your hardware changes. After making changes to your hardware, then re-install

Dragon.
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About Dragon
Dragon software is the premier product for large-Vocabulary continuous recognition of nat-

ural speech. With Dragon, you can create documents quickly and easily with your voice,

without being slowed by typing on your keyboard.

Dictate your documents

You can dictate, rather than type, into any program that accepts text. Dragon recognizes nat-

ural and continuous speech and converts it to text on the screen.

Format and edit by voice

You can use voice commands to format text and make corrections and to activate the but-

tons and menus in supported word processors, such as Corel WordPerfect, Microsoft Word,

DragonPad, WordPad, and other supported programs.
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Say What You See™ to control programs

You can use voice commands to start and switch among programs and to control program

windows, menus, and dialog boxes. Say "File," for example, to open the File menu.

Personalize Dragon for your voice and Vocabulary

You can train Dragon to recognize the way you speak and personalize the Vocabulary with

words you typically use.

You can increase accuracy by creating different Vocabularies, personalized for the different

subject areas in which you dictate.

n How to contact technical support

n Recommended system requirements for Dragon

n Copyrights

Using Dragon Help
In addition to using the Help menu to examine Help topics in Dragon, you can access Help

and navigate through topics using voice commands. The following table summarizes these

commands.

To Say

Open Help "Give Me Help"

Display topics "Move Forward" or "Go Backward"

Search Help "Search Dragon Help for <dictation>," where <dictation> can be any search string
you want to look for in the Dragon Help. You can say this command even when the
Help is not open.

Search options available in the HTML Help that ships with Dragon include phrase
searching using quotation marks. For example, you can say "Search open quote
What's new in Dragon closed quote") to find only topics that contain that exact
phrase. You can also search only previous search results, match similar words, and
search topic titles only. Open the Help Search tab for details.

Open the sam-
ple commands
list in the Side-
bar

"View Sidebar" or "View Sample Commands" or "What Can I Say"

Select the
Contents,
Index, or
Search tab

Say "Click Contents," "Click Index," or "Click Search"
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To Say

Move in the
Contents,
Index list,
Search list, or
Select Topic
list

"Move Down <1 to 20>"
"Move Up<1 to 20>"

Open a topic
from the Con-
tents, Index
list, Search
list, or Select
Topic list

Move to the topic or book you want and say "Press Enter Key." (In the Index and
Search tabs, you can also say "Display.") You can also dictate an index entry or a
search string.

Close Help "Close Help" or "Quit Help"

Note

Not all voice commands work in the Help window. For example, you can select the tabs by

saying "Click Contents," "Click Index," or "Click Search," but you cannot use voice com-

mands to select from the toolbar and you cannot click buttons by saying their name. You

can use "Press Tab Key" to select buttons and "Press Enter Key" to press buttons.

About dictation
When you dictate, try to speak naturally and at your normal speed. Pronounce each word

clearly, not loudly, and in a way that is comfortable for you. Take occasional breaks. As you

dictate, by default Dragon displays a small Dragon icon as it listens to you and proc-

esses your speech. When you pause, Dragon transcribes the text into your document. See

About the Results Display for details.

For best recognition, speak in longer phrases rather than short phrases or individual words.

If you are having recognition problems, do not speak slowly or deliberately.

Basic dictation commands

Dragon Top 5s: Dictation

Notes

n Before you start speaking, make sure the microphone is on and the mouse cursor is

placed in the window where you dictate.

n If your throat gets dry when dictating, you can sip water through a straw to minimize

noise that might interfere with recognition.

n If the borders of the Results box turn blue, then Dragon has interpreted that dic-

tation as a command rather than text to transcribe.
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About the Results Display
Dragon's Results Display is streamlined to reduce distraction and to encourage better dic-

tation practices. Rather than the traditional floating Results Box, a small Recognition-in-Prog-

ress icon displays as you dictate. The simpler display is meant to encourage dictation in

longer phrases and sentences, which improves voice recognition.

When you pause, Dragon transcribes the text into your document.

You can set options to move the Results Display anywhere on the screen, keep it in one

place, change its color and font size, or make it disappear after a recognition. And you can

still display the traditional Results Box (see ), but Nuance recommends that you use the new

display to avoid distraction.

The table below compares how Dragon gives you feedback during dictation with the new

Results Display, which leaves preliminary results turned off, and the more traditional

method, which preliminary and final recognition results.

Speech status

Results display behavior

Preliminary results
turned off

Preliminary results
turned on

Recognition in progress

Dictation recognized and displayed

Recognition complete.
If you prefer, you can also set the Results
Display to Never Show, or to be hidden
after a timed delay.

Speech not recognized

Results context menu

53



Chapter 3: Getting Started

Speech status

Results display behavior

Preliminary results
turned off

Preliminary results
turned on

Command recognized.
If Dragon recognizes a command, the bor-
ders of the Results Box turn blue. The only
exception to this behavior is when you dic-
tate commands such as "New Line" or
"New Paragraph."

Dictation is too loud

Audio volume is too high
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Using the DragonBar
This section contains the following topics:

The DragonBar 55

The Text Control Indicator 59

Displaying the DragonBar 59

Controlling the DragonBar 61

The DragonBar
The DragonBar is the main Dragon toolbar you use to control the Dragon software. The Drag-
onBar appears at the top of the display when you start Dragon for the first time. When you
see the DragonBar, you can use Dragon to dictate into word processors, e-mail, and other pro-
grams.

You can change the appearance and behavior of the DragonBar to suit your working style. By

default the DragonBar is docked to the top of your screen. To change the DragonBar's mode,

see Displaying the Dragon Bar.

The DragonBar contains the following controls, starting from the left side:

The Dragon icon

Click the Dragon icon (or right-click anywhere on the DragonBar) to display a menu that

controls how the DragonBar looks and acts on your screen.

The microphone icon

The microphone icon displays on the DragonBar and in the Windows taskbar. Click the

microphone icon to turn the microphone on and off. The following table shows the micro-

phone states you'll see:

The way the microphone
icon displays What you can do

The microphone is on and Dragon is listening.
Dictate or say commands as needed.
When you are finished or want to pause from dictating:

Say "Go to Sleep" or click the forward slash key (/) to
put the microphone to sleep.

Say "Microphone Off" or click the plus key (+) to turn
off voice recognition.

The microphone is on and Dragon is listening as you dic-
tate.
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The way the microphone
icon displays What you can do

The microphone is asleep and Dragon is temporarily not
listening.
When you want to resume dictating:

Say "Wake Up" or click the plus key (+) to resume
voice recognition.

The microphone is turned off.
When you want to resume dictating, do one of the fol-
lowing:

Press the plus key (+) on the numeric keypad.

Click the microphone button on the DragonBar.

Click the microphone icon in the Windows taskbar.

No User Profile is loaded and the microphone is off.

See Controlling the Microphone in the Dragon Help for more information.

The Volume Display

When Dragon hears you well, the volume display turns green and expands to the
right. When you pause between words, the volume display turns yellow and contracts. No
color displays when the microphone is turned off or is not responding. The display turns
gray when the microphone is in Sleep Mode.

The Text Control Indicator

The DragonBar includes a Text Control Indicator that changes to indicate the level of

speech support in the selected application. See The Text Control Indicator for details.

Recognition Mode Indicator

The Recognition Mode Indicator is an icon on the DragonBar that changes its appearance

when you change Dragon's recognition mode. The default is Normal mode .

You can set Dragon to interpret your speech in the following ways:

n Dictation only - Dragon listens for dictation of words and punctuation only. Nothing

you dictate is interpreted as a command.

n Commands only - Dragon listens for dictation of commands only. Nothing you dic-

tate is interpreted as words (except commands), numbers, or letters.
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n Numbers - Dragon listens for dictation of numbers, commands, and punctuation only.

Nothing you dictate is interpreted as words (except commands) or individual letters.

n Spelling - Dragon listens for dictation of individual letters, commands, and punc-

tuation only. Nothing you dictate is interpreted as words (except commands) or

numbers.

The table below provides a brief overview of the Recognition modes icons. Click the links

for more information about using the Recognition modes.

Drag-
onBar
Mode
icons

Rec-
ognition
modes What they do

Normal Mode Dragon's default mode of dictation. In Normal Mode,
Dragon distinguishes dictation from words, numbers, and
commands by analyzing what you say between pauses.
Say "Start Normal Mode" or "Normal Mode On."

Dictation
Mode

A restricted recognition mode that causes Dragon to inter-
pret everything you say as dictation and nothing is inter-
preted as a command. Dictation Mode can be helpful if you
want to dictate as quickly as possible, or dictate without
looking at the words Dragon transcribes. Say "Start Dic-
tation Mode" or "Dictation Mode On."

Command
Mode

A restricted recognition mode that causes Dragon to inter-
pret everything you say as a command and nothing is inter-
preted as dictated text. Say "Start Command Mode" or
"Command Mode On."

Numbers
Mode

A restricted recognition mode that causes Dragon to rec-
ognize only numbers. If you are dictating only numbers
(including currencies), working in this mode increases rec-
ognition accuracy. Say "Start Numbers Mode" or "Numbers
Mode On."

Spell Mode A restricted recognition mode that causes Dragon to rec-
ognize only letters, numbers, commands, and punctuation.
Spell mode is useful for dictating unpronounceable alpha-
numeric strings, such as part numbers and license plate
numbers, and other terms you anticipate Dragon won’t
know, such as Web addresses, words in a foreign lan-
guage, or unusual product names. Say "Start Spell Mode"
or "Spell Mode On." You can still use commands while in
Spell Mode.
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Message area
To the left of the menus is a messages display, which shows Dragon's current status, such

as whether the microphone is on or off. If you turn off "Show messages" on the , the Extras

toolbar shows in place of the Message area.

The menus
The menus on the DragonBar contain the commands you can use while working in Dragon.

Extras toolbar icon
Click the icon or say "Show Extras Bar" to display the Extras toolbar, which contains the fol-

lowing features:

Display Correction menu

Click the Correction button to stop playback and correct a mistake.

Playback controls

Use the controls to hear audio files of dictation:

n Begin Playback

n Stop Playback or Text-to-speech

n Begin Rewind

n Begin Fast Forward

Read That button

Click the Read That button to have Dragon read back a recording of your dictation.

Transcribe button

Click the Transcribe button to open the , which you use to transcribe recordings of dic-

tation made on portable recorders.

Open User Profiles button

Displays the name of the current User Profile to the right of the Transcribe button. Click

on the User Profile name to open the . Note that this button appears only when Dragon is

docked to the top or bottom of your screen.

Notes

n Unless your computer is equipped with a full-duplex sound card, it's not possible to

stop playback by voice, because the computer can't hear speech when it's playing

back dictation.

n Playback is available for documents dictated with Microsoft Word, Corel Word-

Perfect, and DragonPad. only until you close a document. After you close a doc-

ument, Dragon deletes the recorded dictation for that document.
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n The "Show Extras Bar" voice commands toggle the state of the Extras toolbar. In

other words, if you use this command to show the Extras toolbar, saying the command

again hides the Extras toolbar.

The Text Control Indicator
The DragonBar includes a Text Control Indicator that changes to indicate the level of speech

support in the selected application.

Full Text Control

The Text Control Indicator turns green (as shown) when you use programs and windows

with Full Text Control. Most standard text fields allow full Full Text Control capabilities.

The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after

<xyz>…) work thanks to a functionality called Full Text Control. This functionality

depends on Dragon’s ability to constantly obtain information from the text field about its con-

tent—for instance, in order to know where words and sentences begin and end—so Dragon

can apply spacing between words and capitalization at the beginning of sentences.

Basic Text Control

When Dragon has Basic Text Control, the Text Control Indicator turns gray (as shown), indi-

cating that you may have some difficulty selecting and editing dictated text.

If you have difficulty dictating or correcting text in a particular program or window, Nuance

recommends that you use the Dictation Box.

For more information

For more information, see:

n Using the Dictation Box

Displaying the DragonBar
There are five different ways (or modes) that you can display and use the DragonBar. You

can also specify whether or not the DragonBar always appears on top of the active window.
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To open a menu on the DragonBar

1. Say "Switch to DragonBar" to make the DragonBar active

2. Say the name of the menu and menu item you want to open.

For example, say "Switch to DragonBar" then "Tools" then "Auto-Formatting Options."

To change the DragonBar display mode

1. Click on the Dragon icon on the left side of the DragonBar or right-click anywhere on

the DragonBar to open the DragonBar shortcut menu.

2. Click the mode you want. The DragonBar has five display modes:

DragonBar Docked to Top

The DragonBar always stays at the top of the screen. This is the mode in which

the DragonBar appears the first time you start Dragon.

DragonBar Docked to Bottom

The DragonBar always stays at the bottom of the screen. If the Windows task-

bar is visible at the bottom of the screen, the DragonBar appears just above it.

Floating DragonBar

The DragonBar appears in a window you can drag around the screen.

Clinging DragonBar

The DragonBar "clings" to the top left of the active window. When you drag

the active window to a new location on your screen, the DragonBar moves with

it. In Cling mode, you do not see the Extras toolbar icon.

Tray Icon Only

The DragonBar is not visible on the screen. Only the microphone icon in the

Windows system tray indicates that Dragon is running.

To return to the last DragonBar mode, right-click on the microphone icon and

click Restore Previous DragonBar Mode.

To switch between DragonBar displays

You can also say "Switch To," "Change To," or "Select" and the name of the mode. For

example, if the DragonBar is set to Docked to Top, you could say "Switch To Docked to

Bottom" or "Change To Floating DragonBar" and so on.

Always on Top

By default, Dragon always appears "on top," meaning it is in the foreground of your com-

puter display. For the Floating DragonBar, you can change the setting so that the DragonBar

drops into the background like other window when you maximize or open a new window

large enough to hide the current one.
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Note: These commands toggle the state of the Floating DragonBar. In other words, if you

use a command to turn off the Always On Top setting, and you then say the command again,

the DragonBar reverts to Always On Top.

To change the setting

1. Click on the Dragon icon on the left side of the DragonBar or right-click anywhere on the

DragonBar to open the DragonBar shortcut menu.

2. Do any of the following:

n Say "Set DragonBar to Always On Top" or "Make DragonBar Always on Top."

n On the DragonBar shortcut menu, click Always on Top.

Note

When you set the DragonBar to "Always on Top" it covers parts of other Dragon windows,

such as the DragonPad and Help screens. If necessary, you can turn off "Always on Top" or

move the windows around so that they are not obscured.

Controlling the DragonBar
You can control the DragonBar and get help with Dragon using the following voice com-

mands:

To Say

Click a DragonBar
menu item

1. "Switch to DragonBar" to make the DragonBar active.
2. The name of the menu you want to open.

Start the Drag-
onPad word proc-
essor

"Start DragonPad"

Display Dragon
Help

"Give Me Help"

Display common
voice commands
for your current
program, window,
or text field

"What Can I Say"

Switch the Drag-
onBar mode

"Switch To" or "Select" and the mode name ("Floating Mode,"
"Docked to Top Mode," "Docked to Bottom Mode," "Cling Mode," or
"Tray Icon Only Mode")
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To Say

Display the Drag-
onBar when it is in
Tray Icon only
mode

"Open Dragon’s tray menu”

Change the Drag-
onBar Always on
Top setting

"Set DragonBar to Always On Top" or "Make DragonBar Always on
Top"
These commands toggle the state of the DragonBar. In other words,
if you use one of these commands to make the DragonBar appear
always on top and you then say the command again, the DragonBar
will be put into a state where it can be covered by other windows.

Exit Dragon (and
close the Drag-
onBar)

1. "Exit Dragon"
If you also have your User Profile open and have made corrections
with the Correction menu, or made updates with the Vocabulary
Editor, Dragon asks if you want to save the changes.
2. Say "Yes" to save the changes.
You can use the "Exit Dragon" command from the DragonBar Control
menu (click the Dragon icon at the left) and from the Profile
menu.

Note

When you set the DragonBar to "Always on top" it will cover secondary Dragon windows,

such as the DragonPad and Help screens. In these cases, you will have to turn off the

"Always on top" state or move the windows around so that they are not obscured.
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Using the Microphone
This section contains the following topics:

Choose a speech device 63

Position your microphone properly 65

Choose a speech device
Use this screen to tell Dragon what type of dictation source you'll be using. If you need to

add another dictation source later on, you can later.

Microphone (live dictation)

Use this section for details about microphone choices.

Mic-in jack (most common)

Select this option if your microphone has jacks.

n Computers with built-in audio usually have mic-in jacks on the front. If your com-

puter has jacks in both the front and back, connect your microphone to the back.

n Most newer computers and microphones use standard colors for jacks and plugs. The

microphone jack and plug are pink and the headset jack and plug are green.

n Some newer computers have a combined jack for headset and microphone audio. If

your headset has two separate plugs but your computer has a combined jack, plug the

headset into a Y-splitter adapter, then plug the adapter into the jack.

n Older computers and microphones use a variety of labels and colors, often without

words. They may be labeled "Mic" or with a symbol representing a microphone. Some

microphone plugs and jacks are red.

n Microphone jacks are different from line-in jacks, which you normally should not use.

Microphones typically produce low audio levels that get boosted when connected to

the microphone jack. The line-in jack doesn't boost audio levels.

USB

Select this option if your microphone has a USB connector. USB microphones don't rely on

a computer's sound card to process speech, so using one can alleviate problems with sound

card quality.

Connect your microphone directly into one of your computer's USB ports, not through the

port of a docking station or through a USB extension or hub.

Bluetooth and Enhanced Bluetooth

Select one of these options if you have a Bluetooth microphone and your computer is Blue-

tooth-enabled.

If you plug in the USB adaptor for a certified wideband Bluetooth microphone, such as the

Plantronics “Calisto II” BT-300, before you open Dragon, the list of audio sources will con-

tain the option “Enhanced Bluetooth” during this step of the user profile wizard.
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For a list of fully supported Bluetooth microphones, please see http://-

support.nuance.com/compatibility/.

Note: Please consult your Plantronics Calisto Bluetooth user guide for setup and oper-

ational details with your device. The user guides are also posted on the Nuance User Doc-

umentation page. See also If your Bluetooth microphone doesn't connect with Dragon in

the Dragon Help.

Dragon Remote Microphone application

Use the Dragon Remote Microphone application if you want to use a mobile device as a

wireless microphone.

If you chose the Dragon Remote Microphone application, you must also install the Dragon

Remote Microphone application on the mobile device. For more information, see Using a

mobile device as a wireless microphone in the Dragon Help.

The Dragon Remote Microphone application supports the following devices:

n Apple iPhone 3GS and higher, iPad 1, 2, and 3, and iPod touch 4 and higher using

iOS 4.2 and higher. For iOS devices, the app is available from iTunes and the App

Store.

n Mobile devices and tablets using Android OS 2.2 and higher. For Android-based

devices, the app is available from Google Play (formerly called the Android Market).

For more information about downloading and installing the application and the latest list of

supported devices, on Nuance.com click here.

Line-In Jack (not recommended)

Use this option if you are connecting a microphone through a line-in jack (not rec-

ommended). Microphones typically produce low audio levels that get boosted when con-

nected to the microphone jack. The line-in jack doesn't boost audio levels.

Recorded audio device

Use this section for details about selecting handheld recording choices. If your Dragon

installation is configured to use with commands only, you won't see this section.

Handheld or smartphone with recording application

Select this option if you'll be dictating with a mobile devicecapable of storing digital record-

ings and transferring them to your computer.

Digital audio recorder (includes .wav, .mp3, .wma, .dss, .ds2)

Select this option if you'll be dictating with a digital recorder.

You can only use unencrypted .dss or .ds2 files when creating a User Profile with a portable

recorder.

Sony "Digital Voice Editor" software (.msv, .dvf)

Use this option if you'll be dictating with a Sony Digital Voice Editor recorder.
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Notes

n If you switch between microphones you must at least rerun the audio check. For best

accuracy, create a different User Profile for each device you plan to use.

n Some editions of Dragon allow you to create and train User Profiles with multiple dic-

tation sources. For example, with the same User Profiles, you can dictate with a head-

set microphone or a portable recorder. For more information, see .

Position your microphone properly
Use this screen to help you position your microphone for optimal speech recognition. Posi-

tioning the microphone correctly is one of the most important things you can do to enhance

recognition accuracy. If the microphone moves even slightly away from the optimal position,

your recognition accuracy may significantly deteriorate.

Use the pictures and descriptions on the wizard screen and in this topic as guides for micro-

phone positioning.

To position a headset microphone

n Adjust the headset so that it fits comfortably.

n Move the microphone element to the side of your mouth to avoid noise from breath-

ing.

n Make sure that the microphone element is close to your mouth, but not touching it

(about an inch from the side of your mouth).

n Confirm that the front of the microphone points toward your mouth. The front may

be indicated by a colored dot, the word "Talk," or some other label.

n Position the headset consistently every time you use it.

The following graphics illustrate how to wear a headset microphone.

To position a handheld microphone or recorder

n Point the microphone element to the side of or below your mouth to avoid noise from

breathing. Do not hold the microphone directly in front of your mouth.
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n Hold the microphone in a comfortable position. Make sure not to hold it in an awk-

ward, tiring position.

n Make sure that the microphone element is about 1 to 3 inches away from your

mouth. You should keep the microphone distance in this range, but you don't have

to always keep the microphone at exactly the same distance.

n Hold the microphone so that the front points toward your mouth. Don't talk into the

side of the microphone.

n Hold the microphone consistently every time you use it. Be careful not to move the

microphone or your head suddenly.

n Do not use a microphone stand or holder because it will be harder to keep a con-

sistent position and the stand may conduct noise.
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Using the Dragon Sidebar
This section contains the following topics:

Using the Dragon Sidebar 67

The Dragon Sidebar tabs 70

Dragon Sidebar Tips 72

Using the Dragon Sidebar
Use the Dragon Sidebar to see sample commands and tips that update dynamically as you

switch between programs and windows. For the list of programs with the highest com-

patibility with Dragon, see Dragon Sidebar Help and Tips contexts.

The Sidebar displays automatically when you open a Dragon User Profile. You can change

the default display setting of the Sidebar from the Miscellaneous tabMiscellaneous tab of the

Options dialog box. If the Sidebar is closed, you can open it any time by saying “Show

Dragon Sidebar”.

The Sidebar is divided into upper and lower sections, called panes.

n The top pane of the Sidebar provides clickable links to Help topics, shows examples

of commands available in the current application, and organizes the information by

tabs. See Dragon Sidebar tabs for details.

n The lower pane of the Sidebar contains tips. See Dragon Sidebar Tips for details.

You can dock the Sidebar on the left or right side of the screen, set it to auto-hide, or set it

to "float" like other windows, change its font size, and place it anywhere you want on the

Windows Desktop. You can also maximize, minimize, or resize the Sidebar.

Controlling the Dragon Sidebar

You can use the following voice commands with the Sidebar, whether it's the active window

or not. Most commands require that the Sidebar be open.

To Say this Or do this

Show the Sidebar "What can I say?"
"Dragon Sidebar" (You can also use

any of the following verbs: "Open",
"Launch", "Start", "Show", or "Show
Me")
"Sample Commands" (You can also

use any of the following verbs:
"Open", "Launch", "Start", "Show", or
"Show Me")
"Command list" (You can also use

any of the following verbs: "Open",
"Launch", "Start", "Show", or "Show
Me")

Select Dragon Sidebar
from the DragonBar Help
menu
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To Say this Or do this

"Switch to Dragon Sidebar"

Show the Sidebar
Home tab

"Dragon Sidebar Home" Select the Home tab on the
Sidebar

Show the Sidebar
Global tab (displays
when you are work-
ing in programs with
Full Text Control)

"Dragon Sidebar Global" Select the Global tab on the
Sidebar

Show the Sidebar
Mouse tab

"Dragon Sidebar Mouse" Select the Mouse tab on the
Sidebar

Show the MyCom-
mands tab

"Dragon Sidebar My Commands" Select the MyCommands
tab on the Sidebar

Switch to the next
Sidebar pane

"Go to the next pane"
"Switch to the next pane"

Click the next pane on the
Sidebar

Switch to the pre-
vious Sidebar pane

"Go to the previous pane"
"Switch to the previous pane"

Click the previous pane on
the Sidebar

Dock the Sidebar to
the right

"Dragon Sidebar dock right" Right-click on the Sidebar
and select Dock right

Dock the Sidebar to
the left

"Dragon Sidebar dock left" Right-click on the Sidebar
and select Dock left

Change the font size
of the Sidebar

"Dragon Sidebar Font [Small |
Medium | Large]"

Right-click on the Sidebar
and select Font
Size > Small, Medium or
Large

Float the Sidebar "Dragon Sidebar float"
or
"Dragon Sidebar undock"

Right-click on the Sidebar
and select Floating

Auto-hide the Side-
bar (not available in
Floating mode)

"Dragon Sidebar auto-hide" Right-click on the Sidebar
and select Auto-hide

Disable auto-hide
(not available in
Floating mode)

"Dragon Sidebar stop hiding" Right-click on the Sidebar
and deselect Auto-hide

Set the Sidebar to
Always on Top

With the Sidebar active, right click
and say "Always on Top"

Right-click on the Sidebar
and select Always on Top
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To Say this Or do this

Turn off Always on
Top

With the Sidebar active, right click
and say "Always on Top"

Right-click on the Sidebar
and deselect Always on Top

Increase the Side-
bar width by 5 per
cent

"Dragon Sidebar wider" With the Sidebar

active, press the key

combination

<ALT+W>

Decrease the Side-
bar width by 5 per
cent

"Dragon Sidebar thinner" With the Sidebar

active, press the key

combination

<ALT+T>

Hide the Tips "Dragon Sidebar hide tips" Right-click on the Sidebar
and deselect Tips

Show the Tips "Dragon Sidebar show tips" Right-click on the Sidebar
and select Tips

Show your custom
commands

"Dragon Sidebar show my com-
mands"

Select the My Commands
tab on the Sidebar

Print Sidebar com-
mands

– Right-click on the Sidebar
and select Print

Show the Sidebar
Help

"Dragon Sidebar Help" Click the question mark
icon on the top right-hand
side of the Sidebar window

Close the Sidebar With the Sidebar active, say
"Dragon Sidebar close"
or
"Close window"

Right-click on the Sidebar
and select Close
Click Close on the Sidebar

Dragon Sidebar Help and Tips contexts

Use the Sidebar for Help and Tips about Dragon in these programs and contexts:

n Desktop commands

n Global commands

n DragonBar, DragonPad, Dictation Box, Spelling window (see Dragon Help), Com-

mand Browser

n Microsoft Word, Microsoft Excel, Microsoft Outlook, Windows Mail. Please see the

Dragon Help for Microsoft Outlook Express, Microsoft PowerPoint, and Microsoft

InfoPath.

n .Corel WordPerfect (see Dragon Help)

n .Lotus Notes (see Dragon Help)
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n OpenOffice.org Writer (see Dragon Help)

n Internet Explorer and Mozilla Firefox

Note

A list of global commands appears if there is no list of specific commands available for a spe-

cific program.

The Dragon Sidebar tabs
You can use the Dragon Sidebar to review examples of speech commands in your current

program or task. The contents of the Sidebar update automatically as you change appli-

cations. See Dragon Sidebar Help and Tips contexts for details.

The Sidebar displays tabs across the top that you can click for the most popular commands

for your current task. Click the following links for details about the tabs:

n Home tab

n Global tab

n Mouse tab

n MyCommands tab

Click the green subheadings in the Sidebar to follow links to Help topics about how to use

voice commands with your programs.

See Using the Dragon Sidebar for more information.

Home tab

Use the Home tab to review examples of voice commands for programs with Full Text Con-

trol. Below is an example of what you'll see if you're working in Microsoft Word or Corel

WordPerfect. If you're working in Microsoft Outlook Express, you'll see Outlook Express

commands, and so on, for all programs with Full Text Control. Click the green Sidebar sub-

headings for detailed Help topics.
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Global Commands

For programs with Basic Text Control, the Home tab displays a list of common dictation

commands. Click the Sidebar subheadings for detailed Help topics.

Global tab

You can click the Global tab for a list of Global commands available in programs with Full

Text Control. Click the Sidebar subheadings for detailed Help topics.

Mouse tab

Click the Mouse tab to review examples of common voice commands you can use to control

the mouse in your current application. Click the Sidebar subheadings for detailed Help top-

ics.
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MyCommands tab

Use the MyCommands tab to view custom commands you have created. Click the Sidebar

subheadings for detailed Help topics.

Note

This topic shows examples only. Open the Sidebar to see all of the available commands.

Dragon Sidebar Tips
The Dragon Sidebar shows randomized tips about the current application or task context.

To make the Dragon Sidebar active if it isn't already, use the Show the Sidebar command.

Tips display in the lower pane of the Sidebar window. You can hide or display the tips, and

navigate them using links for Back and Next.
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Chapter 4: Dictating Text

This section contains the following topics:

Dictation Basics 73

Undoing actions 74

Correcting text errors as you dictate 75

Dictation commands 76

Typing or spelling text 77

Spelling words 78

Dictating numbers 80

Using the Dictation Box 83
Using the Dictation Box 83

Using Dictation Box in unsupported applications 83

Turning off the Dictation Box 83

Unsupported applications 83

Transferring your text 84

The Full Text Control Indicator 84

Dictating in unknown text fields 85

Editing text in unknown text fields 85

Defining how the Dictation Box works in different applications 85

Unexpected behavior or text in the Dictation Box 86

Dictation Box Settings 86

Using DragonPad 89
About DragonPad 89

Changing the way text wraps on your screen 89

Dictation Basics
Dictate to Dragon much as you would dictate to a person transcribing your dictation. By

default you must explicitly say most punctuation and capitalization other than for proper

names or at the beginning of a sentence. You can have Dragon automatically insert commas

and periods in most situations by selecting the "Automatically add commas and periods" box

on the Auto-formatting dialog box. For more information, see Dictating punctuation and sym-

bols and Dictation commands.

The following table describes some basic dictation commands.

To start dictating, just say whatever you want to say, speaking normally in phrases. Then:
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To Say

Start a new paragraph (press the Enter key
twice)

"New Paragraph"

Start a new line (press the Enter key once) "New Line"

Enter punctuation marks, such as "!" The name of the punctuation mark, such as "excla-
mation point"

Dictate symbols or special characters such
as "®"

The standard name of the symbol, such as "registered
sign"

Complete listing of dictation commands

Click on the following links for more information about common dictation tasks:

Dictating e-mail and Web addresses

Undoing actions

Moving the cursor

See alsoWorking in Programs on page 127

In the Dragon Help, see:

Dictating in programs

Dictating punctuation and symbols

Dictating proper and place names

Dictating hyphenated and compound words

Dictating acronyms and abbreviations

Dictating a bulleted list

Replacing what you last dictated

Undoing actions
You can reverse the result of a command or dictation in the following ways:

To undo most actions

Say "Undo That," "Undo Last Action," or just "Undo."

Example:

To undo the command "Italicize That," say "Undo That."

To undo dictation

Say "Scratch That."

Example:

To remove text just after you dictated it, say "Scratch That."
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Notes

n You can cancel a selection by saying "Unselect That," selecting different text, or mov-

ing the insertion point to another part of the document.

n The "Undo That" and "Undo Last Action" commands send an undo (CTRL+z) com-

mand to the active program. The result of the command depends on which program is

active and how it handles the undo command. For example, if you say "Undo That"

twice in a row in the DragonPad window, the second Undo reverses the first com-

mand and restores the original dictation. Other programs may behave differently.

n The Accuracy Center provides a central location for taking advantage of all the Dragon

tools available to ensure excellent recognition. For more information, see Using the

Accuracy Center.

Correcting text errors as you dictate
Use the procedures in this topic if you notice that Dragon misrecognizes a word or words

while you are dictating. When you correct errors, Dragon learns not to make the same mis-

takes again.

Click here for Dragon's Top 5s: "Correcting text"

To correct a word or phrase with the Correction menu

1. Say "Select <text>," where text is the incorrect word or phrase. If the error is in the last

thing you said, you can just say "Select That." (Also see Tips for selecting text). Dragon

highlights the word or phrase, and the Correction menu appears.

2. If the correct word or phrase is on the list, start spelling to choose it, or say "Choose" and

the number of that choice. For example, say "Choose 2." Do not say "Choose Numeral

Two" or Dragon will transcribe the phrase as the text "Choose Numeral Two" or "Choose

2" depending on how you set the number formatting options on the Auto-formatting

dialog box.

3. If the word or phrase you want is not on the list, spell the word, or say "Spell That" and

spell the word letter by letter.

Dragon's Smart Format Rules box may appear when you correct auto-formatted alphanumeric

text using the Correction command, the Spelling window, or the keyboard. For details, see

Using Smart Format Rules and Setting Auto-Formatting Options.

The Spelling window appears. You can use this dialog box to spell or type the correct word.

Notes

n Dragon also learns from your typing – if you use the keyboard to correct a mis-

recognized word, Dragon learns from the correction and can use the word the next

time you dictate it.

n The Accuracy Center provides a central location for taking advantage of all the Dragon

tools available to ensure excellent recognition. For more information, see Using the

Accuracy Center.
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n The Correction tab of the Options dialog box lets you control the behavior of the

Correction menu, including the commands that make it appear.

n If you would rather not see the Correction menu every time you select text, you can

turn it off. On the Correction tab of the Options dialog box, clear the box that says

"'Select' commands bring up Correction menu." Then click Apply.

n If you want to open the Spelling window when you start to correct a word or phrase,

select "Correct commands bring up Spelling window" on the Correction tab of the

Options dialog box.

n If you select a phrase to correct that includes punctuation added to the sentence auto-

matically, the list of corrections that appears in the Correction menu will include a

version without the automatically inserted punctuation.

n In some applications, you may have difficulty revising selected text. In this case, you

may need to use the Dictation Box. Just select the text you want to revise and say

"Show Dictation Box" or "Edit Selection."

Dictation commands
When you are dictating, you can say the following dictation – also referred to as "in-line" –

commands without pausing.

Say To

"new line" Press the Enter key once

"new paragraph" Press the Enter key twice,
capitalize next word.

"cap<word>" Type <word> with an initial capital

"caps on" Start typing words with initial capitals

"caps off" Stop typing words with initial capitals

"all caps <word>" Type <word> in all uppercase

"all caps on" Start typing words in all uppercase

"all caps off" Stop typing words in all uppercase

"no caps <word>" Type <word> in all lowercase

"no caps on" Start typing words in all lowercase

"no caps off" Stop typing words in all lowercase

"no space <word>" Do not put a space before <word>

"no space on" Stop putting spaces between words

"no space off" Start putting spaces between words

"numeral" Enter the next numbers stated as Arabic numerals (1,2,3 ...)

"Roman numeral" Enter the next numbers stated as Roman numerals (i, ii, iii ...)
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Notes

n When you are in Dictation mode, Dragon interprets everything you say as dictation

and only Dictation Commands are recognized. Dictation Mode can be helpful if you

want to dictate as quickly as possible, or dictate without looking at the words Dragon

transcribes. Say "Start Dictation Mode" or "Dictation Mode On."

n To enter the word "cap" (as in "baseball cap"), pause after saying "cap."

n The capitalization and spacing modes are automatically canceled if you move around

your document.

n If you move the cursor (insertion point) by mouse or keyboard, or change windows,

the next word you say will not be capitalized. You may need to capitalize the word

manually and insert a space.

n You can enable or disable some Dragon's capitalization commands by setting the

"Caps Lock key overrides capitalization commands" option in the Auto-formatting

dialog box.

Typing or spelling text
In the Spelling window, you can use the keyboard to enter words as well as say the letters of

the words. You can spell continuously or you can pause between letters. As you type or say

each letter, the list of alternatives changes. If the text you want appears before you finish,

you can simply choose it.

To type or spell text

1. Type or say the letters of the word(s).

2. If the text you want appears in the list, choose it. For example, say "Choose 2."

3. If necessary, type or spell the word(s) completely.

4. Say "Click OK."

The Spelling window closes and the text is entered in your document. If you had selected

text to correct, the new text now replaces the old text.

Note

The "Scratch That" command is not available in the Spelling window. If you need to correct

a dictation error while you are using the Spelling window, you must use the Backspace key or

Delete command.
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Voice commands that work in the Spelling window

Command Result

Choose <1-9> Chooses a number from the list of alternative spellings

Select <1-9>
Edit <1-9>
Or
Modify <1-9>

Selects a line from the list of choices in the Spelling window and puts
it in the edit box. You can then change the text either by voice or typ-
ing.

Select last/next
<number> char-
acters

Selects the specified number of characters

Move right/left
<number> char-
acters

Moves the text insertion point

Select That Selects the last utterance (word or letter), or the whole line of text if there has
been no previous selection

Delete/Scratch
That

Deletes the selected text, or the whole line of text if there has been no previous
selection

Go To End/Be-
ginning of Line

Moves the text insertion point

Notes

n Typing letters into the Spelling window searches Dragon's Vocabulary for a matching

word. If you must type the full word, it is because it is not in the active Vocabulary

or the backup dictionary. When you save a User Profile, any words you add in the

Spelling window are added as new words to the active Vocabulary.

n If one of the recognition alternatives is nearly correct, you can say "Select" and the

number of the alternative. The alternative text appears in the text box where you can

edit it.

n The voice command "Delete Next/Previous Word" does not work in the Spelling

window.

Spelling words
If a word or phrase is not currently in Dragon's Vocabulary, you can spell it in the Spelling

window, and add it to Dragon's Vocabulary. Words you spell directly into the document,

while the Spelling window is closed, are not added to the Vocabulary. In addition, you can

teach (or "train") Dragon to recognize how you pronounce the word or phrase you spell.
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In some cases, you may not know that a word is not in the active Vocabulary until Dragon

fails to recognize it correctly. Whether you are spelling a word as part of your dictation or cor-

recting a misrecognition, the process is the same.

To spell a word or phrase

When you want to add a new word to the Vocabulary, say "Spell" or "Spell That" (imme-

diately after a recognition error) and the characters of the word or words you want to spell.

Say the characters continuously and quickly, not one at a time.

Note

The "Scratch That" command is not available in the Spelling window. If you need to correct

a dictation error while you are using the Spelling window, you must use the Backspace key or

Delete command.

For a list of the characters you can spell with the "Spell" or "Spell That" commands, see Spell-

ing characters.

If you use the "Spell That" command, saying the characters immediately is optional; you can

simply wait for the Spelling window, to open before you begin spelling. Spelling words while

the Spelling window is open allows you to confirm that the word is correct before it appears

in your document and allows you to train the pronunciation of the word. For information on

training a word that you have spelled, see the topic Training words from the Spelling

window.

For previously dictated text, select the word or words you want to correct, then say "Spell

That" followed immediately by letters.

Example: Spell That

Notes

n Normally, the Spelling window, does not appear when you use the "Spell" command.

You can make it appear by selecting the "Spell commands bring up Spelling window"

option on the Correction tab of the Options dialog box.

n While you are spelling words, you must say "cap" before each character you want to

capitalize. Pause briefly after saying the capital letter and before you say the next

letter.

n You can say "Double" before any alphabetic character to enter two of the same char-

acters. For example, say "Double a" to enter "aa." You can also say "Double Zulu" to

enter "zz." You cannot, however, say "Double u" to get two "u" characters (and not

"w"). In this case, you can say "Double Letter u."

n You cannot say the normal forms of letters (for example "A") and their alpha-bravo

forms (for example "Zulu") together in a single breath ("A Zulu"). You can mix them if

you pause before you change the spelling format.

n You can say nearly any character of the standard Windows character set. See the See

Also below for a full list of the characters you can say.
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n If you are planning to do a large amount of spelling in a document, consider turning

Spell Mode on (say "Spell Mode" or click Modes > Spell Mode). In Spell Mode,

Dragon tries to interpret everything you dictate as letters.

Dictating numbers
In most cases you can dictate numbers, including postal codes, as you normally say them. If

you want to dictate only numbers, as, for example, when dictating in a spreadsheet program,

you can turn on Numbers Mode.

80



Dragon 12 Installation and User Guide

Examples

To enter Say

4 "four" or "numeral four"

23 "twenty three"

179 "one hundred seventy nine", "one hundred and seventy nine," or "one seventy
nine"

5423 "five thousand four hundred twenty three"

5.423 "five point four twenty three"

142,015 "one hundred forty two thousand and fifteen"

127,400,042 "one hundred twenty seven million four-hundred thousand forty-two"

127 billion "one hundred twenty seven billion"

0.03 "zero point zero three" or "oh point oh three"

2 3/4 "two and three fourths"

11/32 "eleven over thirty two"

565-5000 "five six five five thousand"

781-565-5000 "seven eight one five six five five thousand"

$45 "forty five dollars"

$99.50 "ninety nine dollars and fifty cents"

€1.7 billion "One point seven billion Euros"

8:30 p.m. "eight thirty pm"

200 kg "200 kilograms"

50 meters "50 meters"

May 15, 2003 "May fifteen comma two thousand three" (Note: Saying "comma" is optional.)

MMIV "Roman numeral two thousand four"

iii (lowercase
Roman)

"Roman numeral three" "no caps that"

Boston, MA 02460 "Boston Massachusetts 02460"

Oakland, CA 99077 "Oakland California 99077"

Notes

n Most of these examples only work as shown when the appropriate number formatting

options are selected on the Auto-formatting dialog box.

n If you want a comma in a four-digit number, you must speak it explicitly. Numbers

with five or more digits automatically include commas.

81



Chapter 4: Dictating Text

n To force recognition of digits as numerals instead of text without using the Numbers

Mode, say "Numeral" before you say the digit, for example, say "Numeral Three" to

get 3.

n You can use or omit the word "and" as part of a number. For example, say "one hun-

dred fifty" instead of "one hundred and fifty" to get the number 150.

n You can use "oh" and "zero" interchangeably to get 0.

n The way Dragon formats the currency symbol, the thousand separator, the decimal

separator, the negative symbol, and the time separator depends on the configuration

of the Regional Settings (or on some versions of Windows, Regional Options) in the

Windows Control Panel. For these numbers to be formatted according to the con-

ventions of the language you are dictating, you must make sure that the Windows

Regional Settings match the language.

n You can set the currency symbol and format that Dragon uses by selecting the "ISO

currency codes" option on the Auto-formatting dialog box. Dragon then uses the cur-

rency character and format specified on the Regional Options tab of the Regional and

Languages Options tool in your Windows Control Panel. If you are using the Classic

Start menu, you can open your Windows Control Panel by clicking Start on the Win-

dows Taskbar, pointing to Settings, and then clicking Control Panel.

n You can change the way Dragon formats numbers on the Auto-formatting dialog box

by turning on or off the different formatting options available on the tab.

n You can change the way Dragon formats Canadian and UK postal codes on the Auto-

formatting dialog box by turning on or off the "Street addresses" option. For exam-

ple, with the option on, format a postal code in London by saying "London Comma

W Two Four R J" to enter London, W2 4RJ; and format a postal code in Toronto by

saying "Toronto Comma Ontario M Five H Two L Two" to enter Toronto, Ontario

M5H 2L2. You must reload your User Profile before a change to postal code for-

matting will take effect. To reload a User Profile, click Open User Profile on the Pro-

file menu to open the Open User Profile dialog box. Make sure the correct User

Profile is selected (the current User Profile is selected by default), and click Open.

n Dragon can auto-format text and numbers using standard writing conventions or

apply Word Properties to words as you dictate. For information about these settings,

see Auto-formatting dialog box and The Word Properties dialog box.

n Dragon's Smart Format Rules appear when you correct auto-formatted alphanumeric

text or Word Properties using the Correction menu, the Spelling window, or the key-

board. For details, see Using Smart Format Rules and Setting Auto-Formatting

Options.
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Using the Dictation Box
This section contains the following topics:

Using the Dictation Box 83

Using Dictation Box in unsupported applications 83

Turning off the Dictation Box 83

Unsupported applications 83

Transferring your text 84

The Full Text Control Indicator 84

Dictating in unknown text fields 85

Editing text in unknown text fields 85

Defining how the Dictation Box works in different applications 85

Unexpected behavior or text in the Dictation Box 86

Dictation Box Settings 86

Using the Dictation Box
Normally you can dictate and use Dragon voice commands in any text window of any appli-

cation. However, you may occasionally find an application or a specific window in an appli-

cation where you cannot dictate and/or where some voice commands won’t work or won't

work consistently. These exceptions are called "unsupported applications" or unknown text

fields.

Using Dictation Box in unsupported applications
The Dictation Box opens automatically if Dragon notices that you are trying to dictate in an

unsupported application or window within an unsupported application.

Turning off the Dictation Box
If you don't want Dragon to display the Dictation Box in unsupported applications

1. On the DragonBar, select Tools > Options > Miscellaneous.

2. Click or say "Use the Dictation Box for Unsupported Applications" to clear the check-

mark from the box.

3. Click OK to apply your changes to the current session. When you save your user profile,

the settings will be saved for future dictation sessions.

Unsupported applications
Some examples of unsupported applications would be presentation or page layout or graphics

design software like Adobe Photoshop. Here are some examples of known issues in unsup-

ported applications:

n Dictating into a complex Lotus Notes document sometimes makes Dragon hang or

exhibit other abnormal behavior.

83



Chapter 4: Dictating Text

n Some Microsoft Outlook users may find that the Full Text Control editing capability

does not always work.

n Some applications, such as Netscape, are not supported for Full Text Control editing

at all.

Transferring your text
When you are ready to move your dictation from the Dictation Box to the unsupported

application, say "Transfer" or click the Transfer button to transfer the text into that appli-

cation.

Note: The Dictation Box works for all applications that can accept standard keyboard short-

cuts for Windows Clipboard operations. In some applications that do not accept these com-

mands, your text may be lost or changed when you transfer text in and out of the Dictation

Box. Test your application before you start and, if you lose text when you try to transfer

text to the application, try different selections under the Copy and Paste options (see Dic-

tation Box Settings).

The Dictation Box can transfer text in plain or Rich Text Format (RTF). For more infor-

mation on using fonts in the Dictation Box, refer to Using Fonts in Dictation Box in the

Dragon Help.

Note: You cannot transfer the audio that corresponds to the text from the Dictation Box to

another application. The audio is available only while the Dictation Box is open and only

before you dictate the "Transfer" voice command.

The Full Text Control Indicator
The Dragon bar includes a Full Text Control indicator that turns green when you are in an

application or window where all of Dragon’s functionality is supported.

When you are in an unknown text field, the Full Text Control indicator goes out, indicating

that you may have some difficulty selecting and editing dictated text. Also, when you start

dictating into an unknown text field, the Dragon Bar will display a message saying

"Unknown text field; consider using 'show Dictation Box' - See Help.'"

The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after

<xyz>…) work thanks to a functionality called Full Text Control. This functionality

depends on Dragon’s ability to constantly obtain information from the text field about its

content—for instance, in order to know where words and sentences begin and end, so

Dragon can apply spacing between words and capitalization at the beginning of sentences.

Most standard text fields allow full Full Text Control capabilities.

If you have difficulty in dictating or correcting in one of these unknown text fields, use the

Dictation Box.

For more information, see The Full Text Control Indicator.
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Dictating in unknown text fields
1. Place you cursor where you want to put the text

2. Start the Dictation Box in one of several ways:
n Say "Show Dictation Box"

n Select Tools > Dictation Box from the Dragon Bar

n Use CTRL + SHIFT + D. To change the default hot key(see the Dragon

Options dialog box.

3. When the Dictation Box displays, you can dictate and edit text inside the Dictation Box

using all of Dragon's commands.

4. Once you have finished dictating and editing the text, say or click "Transfer." The text

you dictated in the Dictation Box is transferred to the application. The Dictation Box then

closes.

Editing text in unknown text fields
To edit text already in the unknown text field:

1. Select the text in the unknown text field using voice commands or your keyboard and

mouse.

2. Copy the text to the Dictation Box for editing in one of these ways:
n Say "Edit Selection"

n Say "Show Dictation Box"

Note: To copy all the text in an application into the Dictation Box for

editing say "Edit All"

n Select Tools > Dictation Box from the Dragon Bar

n Use CTRL + SHIFT + D. To change the default hot key, see The

Options dialog box.

3. The selected text displays in the Dictation Box.

4. Once you have finished dictating and editing the text, say or click "Transfer." The text

you dictated in the Dictation Box is transferred to the application.

Defining how the Dictation Box works in
different applications
You can define how the Dictation Box copies and pastes text for each application where it's

needed. For example, you can have different copy and paste settings for Microsoft Pow-

erPoint and Corel WordPerfect.

To define how the Dictation Box works in a specific application:

1. Start the application or specific window and place your cursor in the application.

2. Start the Dictation Box

3. Click the "Settings..." button in the Dictation Box.

The Dictation Box Settings dialog box displays a section named "Settings for application
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<application name>" where the <application name> is the name of the current appli-

cation.

For more information, see Dictation Box Settings.

Unexpected behavior or text in the Dictation Box
Sometimes the Dictation Box misunderstands the context of what you're working on and it

displays text you didn't dictate, and that you can't edit. This can happen when the focus of

the application you're using is on a field you can't edit and:

n you intentionally open the Dictation Box, or

n you speak into your microphone, prompting the Dictation box to open automatically

For example, if you have your e-mail application open with an item in your message list

selected, the Dictation Box may display the header text of that message.

If this happens, just go to the Dictation Box and say or click "Cancel" to close it.

Dictation Box Settings
You open the Dictation Box by selecting Tools > Dictation Box on the DragonBar.

In the Settings dialog box of the Dictation Box, you can define how the Dictation Box

copies text from and pastes text into each application where you plan to use the Dictation

Box.

For example, you can have different copy and paste settings for Microsoft PowerPoint and

Corel WordPerfect.

To open the Settings dialog box, you click the Settings button inside the Dictation Box.

Note: You can have multiple Dictation Boxes open at one time and can have different set-

tings for using the Dictation Box with each application you use.

Font

The Font setting lets you change the font used for the contents of the Dictation Box. To

change the font:

1. Click "Change Font..."

2. Set the font, style, and size under Font, Font style, and Size.

3. Under Effects, you can choose a color from the drop-down list and/or choose Strikeout

or Underline.

4. Click OK to save the font change.

Notes:

n To set the font to the default, click "Default Font" and the font type and size change

to Arial 10-point.

n When you copy text into the text box, it displays in the same font as the originating

application.
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Window Position  

You can define where the Dictation Box appears:

n Anchor: Choosing anchor causes the Dictation Box to appear at the location where it

was last closed. If you drag the Dictation Box to a new location and then close it, it

will display at that location when you restart the Dictation Box.

n Automatically position the Dictation Box near the cursor: This option causes the

Dictation Box to appear as close to the cursor location as is practical.

Settings for application <application name>

You can define how the Dictation Box copies and pastes text in each application where it's

used. For example, you can have different copy and paste settings for Microsoft PowerPoint

and Corel WordPerfect.

The Dictation Box works for all applications that can accept standard keyboard shortcuts for

Windows Clipboard operations. In some applications that do not accept these commands,

your text may be lost or changed when you transfer text in and out of the Dictation Box.

The Copy options define what kind of copied text the Dictation Box can receive from an

application. 

The Paste options define how the Dictation Box pastes text in each application where you

use it.

Test your application before you start and, if you lose text when you try to transfer text to

the application, try different selections under the Copy and Paste options, detailed below:

Copy

n Do not copy: Does not copy any text from the application when the Dictation Box is

started.

n Type keys <Ctrl+C>: Uses Ctrl+C to copy text from the application.

n Use Windows Copy Command: Uses the Windows copy command to copy text

from the application.

Paste

n Type keys <Ctrl+V>: Uses Ctrl+V to copy text from the Dictation Box to the appli-

cation.

n Use Windows Paste Command: Uses the Windows Paste Command to copy text

from the Dictation Box to the application.

n Simulate keystrokes: Sends keystrokes from the Dictation Box to the application.

Use "Simulate keystrokes" if the other methods of pasting text do not work.

Show character count

Select this check box to have the character count display the number of characters in the Dic-

tation Box.
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Keep transferred text in clipboard when the Dictation Box is
closed

Check this option to have Dragon hold the text dictated into the Dictation Box in the Win-

dows clipboard either after you transfer the text unsuccessfully (paste fails) or after you

have closed the Dictation Box (should any text remain in the Dictation Box).

As long as you have chosen Type Keys <Ctrl+V> or Use Windows Paste Command under Paste

options, checking this check box protects you from losing any text when:

n You've transferred with the "Transfer" voice command and it fails to paste into the

application where you have placed the cursor

n Text still remains in the Dictation Box when you close it

If you do not select this option, the text dictated into the Dictation Box that has not been

transferred will be lost when you close the Dictation Box.

When you have selected this check box, if the transfer fails, you do not lose the text,

because the text is stored temporarily in the Windows clipboard. If the application you tried

to transfer the text to fails to receive the text, you can open another application and try

using the Windows paste command to paste the text from the clipboard.

Restore Defaults

This option restores all Dictation Box settings to their defaults.

For more information

For more information, see:

n Using the Dictation Box

n The Full Text Control Indicator
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Using DragonPad
This section contains the following topics:

About DragonPad 89

Changing the way text wraps on your screen 89

About DragonPad
DragonPad is Dragon's built-in word processor, which is optimized for dictation. DragonPad

includes basic text formatting features as well as the ability to save and print documents.

You can use DragonPad when you do not need the capability of a full-featured word proc-

essor. When you have finished dictating, you can say "Copy All To Clipboard" to copy your

text to the Clipboard and "Paste That" to copy the text from the Clipboard into any other pro-

gram.

Although it is similar to WordPad, DragonPad is customized for use with Dragon and con-

tains speech recognition features that are not available in WordPad.

Changing the way text wraps on your screen
As you are dictating in DragonPad, you may want to change the way text wraps in the Drag-

onPad window.

To change the way text wraps on your screen

1. On the View menu, click Settings.

2. In the Word Wrap group of the Text or the Rich Text tab, select the wrapping option you

want. You can select No wrap, Wrap to window, or Wrap to ruler.

3. Click OK.

Notes

n The wrapping options affect only how text appears on your screen. When printed, the

document uses the margin settings specified in Page Setup.

n You can set different word wrap options for the text format in which you save the doc-

ument: text-only (TXT) or rich text format (RTF).
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Chapter 5: Making
Corrections

This section contains the following topics:

Correcting dictation - workflow 90

Using Smart Format Rules 93

Correcting text - quick reference 93

Choosing the correct text 95

Correcting misrecognized commands 96

Correcting dictation - workflow
There are a number of ways you can correct the misrecognitions in a document. The fol-

lowing techniques describe the most basic methods. You can combine these techniques in

any manner that suits your working style.

Correcting using the Correction menu (easiest)
To correct text using the Correction menu

1. Do any of the following:
n Say "Correct that" after the last thing you dictated.

n Say "Correct <xyz>" or "Select <xyz>" to have Dragon select any edi-

table text in the current document or e-mail message.

n Say "Correct <abc> through <xyz> to have Dragon select any edi-

table range of text in the current document or e-mail message.

n Press the correction hot key, normally the minus (-) key on the

numeric keypad.
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The Correction menu opens*.

2. Choose one of the items from the Correction menu or dictate the replacement content.

If you choose one of the suggestions on the Correction menu, Dragon automatically

returns the cursor to where you were dictating before you made the correction.

If you dictate something new to make a correction when the Correction menu is open,

Dragon does not return the cursor to its last location. You can use the "Go Back" com-

mand or the mouse or keyboard to move it back to where it was.

* Dragon also includes an option setting to substitute the Spelling window for the Cor-

rection menu when you use a correction command.

Correcting text with the keyboard (fastest)
To correct text with the keyboard

1. Move the insertion point to the beginning of the dictation you want to correct.

2. Press the Correction hot key to display the Correction menu. By default, this is the

minus (-) key on the numeric keypad. You can change the hot key assignment on the
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Hot keys tab of the Options dialog box. You can also click the Correction button on

the Extras toolbar of the DragonBar.

3. The Correction menu displays a list of optional spellings.
n If the selected alternative is correct, press the Right Arrow key.

n If one of the other alternatives is correct, press the Down Arrow key

until that alternative is highlighted and press the Right Arrow key.

n If no alternative is correct, just type the correct text or say "Spell

That" to open the Spelling window.

4. Continue until all the text is correct.

Correcting text while playing back dictation (most accurate)

Please note that when you dictate into a Web application, playback availability is limited.

For more information on this, see If you have problems using Web application support.

To correct text while playing back dictation

1. Move the insertion point to the beginning of the dictation you want to correct.

2. Click Play That Back on the Audio menu of the DragonBar or click the Begin Play-

back button on the Extras toolbar.

3. When the playback of your dictation reaches a recognition error, press the correction

hot key. By default, this is the minus (-) key on the numeric keypad. You can change

the hot key assignment on the Hot keys tab of the Options dialog box. You can also

click the Correction button on the Extras toolbar of the DragonBar.

4. The Correction menu displays a list of alternatives for the misrecognition.

n If one of the alternatives is correct, press the Down Arrow key to highlight that

choice and then press Enter to accept it. Playback will continue automatically

from the point where you stopped.

n If no alternative is correct, just type or say the correct text and click the Begin

Playback button. Playback will continue from the point where you stopped.

Correcting text using voice commands (hands-free)
To correct text using voice commands

1. Say "Go To Beginning of Document."

2. Look for the first misrecognition and say "Select" and the text that is incorrect. The

Correction menu appears with a number of alternatives.

n If one alternative is correct, say "Choose" and the number of that alternative. For

example, "Choose Two." Do not say "Choose Numeral Two" or Dragon will tran-

scribe the phrase as the text "Choose Numeral Two" or "Choose 2" depending on

how you set the automatic text formatting properties on the Auto-formatting

dialog box.
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n If none of the alternatives is correct, say "Spell That," spell the correct word or

words into the Spelling window, and then say "OK."

3. Verify that the correct text appears in the document in place of the misrecognized text

and continue to the next misrecognition.

Using Smart Format Rules
You can also use the Smart Format Rules feature to have Dragon recognize when you correct

dictated text that corresponds to an Auto-formatting option or supported by this feature.

Dragon then displays a Smart Format Rules dialog box, offering one or more setting adjust-

ments relevant to the change you just made. If you don’t wish to change any setting, you can

just ignore the Smart Format Rules box and continue dictating, or say "Cancel" and the box

will close.

The Smart Format Rules box may appear when you make a correction using

n the Correction menu

n the Spelling window

or

n the keyboard.

For details, see Using Smart Format Rules, the Auto-formatting dialog box and Creating

Word Properties.

Notes

n If you select a phrase to correct that includes punctuation added to the sentence auto-

matically, the list of corrections that appears in the Correction menu will include a ver-

sion without the automatically inserted punctuation.

n When you use the Correction menu with a selection of more than 70 characters,

Dragon selects only the first sentence for correction.

n The Accuracy Center provides a central location for taking advantage of all the Dragon

tools available to ensure excellent recognition. For more information, see Using the

Accuracy Center.

n When you use the "select" or "correct" command to select any part of a hyphenated

word or a hyphen, Dragon selects the entire hyphenation. For example, in the hyphen-

ated word "brother-in-law" if you say "correct brother" because you only need to

change that, Dragon selects "brother-in-law."

Correcting text - quick reference
When you correct recognition errors, Dragon adapts your User Profile, so errors are less

likely to happen again.

See also

n Using Direct Editing

You can correct recognition errors in the following ways:
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To Say

Correct the
last thing you
said

Say "Correct That"

Correct the
selected text

"Correct That"

Correct a
range of text

"Correct dark through night" where dark is the first word to correct and
night is the last word to correct. You don't have to include the entire
phrase when you use this command.
"Correct from <text> to <text>" (Outside US and Canada)
"Correct <text> through <text>" (In the US and Canada)

Use the
Extras toolbar

Select the Extras toolbar button on the DragonBar.

Select the Correction button to stop playback and correct a
mistake.

Correct one
or all
instances of
words

"Correct <text>"

Delete text
you just dic-
tated

"Scratch That"

Save and
play back
recorded
speech

"Play That Back"

Note: Web applications have only limited playback.

The Correction menu closes automatically after you make a choice. If you want to close the

Correction menu without making a selection, say "Cancel" or continue dictating.

You can enable and disable these Direct Editing commands from the Commands tab of the

Options dialog box.

Workflow

You can experiment with Dragon's various correction options, including both vocal and

manual actions (Correction button, Correction hot key, double-click to Correct, Smart For-

mat Rules), to see what you prefer for a given situation. For a description of three different

methods for correcting text and how each fits into a particular workflow, click Correction

workflow.

Techniques

The following topics explain different aspects of correcting text:

Correcting text errors as you dictate
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Choosing the correct text

Undoing actions

Correcting misrecognized commands

Using the Recognition History window

Notes

n Remember that letting Dragon adapt its Vocabulary to your own words and phrases

will prevent many recognition errors. If a word is not in Dragon's active Vocabulary,

Dragon can't recognize it accurately. The Accuracy Center provides a central location

for taking advantage of all the Dragon tools available to ensure excellent recognition.

For more information, see Using the Accuracy Center.

n If you get a message in the DragonBar that there is nothing to correct, select the text

you want to correct and say "Correct That" again (or press the Correction hot key or

click the Correction button).

n If you select a phrase to correct that includes a comma or period added to the sen-

tence automatically, the list of corrections that appears in the Correction menu will

include a version without the automatically inserted punctuation.

n To dictate the word "correct" at the beginning of an utterance (that is, as the first

word after a pause), either say "correct" and then pause, or hold down the Shift key

while you speak to force Dragon to recognize the word as dictation and not as a com-

mand. You can change the key that you press to control this behavior on the Hot keys

tab of the Options dialog box.

Choosing the correct text
In the Correction menu and the Spelling window, Dragon offers a selection of recognition

alternatives. Use the following procedure to choose the alternative you want.

To choose the correct text

If the correct text is one of the alternatives listed, say "Choose" and then say the number of

the alternative in the list. As an option, you can press the ALT key and type the number of

the alternative from the keyboard (not the numeric keypad).

The text you choose replaces the text in your document.

Example:

If the correct text is the third alternative, say "Choose 3."

Notes

n Dragon's Smart Format Rules dialog box may appear when you correct auto-formatted

alphanumeric text using the Correction command, the Spelling window, or the key-

board. For details, see Using Smart Format Rules and Automatically Format Text.

n When selecting an alternative on the correction menu, say "Choose" and the number

of that alternative. For example, "Choose Two." Do not say "Choose Numeral Two"
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or Dragon will transcribe the phrase as the text "Choose Numeral Two" or "Choose

2" depending on how you set the number formatting options on the Auto-formatting

dialog box.

n In the Spelling window, if one of the recognition alternatives is nearly correct, you

can say "Select" and the number of the alternative. The alternative text is moved into

the text box, so you can edit it. As an option, you can press the SHIFT and ALT

keys and type the number of the alternative from the keyboard (not the numeric key-

pad).

n If you select a phrase to correct that includes punctuation added to the sentence auto-

matically, the list of corrections that appears in the Correction menu will include a

version without the automatically inserted punctuation.

n The Accuracy Center provides a central location for taking advantage of all the

Dragon tools available to ensure excellent recognition. For more information, see

Using the Accuracy Center.

n You can choose to always play back recorded speech in the Correction menu. You

can set the respective option on the Correction tab of the Options dialog box.

Correcting misrecognized commands
If you speak a valid command and it is not recognized correctly, use the following pro-

cedure to ensure that Dragon recognizes the command in the future. When valid command

words and phrases appear in the Results box the box contains a blue border. Open the Com-

mand Browser from the DragonBar Tools menu for lists of valid commands.

To correct a misrecognized command

1. If the window or dialog box containing the misrecognized command is not active (that

is, the title bar is not highlighted), click in it to make it active.

2. Say "Scratch That" (to delete the unwanted dictation), "Undo That", or "Undo Last

Action" to undo an unwanted action.

3. Say the command again.

If the command was recognized as dictation, hold down the CTRL key as you start to say

the command again. Holding down the CTRL key forces Dragon to recognize what you say

as a command. You can also switch to Command Mode.

Notes

n You can train commands to match your pronunciation, if necessary.

n When Dragon recognizes a command, the borders of the results box turn blue. The

only exception to this is when you use commands that you usually say without paus-

ing during dictation, such as "new line", "new paragraph", "no caps", or "all caps".

n The Accuracy Center provides a central location for taking advantage of all the

Dragon tools available to ensure excellent recognition. For more information, see

Using the Accuracy Center.
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Chapter 6: Revising Text

This section contains the following topics:

Using Direct Editing commands 98

Handling multiple text matches 99

Revising text - quick reference 103

Moving around in a document 106
Moving the insertion point 106

Moving to specific words 108

Moving to the beginning or end of a document or line 108

Using "GoBack" tomove the cursor 109

Selecting text 110
Selecting text - quick reference 110

Selecting characters and words 110

Selecting specific words or phrases 111

Selecting lines and paragraphs 112

Selecting text again 113

Changing an incorrect text selection 113

Deleting, Cutting, and Copying Text 115
Cutting, copying, and pasting 115

Deleting dictated text 115

Deleting characters, words, lines, or paragraphs 116

Deleting by backspacing 116

Formatting 118
Formatting text 118

Formatting numbers 120

Setting font name, size, and style 120

Aligning text 121

Adding new lines and paragraphs 121

Hyphenating words 121

Joining words 122

Setting Auto-Formatting Options 122

Using Smart Format Rules 122

Creating Word Properties 123
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Using Direct Editing commands
Use Dragon Direct Editing (formerly called Quick Voice Formatting) commands to do rou-

tine tasks faster by voice.

In previous versions of Dragon, deleting, cutting, copying, italicizing, underlining, and

applying bold to text were two-step operations: you had to select the text before you could

change it. Now you can perform these actions in one step.

See also

n Handling multiple text matches

Note

For commands that name a range of text, such as "bold <text> through <text>," Dragon

expects to hear "to" or "through" depending on the region you selected when you created

your User Profile. Use "through" in the United States and Canada, and use "to" in all other

regions.

Formatting text

Use the commands in the following table to quickly format text using Direct Editing. For-

matting commands are available only in programs that support formatting.

To... Say...

Bold the specified text or a range of text. Bold <text>
Bold from <text> to <text> 
Bold <text> through <text>

Italicize the specified text or a range of
text.

Italicize <text>
Italicize from <text> to <text> 
Italicize <text> through <text>

Underline the specified text or a range of
text.

Underline <text>
Underline from <text> to <text> 
Underline <text> through <text>

Capitalize the specified text of a range of
text

Capitalize <text>
Capitalize from <text> to <text>
Capitalize <text> through <text>
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Editing text

Use the commands in the following table to quickly revise text using Direct Editing.

To... Say...

Cut the specified text or a range of text. Cut <text>
Cut from <text> to <text>
Cut <text> through <text>

Note: The Cut voice command is turned off by default to keep the word "cut" avail-
able for regular dictation. To enable using "Cut" as a command, change the Enable
Cut shortcut command setting in the Options dialog box Commands tab and then Exit
and Restart Dragon.

Copy the specified text or a range of
text.

Copy <text>
Copy from <text> to <text>
Copy <text> through <text>

Delete the specified text or a range of
text.

Delete <text>
Delete from <text> to <text>
Delete <text> through <text>

Handling multiple text matches
Use the commands in this topic when Dragon finds multiple instances of a word or phrase in

the part of your document currently showing on screen. Dragon displays a number next to

each instance, so that you can choose the one you had in mind for the command. This fea-

ture also lets you save time by applying the command to all instances at once if doing so

makes sense for that particular command.

Note

n If you prefer that Dragon change only the instance of a word or phrase nearest to the

cursor, you can turn this option off in Dragon's Options dialog box, Commands tab

(see Enable multiple text matches). Then, if Dragon selects the correct word or phrase

but not the right instance, you can say "Select Again" to select the previous instance.

By default, the feature is turned on.

Here's an example of what Dragon does with the "Bold <xyz>" command. When you say

"bold fox," Dragon displays a number next to each matching item, as shown here. Then you

can say "Choose <n>," where <n> represents one of the numbered text matches, or

"Choose All" to apply the command to all text matches. Dragon only numbers text matches

that are visible in your current document window.
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You can cancel text matching by saying "Cancel," continuing to dictate, typing, or clicking

the mouse. You can also use "Undo All" after you use "Choose All."

See also

n Using Direct Editing commands

Use the following table as a quick reference for text matching commands.

Com-
mand To... Say...

Bold <xyz> Apply bold
to one or
more text
matches

"Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to apply the formatting to only the third instance of a
number of text matches.

OR
"Choose all" to apply bold to all instances Dragon shows as
text matches.

Underline
<xyz>

Apply under-
lining to one
or more text
matches

"Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to apply the formatting to only the third instance of a
number of text matches.

OR
"Choose all" to underline all instances Dragon shows as text
matches.

Italicize
<xyz>

Apply ital-
ics to one or
more text
matches

"Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to apply the formatting to only the third instance of a
number of text matches.

OR
"Choose all" to italicize all instances Dragon shows as text
matches.

Capitalize
<xyz>

Capitalize
the first
letter of one
or more text
matches

"Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to apply the formatting to only the third instance of a
number of text matches.

OR
"Choose all" to capitalize all instances Dragon shows as text
matches.
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Com-
mand To... Say...

Delete
<xyz>

Delete one
or more text
matches

"Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to delete only the third instance of a number of text
matches.

OR
"Choose all" to delete all instances Dragon shows as text
matches.

Undo All Undo
changes to
all revised
text
matches

1. Perform one of the commands in this table to revise

two or more multiple text matches.

2. Say "Undo All."

Note Undo All can undo a maximum of 50 instances of the
Bold, Italicize, Underline, and Delete commands, and up to a
maximum of 25 instances of the Correct command.

Cut <xyz> Cut one of
the text
matches

Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to cut only the third instance of a number of text
matches.

Note: The Cut voice command is turned off by default to keep the word "cut" available for
regular dictation. To enable using "Cut" as a command, change the Enable Cut shortcut com-
mand setting in the Options dialog box Commands tab and then Exit and Restart Dragon.

Copy
<xyz>

Copy one of
the text
matches

Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to copy only the third instance of a number of text
matches.

Select
<xyz>
OR
"Select
<abc>
through
<xyz>"

Select one
of the
matches of
selected
text

Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to select only the third instance of a number of text
matches. You must then choose one of the numbered text
matches.
Notes:

n Depending on how Dragon's Correction Options

are set, Dragon displays either the Correction

menu or the Spelling window when you use the

Select command. Changes to multiple text

matches do not work from the Spelling window.

n Replacing all instances of text matches does not

work with the Select command.
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Com-
mand To... Say...

Correct
<xyz>
OR
"Correct
<abc>"
through
<xyz>

Use the Cor-
rection
menu to
change one
or more text
matches

Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to correct only the third instance of a number of text
matches.
OR
"Choose all" to correct all text matches Dragon displays.
Notes:

n Depending on how Dragon's Correction Options

are set, Dragon displays either the Correction

menu (see example below) or the Spelling win-

dow when you use the Correct command. If you

use "Choose all" when multiple correction

options are displayed, you can replace all of the

selections with a numbered option from the

menu or use "all caps that." Other menu com-

mands apply to the last match selected.

n Changes to multiple text matches do not work

from the Spelling window.

Insert
before

Move the
cursor to
just before
a particular
word or
phrase in
your doc-
ument

Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to move cursor into position just before the third
instance of a number of text matches.

Insert after Move the
cursor to
just after a
particular
word or
phrase in
your doc-
ument

Choose <number>" or "<n>." For example, say "Choose 3"
or "3" to move cursor into position just after the third
instance of a number of text matches.

Notes

n In the numbering of matches, Dragon will include homophone and hyphenated var-

iants of the word or phrase. In the following example, Dragon identifies matches in

the words "Course," "course's," "full-course," "half-course," and "coarse."
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n For commands that apply to a range of text, such as "bold <abc> through <xyz>,"

Dragon expects to hear "to" or "through" depending on the region you selected when

you created your User Profile. Use "through" in the United States and Canada, and use

"to" in all other regions.

n Formatting commands are not available in Notepad and may not work correctly in

Internet Explorer.

n To use formatting commands in Microsoft Outlook, make sure either HTML or RTF

mail message format is turned on .

Revising text - quick reference
You can revise text by voice in any of the following ways.

See also

n Handling multiple text matches

To Say

Delete text "Scratch That" to delete the last thing you said.
"Delete <text>" where <text> is the word or phrase
you want to delete *
"Delete from <text> to <text>" *
"Delete <text> through <text>" *
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To Say

Cut text "Cut That" to cut previously selected text or the last
thing you said.
"Cut <text>" where <text> is the word or phrase you
want to cut *
"Cut from <text> to <text>"
"Cut <text> through <text>"
Note: The Cut Direct Editing command is turned off
by default to keep it available for regular dictation. 
To enable the Cut command,

1. Choose Tools > Options from the Drag-

onBar.

2. Click Commands > Enable Cut Command.

3. Restart Dragon.

Copy text "Copy That" to copy previously selected text or the
last thing you said.

"Copy <text>" where <text> is the word or

phrase you want to copy *

"Copy from <text> to <text>" *
"Copy <text> through <text>" *

Select text "Select that" to select the last thing you said.
"Select <text>" where <text> is the word or phrase
you want to change
"Select <text> Through <text>."
Note: Outside the USA or Canada, say "Select
<text> To <text>."
"Select from <text> to <text>"

Correct text "Correct That"
"Correct <text>" where <text> is the word or phrase
you want to change
"Correct <text> To <text>"
"Correct from <text> to <text>"
"Correct<text> Through <text>."
Note: Outside the USA or Canada, say "Select
<text> To <text>."

Correct text once you have
selected it

"Correct That"
OR
The words you want to replace the selection.

104



Dragon 12 Installation and User Guide

To Say

Back up and resume dictating "Resume With <word>" where <word> is the word
you want Dragon to resume with. Then, dictate the
revised text.

Move the cursor back to its last
position in documents and e-mail
messages

Pause briefly during dictation and say "Go Back" See
Using "Go Back" to move the cursor.

* indicates a Direct Editing command. You can enable and disable these Direct Editing com-

mands from the Commands tab of the Options dialog box.

The commands that quote text from the screen (select <xyz>, correct <xyz>, insert after

<xyz>…) work thanks to a functionality called Full Text Control. This functionality

depends on Dragon’s ability to constantly obtain information from the text field about its con-

tent—for instance, in order to know where words and sentences begin and end, so Dragon

can apply spacing between words and capitalization at the beginning of sentences. Most stand-

ard text fields allow full Full Text Control capabilities. For more information, see The Full

Text Control Indicator.

Knowing additional ways to perform the following tasks by voice is useful in revising text.

Click the following links for more detailed explanations.

Moving around in a document

Selecting text

Deleting dictated text

Formatting text

Automatically Format Text (see Dragon Help)

Notes

n Dragon can auto-format text and numbers using standard writing conventions or apply

Word Properties to words as you dictate. For information about these settings, see

Auto-formatting dialog box and The Word Properties dialog box.

n Dragon's Smart Format Rules appear when you correct auto-formatted alphanumeric

text or Word Properties using the Correction menu, the Spelling window, or the key-

board. For details, see Using Smart Format Rules and Setting Auto-Formatting

Options.

n When you use the "select" or "correct" command to select any part of a hyphenated

word or a hyphen, Dragon selects the entire hyphenation. For example, in the hyphen-

ated word "brother-in-law" if you say "correct brother" because you only need to

change that, Dragon selects "brother-in-law."
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Moving around in a document
The following topics describe how to move the text insertion point around in a document.

Moving the insertion point

Moving to specific words

Moving to the beginning or end of a line or document

Moving the insertion point
Use the procedures in this topic to move the text insertion point as follows:

n by characters

n by words

n by lines

n by paragraphs

Note

Anytime you move the insertion point by voice, keyboard or mouse, you can move it back

to where it was by saying "Go Back."

For more information, see Using "Go Back" to move the cursor.

To move the insertion point by characters

Say the following to move the insertion point left or right by a number of characters.

Say Then say Then say

"Move" "Right" "<1-20>"

"Left" "a character"

"Forward" "<1-20> characters"

"Back"

Examples
"Move Right 3"
"Move Back 15 characters"
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To move the insertion point by words

Say the following to move the insertion point by a number of words.

Say Then say Then say

"Move" "Right" "a Word"

"Forward" "<1-20>Words"

"Left"

"Back"

Examples
"Move Left 3 Words"
"Move Forward a Word"

To move the insertion point by lines

Say the following to move the insertion point up or down by lines. These commands press

the up and down arrow keys.

Say Then say Then say

"Move" "Up" "<1-20> Lines"

"Down"

Examples
"Move Up 3 Lines"
"Move Down 5"

To move the insertion points by paragraphs

You can use these commands to move around by paragraphs.

Say Then say Then say

"Move" "Up" "a Paragraph"

"Back" "<1-20> Paragraphs"

"Down"

"Forward"

Examples
"Move Up a Paragraph"
"Move Forward 8 Paragraphs"

Notes

n These commands deselect any text that is selected.

n Commands that delete by words or paragraphs may not always have the expected

effects in programs that do not use the same shortcut keys as WordPad (on which the

word processing features of Dragon are based). For example, in Windows Notepad,
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the paragraph commands don't work because Notepad does not recognize a paragraph

and in Microsoft Excel, these commands only work in the toolbar edit field.

Moving to specific words
You can move the insertion point before or after a particular word or phrase.

To move the insertion point to a specific word

Say "Insert Before <text>" or "Insert After <text>," where <text> is a word or phrase in

the document.

To Say, for example

Move the insertion point before the word "John" "Insert Before John"

Move the insertion point after the phrase "Dear Sir" "Insert After Dear Sir"

Notes

n These commands deselect any text that is selected.

n Do not pause anywhere in the middle of saying these commands, including the text.

For example, "Insert Before Dear Sir" is all one command.

Moving to the beginning or end of a document
or line
You can use these commands to move the text insertion point to the top or bottom of a

document and the beginning or end of a line.

Say Then say

"Go to" "Top"

"Move to" "Top of Document"

"Beginning of Document"

"Start of Document"

"Bottom"

"Bottom of Document"

"End of Document"

"Beginning of Line"

"Start of Line"

"End of Line"

Examples
"Go to Top"
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"Move to End of Line"

Note

These commands deselect any text that is selected.

Using "Go Back" to move the cursor
Use the "Go Back" command to return the cursor (insertion point) to its original position

after you move the cursor by voice, keyboard or mouse.

To move the cursor back to its original position

n Pause briefly during dictation and say "Go Back."

You can repeat the command to move the cursor back to where your original action put it.

Examples

Use the Go Back command after commands that move the cursor from place to place, such

as:

n "Select <text>." See Selecting text: quick reference

n "Move <direction>." See Moving the insertion point

n Moving the cursor with the mouse or keyboard. If you move the cursor around in a

document or message with the mouse or keyboard, when you say "Go Back," Dragon

returns the cursor returns to where it was last.

n "Insert before <text>." or "Insert after <text>" See Moving to specific words

n "Go to" or "Move to." See Moving to the beginning or end of a document or line

n "Correct <text>." Use "Go Back" if you dictate something new to make a correction

when the Correction menu is open. See Correcting with the Correction menu

Note

To use "Go Back," the distance from the last cursor location must be greater than 10 char-

acters.
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Selecting text
This section contains the following topics:

Selecting text - quick reference 110

Selecting characters and words 110

Selecting specific words or phrases 111

Selecting lines and paragraphs 112

Selecting text again 113

Changing an incorrect text selection 113

Selecting text - quick reference
When you are dictating, you can select text in these different ways:

Selecting text

Selecting characters and words

Selecting specific words or phrases

Selecting parts of a document

Selecting text again

Changing an incorrect text selection

You can cancel a selection by saying "Unselect That," selecting different text, or moving the

insertion point to another part of the document.

Caution

When text is selected, be careful not to breathe loudly, clear your throat, or make other

sounds. Dragon may interpret such noises as speech and replace the selection with new

text. If this happens, say "Undo That" right away to reverse the action.

Selecting characters and words
You can use the following commands to select individual characters and words.

To select characters and words

Say Then say Then say

"Select" "Next" "Character"

"Forward" "<1-20> Characters"

"Previous" "Word"

"Back" "<1-20>Words"

"Last"
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Notes

n When you use the "select" or "correct" command to select any part of a hyphenated

word or a hyphen, Dragon selects the entire hyphenation. For example, in the hyphen-

ated word "brother-in-law" if you say "correct brother" because you only need to

change that, Dragon selects "brother-in-law."

n You can select punctuation marks by voice. For example, you can say "Select comma."

n By default, when you select a word or phrase, Dragon displays the Correction menu,

which you can use to correct recognition errors. You can turn this feature off by clear-

ing (deselecting) the "Select command bring up Correction menu" options on the Cor-

rection tab of the Options dialog box.

n Commands that delete by words or paragraphs may not always have the expected

effects in programs that do not use the same shortcut keys as WordPad (on which the

word processing features of Dragon are based). For example, in Windows Notepad,

the paragraph commands don't work because Notepad does not recognize a paragraph

and in Microsoft Excel, these commands only work in the FormulaBar edit field.

Selecting specific words or phrases
Use the following procedures to select a specific word or phrase:

To select specific words

Say "Select <text>," where <text> is the word or phrase you want to select. The text must

be visible on the screen for you to select it.

Examples

To select the words "White House" or "began to feel," say:

"Select White House"

"Select began to feel"

To select a phrase or range of words

Say "Select <text> Through <text>," where <text> is a word or phrase at the beginning

and at the end of the range you want to select. The text must be in view on the screen.

Note: Outside the USA or Canada, say "Select <text> To <text>."

Example

To select the words "enclosed the materials you requested," in the sentence: "I have also

enclosed the materials you requested," say:

"Select enclosed Through requested"

Notes

n You can cancel a selection by saying "Unselect That," selecting different text, or mov-

ing the insertion point to another part of the document.
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n In most instances, the "Select" command will display a number next to each instance

of the word, allowing to select all instances or just a specific instance. See Handling

multiple text matches for more information. If you find that a particular application

does not display these numbers, you can still use the "Select Again" command.

n If you need to use the "Select Again" command, the selection commands search for

the instance of the word nearest the insertion point. You can set the direction to

always search backward on the Correction tab of the Options dialog box..

n When you select a word or phrase, Dragon displays the Correction menu, which you

can use to correct recognition errors. You can change this behavior on the Correction

tab of the Options dialog box.

n When you use the "select" or "correct" command to select any part of a hyphenated

word or a hyphen, Dragon selects the entire hyphenation. For example, in the

hyphenated word "brother-in-law" if you say "correct brother" because you only need

to change that, Dragon selects "brother-in-law."

Selecting lines and paragraphs
You can select parts of a document by lines or paragraphs, or you can select the whole doc-

ument in the following ways:

To select one or more lines or paragraphs

Say Then say Then say

"Select" "Next" "Line"

"Forward" "<1-20> Lines"

"Previous" "Paragraph"

"Back" "<1-20> Paragraphs"

You can also say

"Select Document"

"Select All"

Caution

When text is selected, be careful not to breathe loudly, clear your throat, or make other

sounds. Dragon may interpret such noises as speech and replace the selection with new

text. If this happens, say "Undo That" right away to reverse the action.

Notes

n You can cancel a selection by saying "Unselect That," selecting different text, or mov-

ing the insertion point to another part of the document.

n Commands that delete by words or paragraphs may not always have the expected

effects in programs that do not use the same shortcut keys as WordPad (on which

the word processing features of Dragon are based). For example, in Windows Note-

pad, the paragraph commands don't work because Notepad does not recognize a

112



Dragon 12 Installation and User Guide

paragraph and in Microsoft Excel, these commands only work in the FormulaBar edit

field.

Selecting text again
Once you have selected a word or phrase, you can quickly select another occurrence of the

same text.

To select text again

Say "Select Again."

Example

In the sentence, "The frost is on the pumpkin, and the fruit is on the vine," say "Select is on

the" to select the words "is on the" after the word "fruit."

Then, to select the instance of the words "is on the," after the word "frost" say "Select

Again."

Changing an incorrect text selection
When you select text by saying "Select" and the text you want selected, Dragon searches for

the nearest instance of the text from the current location of the insertion point. Sometimes

the program selects the wrong words. Other times, the program selects the right words, but

they are not in the correct location.

When this happens, try the following techniques:

To change an incorrect text selection

If the wrong text is selected, try saying "Select <text>" again. The second time, Dragon

searches for different text with a similar pronunciation.

If the wrong text is selected, try using a longer phrase. This provides more information so

Dragon is more likely to select the correct text.

If the correct words are selected but they are not in the correct location, say "Select

Again" to select the previous occurrence of the same text.

Notes

n You can select punctuation marks.

n You can say "Select period" and then "Select Again" to move the insertion point sen-

tence by sentence.

n The default is for Dragon for the nearest instance from the location of the insertion

point. You can change the search direction to always be backward on the Correction

tab of the Options dialog box.

113



Chapter 6: Revising Text

n To dictate the word "Select" at the beginning of an utterance (that is, as the first

word after a pause), either say "Select" and then pause, or hold down the Shift key

while you speak. You can also use Dictation Mode.
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Deleting, Cutting, and Copying Text
This section contains the following topics:

Cutting, copying, and pasting 115

Deleting dictated text 115

Deleting characters, words, lines, or paragraphs 116

Deleting by backspacing 116

Cutting, copying, and pasting
You can say these commands to cut, copy, and paste selected text to and from documents.

To cut selected text

Say "Cut That."

To copy selected text

Say "Copy That" or "Copy All To Clipboard."

To paste cut or copied text

Say "Paste That."

Deleting dictated text
Use the following procedure to remove text from a document.

To delete the last words you dictated

Say "Scratch That."

Or

Say "Resume With <word>," where word is a word within the last 100 characters of text

you dictated.

To delete any text

1. Select the text.

2. Say "Scratch That" or "Delete That."

To delete specific text or a range of text, see Revising words.

Notes

n You can repeat "Scratch That" up to ten times to delete the last things you said one at

a time, or you can just say "Scratch That <2-10> Times."

n If you just dictated the text and want to delete it, say "Scratch That."
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Deleting characters, words, lines, or paragraphs
You can delete any number of words or characters (up to 20) using the following com-

mands.

To delete characters, words, lines, or paragraphs

Say Then Say Then Say

"Delete" "Next" "Character"

"Previous" "1 Character"

"Last" "<2-20> Characters"

"Word"

"1 Word"

"<2-20>Words"

"Line"

"1 Line"

"<2-20> Lines"

"Paragraph"

"1 Paragraph"

"<2-20> Paragraphs"

Examples:

"Delete Next Character"

"Delete Previous 4 Lines"

Notes

n If you delete text and an extra space remains, say "Delete Next Character," "Delete

Previous Character," or "Backspace" to remove the space.

n Commands that delete by words or paragraphs may not always have the expected

effects in programs that do not use the same shortcut keys as WordPad (on which

the word processing features of Dragon are based). For example, in Windows Note-

pad, the paragraph commands don't work because Notepad does not recognize a par-

agraph, and in Microsoft Excel, these commands only work in the FormulaBar edit

field.

Deleting by backspacing
Use the following commands to remove characters to the left of the insertion point.
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To delete characters

Say "Backspace" or "Backspace" followed by the number of characters you want to delete

(from 2 to 20).

Examples:

"Backspace" (will delete one character)

"Backspace 5" (will delete 5 characters)
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Formatting
This section contains the following topics:

Formatting text 118

Formatting numbers 120

Setting font name, size, and style 120

Aligning text 121

Adding new lines and paragraphs 121

Hyphenating words 121

Joining words 122

Setting Auto-Formatting Options 122

Using Smart Format Rules 122

Creating Word Properties 123

Formatting text
You can use the following commands to format text you have just dictated or text you have

selected.

For information about applying formatting to multiple instances of words or phrases, see

Handling multiple text matches.

To Say

Apply bold "Bold That" or "Format that Bold" to bold previously
selected text or the last thing you said.
"Bold <text>" *
"Bold from <text> to <text>" *
"Bold <text> through <text>" *

Apply italics "Italicize That" or "Format That Italics" to italicize pre-
viously selected text or the last thing you said.
"Italicize <text>"  *
"Italicize from <text> to <text>"  *
"Italicize <text> through <text>" *

Apply bold italics "Format That Bold Italic" or "Format That Bold Italics"

Add underlining "Underline That" or "Format That Underline" to underline
previously selected text or the last thing you said.
"Underline <text>"  *
"Underline from <text> to <text>"  *
"Underline <text> through <text>" *

Add strikeout "Format That Strikeout"
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To Say

Remove all bold, italics, under-
line, and strikeout formatting

"Restore That" or "Format That Regular" or "Format That
Plain"

Change text to initial capitals "Format That Caps" or "Format That Initial Caps"

Change text to uppercase "Format That Uppercase" or "all caps that" or "capitalize
XYZ"

Change text to lowercase "Format That Lowercase" or "No-Caps That"

Create a bulleted list "Format That Bullet Style"

Left-align text "Format That Left Aligned" or "Left Align That"

Right-align text "Format That Right Aligned" or "Right Align That"

Center text "Format That Centered" or "Center That"

Put hyphens between words "Hyphenate That"

Combine multiple words into
one

"Compound That"

* indicates a Direct Editing command. You can enable and disable these Direct Editing com-

mands from the Commands tab of the Options dialog box.

To set a font name, size, or style

Notes

n The commands that quote text from the screen (select <xyz>, correct <xyz>, insert

after <xyz>…) work thanks to a functionality called Full Text Control. This func-

tionality depends on Dragon’s ability to constantly obtain information from the text

field about its content—for instance, in order to know where words and sentences

begin and end, so Dragon can apply spacing between words and capitalization at the

beginning of sentences. Most standard text fields allow full Full Text Control capabil-

ities. For more information, see The Full Text Control Indicator.

n You can combine different formatting and font style commands. For example, you can

say: "Format That Caps Bold" or "Format That Bullet Style Italic."

n In the DragonPad, when you use the "Format That" command to align an empty par-

agraph, the previous paragraph is aligned also. To prevent this, dictate some text in the

new paragraph before saying the alignment command.

n Dragon can automatically format text and numbers as you dictate using standard writ-

ing conventions. For information about these settings, see the Auto-formatting dialog

box.

n Dragon's Smart Format Rules appear when you correct auto-formatted alphanumeric

text using the Correction command, the Spelling window, or the keyboard. For

details, see Using Smart Format Rules and the Auto-formatting dialog box.
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Formatting numbers
You can have Dragon type your dictation as numerals. You can also change the format of

text while you are dictating it or while you are editing existing text that you have selected.

To format dictation as numerals

Say "Start Numbers Mode"

To turn Numbers Mode off, say "Stop Numbers Mode"

Note

n You can select text that contains several numbers separated by words. When you say

one of these commands, the numbers will all reformat without changing the text.

n Dragon can automatically format text and numbers as you dictate using standard writ-

ing conventions. For information about these settings, see the Auto-formatting

dialog box.

n Dragon's Smart Format Rules appear when you correct auto-formatted alphanumeric

text using the Correction command, the Spelling window, or the keyboard. For

details, see Using Smart Format Rules and the Auto-formatting dialog box.

Setting font name, size, and style
You can use commands to specify any combination of font name, size, and style, in that

order. These commands change selected text and text you dictate from then on.

To set a font name, size, or style

Say "Set Size" or "Set Font Size" or "Format That" and the font name, size, and/or style.

Examples:

"Set Font Times"

"Set Font Size 12 Points"

"Format That Courier 18 Points Bold"

"Format That Arial 12 Points"

To remove font formatting

To remove bold, italics, underline, and strikeout formatting, say "Format That Plain

Text."

Notes

n You can specify any combination of font name, size, and style, but you must specify

attributes in that order (name, size, style). If you specify only a size, you must say
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"Points." For example, say "Format That 12 Points."

n Not all of these commands work in all applications. These commands do work in

Microsoft Word, Microsoft InfoPath, Corel WordPerfect, DragonPad, and WordPad.

Check the Command Browser for additional application-specific commands.

n Commands that start with "Set Font" change selected text and text you dictate from

then on.

n Commands that start with "Format That" change the selected text or what you just

said.

n You can specify any combination of font name, size, and style, but you must specify

attributes in this order: name, then size, then style.

Aligning text
You can align text while you are dictating it or while you are editing existing text that you

have selected.

To Say

Center text "Center That" or "Format That Centered"

Left align text "Left Align That" or "Format That Left Aligned"

Right align text "Right Align That" or "Format That Right Aligned"

Adding new lines and paragraphs
While you are dictating, you can use the following commands to duplicate the action of press-

ing the Enter key once (to add a new line) or twice (to add a new paragraph).

To Say

Add a new line "New Line"

Add a new paragraph "New Paragraph"

Note

Saying "New Paragraph" presses the Enter key twice and capitalizes the next word you dic-

tate.

Hyphenating words
Dragon automatically hyphenates words based on standard usage, but you can also insert

hyphens manually.

To hyphenate words

Say "Hyphenate That" to hyphenate the last phrase you said. You can also select specific

words and say "Hyphenate That."
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Spaces between words are replaced with hyphens. Any tabs or line breaks are also replaced.

Note

You can hyphenate words as you dictate by saying "hyphen" between words. For more infor-

mation, see Dictating hyphenated and compound words in the Dragon Help.

Joining words
Dragon automatically joins words based on standard usage, but you can also join words man-

ually.

To join words

Say "Compound That" to join the last words you said. Or, select specific words and say

"Compound That."

Spaces between words are removed. Any tabs or line breaks are also removed. The word is

added to your Vocabulary.

Note

You can join words as you dictate by saying "no space." When you use this technique, the

new word is not added to your Vocabulary, but you can add it as a new compound word if

necessary. For more information, click Adding words and phrases to your Vocabulary.

Setting Auto-Formatting Options
You can configure how Dragon formats commonly used words and phrases.

Using Smart Format Rules
You can also use the Smart Format Rules feature to have Dragon recognize when you cor-

rect dictated text that corresponds to an Auto-formatting option or supported by this fea-

ture. Dragon then displays a Smart Format Rules dialog box, offering one or more setting

adjustments relevant to the change you just made. If you don’t wish to change any setting,

you can just ignore the Smart Format Rules box and continue dictating, or say "Cancel" and

the box will close.

The Smart Format Rules box may appear when you make a correction using

n the Correction menu

n the Spelling window

or

n the keyboard.

For details, see Using Smart Format Rules, the Auto-formatting dialog box and Creating

Word Properties.
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To set auto-formatting options

1. On the DragonBar, select Tools > Auto-Formatting Options. The Formatting dialog

appears.

2. Select the checkboxes of the formatting options that you want to enable. See The Auto-

Formatting dialog box for a description of the different formatting options.

3. Click OK to save your changes.

Creating Word Properties
Use this procedure to create and revise .

To open the Word Properties dialog box

1. Say "Edit Vocabulary" to open the Vocabulary Editor.

2. Say or type a Written Form or select one by scrolling the list.

Note: Scroll up to view alphanumeric words and special characters in your User Profile's

Vocabulary.

3. Say or click "Properties."

To revise Word Properties

4. Add or revise automatic formatting as required.

5. Add or revise Spoken forms or train individual words and phrases as required.

To revise Alternate Written Forms

6. Say or click "Alternate Written Form 1" or "Alternate Written Form 2." For example, here

is how Dragon displays the Alternate Written Form for "Massachusetts":

7. Say or click "Format" to open the Alternate Written Form Formatting dialog box. For

example,
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8. Choose from the following options:

Option Description

Insert
<value>
space
before and
<value>
space after

Inserts the specified number of spaces before
and after the word or phrase.
Use the drop-down fields to select a number of
spaces. Valid values are:
0
1
2

Precede by
<value>
and follow
with
<value>

Inserts the specified spacing before and after the
word or phrase.
Use the drop-down fields to select the spacing
type. Valid values are:

-(nothing)
- New Line
- New Paragraph
- Tab

Format
the next
word with

Inserts the word or phrase using the specified
capitalization.
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Option Description

<value> Use the drop-down field to select the cap-
italization type. Valid values are:
with normal capitalization
There is no special capitalization associated with
this word.
- capitalized (initial capitals)
- in all capitals
- without capitals

Format
preceding
numbers
<value>
and fol-
lowing
numbers
<value>

Inserts numbers using the specified format.
Use the drop-down field to select the format.
Valid values are:
normally (Dragon determines whether to insert
Arabic numerals or the written form of the
number)

- a-s numerals
- as Roman numerals

Sample Displays a preview of how Dragon will apply for-
matting before and after your word.

Lower
case in
titles

Causes the word or phrase to never be cap-
italized unless it appears at the beginning of a
sentence or phrase. This is typical of short
articles, such as "a", "of", or "the" when they
appear in a title that is normally capitalized, for
example "The Grapes of Wrath".
Check the "Lower case in titles" checkbox to ena-
ble this feature.

9. Repeat the last two steps to add a second Alternate Written Form as required.
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Chapter 7: Working in
Programs

This section contains the following topics:

Scrolling in popular programs 128

Using the Microsoft Office ribbon 128

About spoken commands in word processing programs 132
About spoken commands in word processing programs 132

Dictating in your word processor 132

Working with Microsoft Word 134
Basic document commands inMicrosoft Word 134

Selecting text 139

Formatting text inMicrosoft Word 140

Email Programs 142
Supported e-mail programs 142

Working in e-mail programs 142

Dictating e-mail andWeb addresses 144

Dictating E-mail and Calendar commands 145

Commands for Microsoft Outlook Express, WindowsMail, andWindows Live Mail 147

Microsoft Outlook 149
Working withMicrosoft Outlook 149

Reading and sending e-mail withMicrosoft Outlook 149

Making appointments inMicrosoft Outlook 151

Adding contacts inMicrosoft Outlook 151

Writing notes inMicrosoft Outlook 152

Using other Microsoft Outlook commands 152

Microsoft Excel 155
Working withMicrosoft Excel 155

Dictating inMicrosoft Excel with Full Text Control 155

Basic commands for Microsoft Excel 156

Formatting a Microsoft Excel spreadsheet 159

Working with cell contents inMicrosoft Excel 160
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Scrolling in popular programs
You can use the following commands in many programs to scroll and move the view

through the program's work area.

These voice scrolling commands work with Microsoft Office 2003 and 2007 programs,

including Word, Outlook, Excel, PowerPoint, and InfoPath.

To Say

Start automatic upward scrolling "Start Scrolling Up"

Start automatic downward scrolling "Start Scrolling Down"

Stop automatic scrolling "Stop Scrolling"

Increase the speed of automatic scrolling "Scroll Faster"

Reduce the speed of automatic scrolling "Scroll Slower"

Move the visible page up one line "Scroll Up"

Move the visible page down one line "Scroll Down"

Move up one line in the text "Line Up"

Move down one line in the text "Line Down"

Move the page up by a screen "Page Up"

Move the page down by a screen "Page Down"

For more information on how these commands work in individual programs, please see the

following:

n Scrolling in windows and lists

n Web browser commands

n Basic document commands in Microsoft Word

n Using other Microsoft Outlook commands

n Basic commands for Microsoft Excel

Using the Microsoft Office ribbon
Dragon supports the new ribbon and tab based interface provided in Microsoft Office 2007

and Microsoft Office 2010. Both 32-bit and 64-bit versions of Microsoft Office are sup-

ported.
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The Microsoft Office ribbon presents commands organized into a set of tabs. The tabs on

the ribbon display the commands that are most relevant for each of the task areas in the appli-

cations.

Using the Office ribbon
To use the ribbon with Dragon

Say the name of the tab or click the tab.

For example, to open the Home tab, say "Home" or click the tab.

Dragon voice commands for the Office ribbon also work when the ribbon is minimized.

To dictate from an open tab

Say the name of the feature you want to access or click on it.

For example, to apply a heading style to a paragraph you're working on, say "Heading 1" or

select Heading 1 from the Styles list.

If you're unsure of the name of a feature, you can hold your mouse pointer over the

graphic displaying the feature until the name appears.

Using the Office 2010 ribbon

Here's an example of how the ribbon looks when you click the Home tab in Microsoft Word

2010.

Note

To access the File tab in any of the Office 2010 applications, say "File Tab".

For example, here's the type of display you'll see when you click the File tab in Word 2010:
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Microsoft Word 2007

In Microsoft Word 2007, the Microsoft Office Button replaces the File menu. To

access the Microsoft Office Button, say "Office Button".

The Application menu

In Windows 7, WordPad and Windows Live Mail 2011 have a new menu for file-

related commands called the Application menu (shown below).

To access file-related commands in these applications, say "Application menu."
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About spoken commands in word
processing programs

This section contains the following topics:

About spoken commands in word processing programs 132

Dictating in your word processor 132

About spoken commands in word processing
programs
Dragon provides Natural Language Commands for use with popular word processing pro-

grams other than Microsoft Word and Corel WordPerfect. By using these commands, you

can avoid the multiple menu-selection and mouse-movement steps associated with the tra-

ditional Microsoft Windows interface. These commands let you:

n Move the text insertion point around a document

n Select a word, phrase, or block of text

n Format text (including indenting text, changing text fonts and styles, setting colors,

applying paragraph styles, adding tables, setting margins, and inserting new lines and

paragraphs)

n Run spelling and grammar checks

n Edit text (including moving, copying, pasting, and deleting text)

n Print all or part of a document and print preview your work

Because the number of valid commands is so large, you should just try saying what you

want to do. If you get unexpected results, say "Undo That" to undo the action and try a dif-

ferent way to speak the command. Alternatively, you can open the Command Browser or

the Dragon Sidebar for more information.

Notes

n Dragon displays commands with a blue border in the Results box. If you say a phrase

that produces no action, look in the Results box. If the box does not have a blue bor-

der, Dragon does not recognize it as a valid command. For example, if you say

"Insert a 2 by 2 Table" when the insertion point is inside a table, nothing happens

because you cannot insert a table inside a table.

n When creating a new document, always give the document a name before starting

your dictation.

Dictating in your word processor
If you are dictating in a word processor, there are some things you can do to make Dragon

work more efficiently:
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n Do not run other programs when you are running your word processor.

n Disable your word processor’s automatic spelling and grammar checker. Turning these

options off frees memory for speech recognition. When you have finished dictating

you can run the grammar checker. Dragon does not make spelling errors.

n Disable any automatic correction or other automatic features such as automatic for-

matting if they are not necessary. Turning these options off frees memory for speech

recognition.

n Divide large documents into multiple smaller documents. Large documents cause

Dragon to work more slowly. The maximum document size you should have depends

on your system and its resources.

n You can cancel a selection by saying "Unselect That," selecting different text, or mov-

ing the insertion point to another part of the document.

Caution

When text is selected, be careful not to breathe loudly, clear your throat, or make other

sounds. Dragon may interpret such sounds as speech and replace the selection with new text.

If this happens, say "Undo That" one or more times right away to reverse the action.
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Working with Microsoft Word
Dragon provides a large number of Natural Language commands to use with different ver-

sions of Microsoft Word. Using these commands, you can avoid the multiple menu-selec-

tion and mouse-movement steps associated with the traditional Microsoft Windows

interface. Because the number of valid commands is so large, you should just try saying

what you want to do. If you get unexpected results, say "Undo That" to undo the action and

try a different way to speak the command. Alternatively, you can open the Command

Browser or the Dragon Sidebar for more information.

You can cancel a selection by saying "Unselect That," selecting different text, or moving the

insertion point to another part of the document.

The following topics describe the natural language commands you can use to perform some

common tasks using Word:

Basic document commands

Selecting text

Formatting text

Working with tables (see Dragon Help)

Using Voice Notations (see Dragon Help)

Basic document commands in Microsoft Word
Use this procedure as a reference for basic document operations using Microsoft Word.

See also

n For text formatting and editing help, see Using Direct Editing commands and Han-

dling multiple text matches.

n Using the Microsoft Office ribbon

Creating, opening, and closing a document

To Say

Create a new document "Create New File" or "Open New File"

Open an existing doc-
ument

1. "Open File"
2. "<file name> dot <file extension>", for example, "My Doc-
ument Dot Doc"
3. "Press Enter"

Close a document "Close File" or "Close Document"
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Saving a document

To Say

Save a document as a
.doc file

1. "Save Changes"
2. Dictate a file name (only needed if this is the first time the
file has been saved)
3. "Click Save"

Save a document with a
new file name and file
type

1. "Save Document As"
2. Dictate a file name
3. "File Type <file type from list>", for example, "RTF"
4. "Click Save"

Save a document in HTML
format

1. "Save Document as Web Page"
2. "Click Save"
3. If a dialog box appears warning of a text format loss, "Click
Continue"

Save as document tem-
plate

"Save the Page Settings as Default"

Page Setup

To Say

Set the page orientation "Set Page Orientation to Landscape"
"Set Page Orientation to Portrait"

Set the size "Set Page Width to <number> Inches/Centimeters", for
example, "Set Page Width to Eight Inches"
"Set Page Height to <number> Inches/Centimeters", for
example, "Set Page Height to Eleven Inches"

Set margins "Set Left/Right Margin to <number> Inches/Centimeters",
for example, "Set Left Margin to Two Inches"
"Set Top/Bottom Margin to <number> Inches/Cen-
timeters", for example, "Set Bottom Margin to Five Cen-
timeters"

Number pages "Add Page Numbers"
"Create Page Numbers"

Create headers and footers 1. "Go To Header/Footer"
2. Dictate text to appear in the header or footer
3. "Close Header/Footer"

Add footnotes 1. Move the insertion point to the location where you want
the footnote

135



Chapter 7: Working in Programs

To Say

2. "Insert Footnote Here"
3. Dictate the footnote text
4. "Close Footnotes"

Viewing a document

To Say

View a document "Preview the File"
"View Master Document"
"Preview Document as HTML"
"Close the Preview"
"Set View to Normal"

Enlarge or reduce the doc-
ument view

"Zoom to <number> Percent", for example, "Zoom to
Fifty Percent"
"Set Zoom to Page Width/Height"

Change the display "Show/Hide Headers and Footers"
"Show/Hide the Ruler"
"Show/Hide Paragraph Marks"

Printing

To Say

Print a range of pages "Print Pages <number> to <number>", for example, "Print
Pages One to Three"

Print part of a page 1. "Select <First/Last> paragraph", for example, "Select the
Last Paragraph"
2. "Print the Paragraph" or "Print the Selection"

Checking spelling and grammar

To Say

Check spelling 1. "Check Spelling"
2. "Click Change" or "Click Ignore" depending on how you
want to respond
3. "Click Close" when the spelling check is complete
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Searching and replacing

To Say

Search for text 1. "Find a Word"
2. Dictate the word or phrase you want to find in the Find
dialog box
3. "Click Find"

Replace all instances of a
word or phrase

1. "Find Text"
2. Dictate the word or phrase you want to find
3. "Click Replace"
4. "Click Replace With" (to move the insertion point to the
Replace With field)
5. Dictate the replacement word or phrase
6. "Click Replace All"
7. "Click Close" (to close the Find and Replace dialog box)

Inserting document segments

To Say

Add a page 1. "Go To <location>" (to move the insertion point to where
you want to insert the new page). For example, "Go To Bot-
tom" to add a new page at the end of the current document.
2. "Add a New Page"

Create a line break 1. "Go To <location>" (to move the insertion point to the loca-
tion where you want the text to break). For example, "Go To
third line" to add a line break at the end of the third line in the
current paragraph.
2. "Insert Hard Line Break"

Create a page break 1. "Go To <location>" (to move the insertion point to the loca-
tion where you want the text to break). For example, "Go To
third paragraph" to add a page break at the end of the third
paragraph in the current page.
2. "Insert Page Break"

Add the date and time 1. "Go To <location>" (to move the insertion point to the loca-
tion where you want to place the information)
2. "Insert Date and Time" or "Insert Date" or "Insert Time"

137



Chapter 7: Working in Programs

Moving text

To Do

Move a word 1. Move the insertion point to the word you want to move
2. "Select Word"
3. "Move Word Forward/Back <number> Words/Lines",
for example, "Move Word Forward Five Lines"

Move a line 1. Move the insertion point to the line you want to move
2. "Select Line"
3. "Move Line Forward/Back <number> Lines" or "Move
Line to the Beginning/End of Paragraph/Document", for
example, "Move Line to the End of Paragraph"

Move a paragraph 1. Move the insertion point to the paragraph you want to
move
2. "Select Paragraph"
3. "Move Paragraph Forward/Backward <number> par-
agraphs" or "Move Paragraph to the Beginning/End of Doc-
ument", for example, "Move Paragraph to the Beginning
of Document" or "Move Paragraph Backward Six Par-
agraphs"

Moving around in a document

To Say

Go to a specific place in a
document window

"Go to <location>," where location can be top, bottom,
start, or end.

Move up or down one line "Line Up"
or
"Line Down"

Move up or down one page "Page Up"
or
"Page Down"

Go back to the last place
you moved the cursor

"Go Back" See Using "Go Back" to move the cursor
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Switching between open documents

To Say

Switch between open doc-
uments

1. "Say "List windows for Microsoft Word"
Do one of the following:
Say "Choose n", where n is the number of the window you

want to switch to. For example, say "Choose 2"
OR
Choose the number of the program from the list and click

OK

See Scrolling in popular programs, Scrolling in windows and lists, and Moving the insertion

point.

Note

You can also select the next or previous word, line, or paragraph by moving the insertion

point to either before or after the word, line or paragraph you want to select and saying

"Select Next/Previous Word/Line/Paragraph"

Selecting text
You can use the following voice commands to select text in Microsoft Word and Ope-

nOffice.org Writer.

To Do

Select a word, line, or par-
agraph

1. Move the insertion point to the word, line, or par-
agraph you want to select
2. Say "Select <word>/<line>/<paragraph>"

Select an adjacent word, line
or paragraph

1. Move the insertion point to either before or after the
word, line, or paragraph you want to select.
2. Say "Select <next>/<previous>
<word>/<line>/<paragraph>"

Select specific text or a range
of text (see also Handling mul-
tiple text matches)

Select <text>*
Select <text> Through <text>(Note: Outside the USA

or Canada, say "Select <text> To <text>".)
Select from <text> to <text>
* For <text> substitute whatever text you want select.

Extend a selection "Extend Selection Forward/Backward by <number>
Words/Lines/Paragraphs"
"Extend Selection Up/Down by <number> Lines/Par-

agraphs"
"Extend Selection Left/Right by <number> Words"
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Formatting text in Microsoft Word
This topic contains examples of voice commands to format text in Microsoft Word.

For information about applying formatting to multiple instances of words or phrases, see

Handling multiple text matches.

Changing text properties

To Say

Change text properties "Set Word/Line/Paragraph to Strikeout"
"Underline this Word/Line/Paragraph"
"Italicize Next <number> Words"
"Bold This Page"

Changing font and point sizes

To Say

Change font name and
point size

"Set the Font to Twenty Four Points Times in the
Word/Line/Paragraph"
"Increase/Decrease the Font Size to Eighteen Points in the
Word/Line/Paragraph"
"Set the Font to Courier in the Selec-
tion/Word/Line/Paragraph/Page/Section/Document"
"Decrease Selection by Two Points"

Changing font properties

To Say

Change font properties "Turn on Bold and Italics"
"Format That Regular"
"Italicize the Next <number> Words/Lines/Paragraphs," for
example, "Italicize the Next Five Lines"
"Unitalicize That"

Changing capitalization

To Say

Change case "Capitalize the First/Last/Next <number> Words/Lines/Par-
agraphs," for example, "Capitalize the Next Five Words"
"Lowercase the First/Last/Next <number> Words/Lines/Par-
agraphs," for example, "Lowercase the Last Ten Words"
"Toggle the Case of the Word"
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Changing font color

To Say

Change font color "Set Font Color to Green in This Line"
"Set the Color to Red in the Selection"
"Set It to Dark Blue" (refers to current word or selection)

Changing line spacing

To Say

Change line and par-
agraph spacing

"Double Space the Paragraph"
"Single Space Selection"
"Increase Paragraph Spacing to <number> Inches/Cen-
timeters"

Changing text justification

To Say

Change text justification "Justify the Document"
"Right Justify It" or "Right Align Selection"
"Left Align This Line/Paragraph"
"Set Initial Indent to <number> Inches/Centimeters"
"Set Hanging Indent to <number> Inches/Centimeters on
This Page"

Creating bulleted or numbered lists

To Say

Create and delete bullet
points or list numbers

"Set the paragraph to Bulleted/Numbered"
"Delete Bullets From the Document"
"Unnumber the Selection"

Working with outlines

To Say

Create an outline "Set View to Outline"
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Email Programs
This section contains the following topics:

Supported e-mail programs 142

Working in e-mail programs 142

Dictating e-mail and Web addresses 144

Dictating E-mail and Calendar commands 145

Commands for Microsoft Outlook Express, Windows Mail, and Windows

Live Mail 147

Supported e-mail programs
The e-mail commands listed in this section work in the following desktop e-mail appli-

cations:

n Microsoft Outlook Express

n Microsoft Outlook

n Lotus Notes

n Mozilla Thunderbird

n Windows Mail

n Windows Live Mail

Dragon's Web application commands, along with many of the commands for desktop e-mail

applications, work in these Web-based applications:

n Gmail (in supported Web browsers)

n Hotmail (in supported browsers)

Note

If you use Gmail or Hotmail, you cannot use Dragon's tools for adding contacts and scan-

ning sent e-mail.

Working in e-mail programs
The commands described here work best with desktop e-mail applications. If you're using

Web-based e-mail, see Using Rich Internet Application extensions for additional infor-

mation.

Check the list of supported e-mail programs to verify that Dragon works with your e-mail

application.

To start an e-mail program

Say "Start Mail" to start your default e-mail program.
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To access and create e-mail messages

Use the following commands to check for, open, and create messages.

To Say

Check for new messages "Check Mail"

Open the selected e-mail message "Open Mail"

Create an e-mail message "New Mail"

Commands for working with e-mail messages
To work with e-mail messages

Use the following commands if you are working in your Inbox and have a message selected

or open.

To Say

Reply to the sender of the cur-
rent message

"Reply to Mail" or "Reply"

Reply to the sender and all recip-
ients of the current message

"Reply to All"

Forward the current message "Forward Mail"

Print the current message "Print Mail"

Delete the current message "Delete Mail"

Send the current message "Send Mail"

Close the active e-mail mes-
sage window

"Close Mail" This command does not close your mail
program. It does not work in Netscape Messenger.

Commands for moving around in e-mail
To move around in email

Use the following commands to move around when editing e-mail. Please note that only "Go

to Body Field," "Go to Previous Field," and "Go to Next Field" are supported in Windows

Live Mail.

To Say

To move to the To field "Go to To Field"

To move to the CC field "Go to CC Field"

To move to the BCC field "Go to BCC field"
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To Say

To move to the Subject field "Go to Subject Field"

To move to the Body field "Go to Body Field"

To move to the First field "Go to First Field"

To move to the Previous field "Go to Previous Field"

To move to the Next field "Go to Next Field"

To move to the Last field "Go to Last Field"

Move up or down one line "Line Up"
or
"Line Down"

Move up or down one page "Page Up"
or
"Page Down"

Go to a specific place in a doc-
ument or message window

"Go to <location>," where location can be top, bottom,
start, or end.

Go back to the last place you
moved the cursor

"Go Back" See Using "Go Back" to move the cursor

Note

You can say "E-mail," "Message," or "Memo" in place of "Mail" in these commands.

Dictating e-mail and Web addresses
You can dictate e-mail and Web addresses as you normally speak them. To make sure that

the address is lowercase, say "no caps on".

To Dictate Say

info@samplecompany.com "no caps on info at sample company dot com no caps off"

http://www.samplecompany
.com/sales

"no caps on http www dot sample company dot com
slash sales no caps off"

Notes

n The "Web and E-mail Addresses" box must be selected on the Auto-formatting

dialog box. for you to dictate e-mail addresses as described here.
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n You can say the following abbreviations by pronouncing them as words: com, net, org,

and sys. Say the following abbreviations by saying their letters: edu, gov, mil, ca, de,

fr, jp, sp, and uk.

n If an address contains nonwords or words that Dragon does not recognize (for exam-

ple, "baxterex" in "juliasmith@baxterex.com"), you can correct the recognition error

and the address will usually be recognized in the future. You can also add names that

you commonly use to your Vocabulary.

n Create text and graphics commands for addresses you dictate frequently.

n You can use the "Spell That" command to correct e-mail and Web addresses by spell-

ing.

n You can add the names in your address book to your Dragon Vocabulary by running

the Learn From Sent E-mails tool.

Dictating E-mail and Calendar commands
Use the Dragon Voice Shortcuts in this topic to control your e-mail and Microsoft Outlook

calendar.

Just say commands containing your desired e-mail task. For example, say “Send e-mail to

<contact name>," where <contact name> is the name of someone in your e-mail address book.

Dragon opens a new message in your default e-mail client, with the address for the contact in

the To field. If you are using Microsoft Outlook, you can also schedule meetings. For exam-

ple, say “Schedule meeting with <contact name1> and <contact name2>,” where <contact name1>

and <contact name2> are the names of people in your Outlook contact list. Dragon opens a

new calendar entry in Outlook, adding the selected contacts. You can also schedule a meet-

ing for a specific date and time. For example, "Create an appointment on July 1 at 1 pm."

Before you begin

n Before using the Dragon e-mail and Outlook calendar commands for the first time,

you must run the Learn From Sent E-mails tool, so that Dragon knows your e-mail

contacts. To run the tool, say "Open Accuracy Center," then "Click Learn From Sent

E-Mails," or click Vocabulary > Learn From Sent E-Mails. For more information, see

Learn From Sent E-mails. Note that the tool works only with e-mail clients that keep

data on your local computer.

n Make sure Microsoft Outlook is the default e-mail client, before you start dictating cal-

endar commands.

The following table lists the types of e-mail and calendar commands that Dragon supports, an

example command, and a description of what happens after you say the command.
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Command
Type Syntax

Example
command What happens

Email the
selected text,
message or
file(s) to one or
more contacts

E-mail the selection
to <name>... and
<name>

“E-mail the
selection to
Peter
Moreno and
Caroline
Chang"

A new e-mail appears,
addressed to the person(s)
named, with as body the
selected text (or email) or as
attachment(s) the file(s)
selected in Windows Explorer.

Send e-mail to
specific contacts
who are listed in
your e-mail
address book or
contact list

(Send | Create) [an |
a] (e-mail | mail
[note] | message) to
<name>
<name>...<name>
and <name>

"Send e-
mail to John
Doe and
Jane Smith"

A new e-mail appears with John
Doe and Jane Smith's e-mail
addresses in the To field.

Send e-mail
about a specific
subject

(Send | Create) [an |
a] (e-mail | mail
[note] | message)
(about | on)<sub-
ject>

"Send e-
mail about
project
schedule"

A new e-mail appears with the
phrase "Project Schedule" in the
Subject field.

Schedule a meet-
ing with specific
contacts

(Schedule | create |
book) ([a] meeting |
[an]
appointment) with
<name>
<name>...<name>
and <name>

"Schedule a
meeting
with John
Doe and
Jane Smith"

A new Meeting window appears
with John Doe and Jane Smith
listed as attendees.
This command works only with
Microsoft Outlook.

Schedule a meet-
ing or appoint-
ment about a
specific subject

(Schedule | create |
book) ([a] meeting |
[an]
appointment) about
<subject>

"Schedule a
meeting
about vaca-
tion time"

A new Meeting or Appointment
window appears with the phrase
"vacation time" in the Subject
field.
This command works only with
Microsoft Outlook.

Schedule a meet-
ing or appoint-
ment at a specific
time

(Schedule | create |
book) ([a] meeting |
[an]
appointment) [on]
(month) | (day) [at]
(time)

"Create an
appointment
on July 1 at
1 pm"

A new Meeting or Appointment
window appears for the date and
time you dictated.
This command works only with
Microsoft Outlook.

Move a message
from one Micro-
soft Outlook
folder to another

Move [the] (e-mail |
message | selection |
it | that | this ) to
[the] <folder name>
folder

"Move e-
mail to
Inbox
folder"

The selected message moves to
the Outlook folder used in the
command.
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Command
Type Syntax

Example
command What happens

Note: If the folder name is unu-
sual, you may need to add it to
Dragon's Vocabulary. See Add-
ing individual words to your
Vocabulary.

Create a task in
Microsoft Outlook

Create task <about |
on>

"Create
task about
today's shop-
ping list"

A task window opens, with the
subject "today's shopping list."

Notes

n If e-mail and calendar commands are not working in Microsoft Outlook, make sure the

Natspeak Outlook Add-in is enabled in the Outlook Options. See the Microsoft Help

for information about setting the options.

n The e-mail commands “mail it to…”, “send this to…”, and “forward that to…” have

been removed from Version 12. You can continue to use “e-mail the selection to…”

command.

Enabling or disabling E-mail and Calendar commands

To enable or disable e-mail and calendar commands, open the Options dialog box, Com-

mands Tab and do one of the following:

Select or deselect the "Enable E-mail and Calendar commands" check box.

The option is enabled by default.

Commands for Microsoft Outlook Express,
Windows Mail, and Windows Live Mail
You can use the following voice commands using Microsoft Outlook Express, Windows

Mail, and Windows Live Mail.

To Say

Start the e-mail application "Start Outlook Express"
"Start Windows Mail"
"Start Windows Live Mail"
Instead of "start," you can also say "open," "launch" or
"show". For example, say "show Outlook Express"

Readmessages "Check for New Mail"
"Open Message"
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To Say

"Go To Next Unread Message"
"Mark Message as Unread"
"Go To Previous Message"
"Delete Message"
"Close the Message Window"

Create and send amessage 1. "Create Message"
2. "Move to Text Field"
3. Then, dictate the content of your message and when
you ready to send, say "Send Message".

Go to the Subject line in a message
(Windows Mail and Outlook Express
only)

"Go to Subject"
"Go to Subject Field"

Go to your Address Book folder (for
Outlook Express only)

"Go to Address Book"

Go to your Windows contacts folder
(for Windows 7 andWindows Mail
(Vista) only)

"Go to [the] [Windows] contacts" (for Windows 7 andWindows
Mail (Vista) only)

"Display contacts folder" (for Live Mail only)

Reply to a message 1. "Reply to Author" to reply to the sender only, or
"Reply to All" to reply to all recipients of the message
2. "Move to Text Field"
3. Then, dictate the content of your message and when
you ready to send, say "Send Message".

Forward amessage "Forward the Message"

Sort Inbox messages "Sort ascending | descending"
"Sort e-mails ascending | descending"
"Sort memos ascending | descending"

Go to the Outbox (for Outlook
Express in Windows XP and
Windows Mail in Vista only)

"Go to [the] Outbox folder"

Access file-related commands (for
Windows Live Mail 2011 only)

"Application menu"

Note

Words shown in [brackets] are optional.
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Microsoft Outlook
This section contains the following topics:

Working with Microsoft Outlook 149

Reading and sending e-mail with Microsoft Outlook 149

Making appointments in Microsoft Outlook 151

Adding contacts in Microsoft Outlook 151

Writing notes in Microsoft Outlook 152

Using other Microsoft Outlook commands 152

Working with Microsoft Outlook
Dragon provides a number of natural language commands to use with Microsoft Outlook.

Using these commands, you can avoid the multiple menu-selection and mouse-movement

steps associated with the traditional Microsoft Windows interface. Because the number of

valid commands is so large, you should just try saying what you want to do. If you get

unexpected results, say "Undo That" to undo the action and try a different way to speak the

command. Alternatively, you can open the Command Browser or the Dragon Sidebar for

more information.

You can cancel a selection by saying "Unselect That", selecting different text, or moving the

insertion point to another part of the document.

For information about applying formatting to multiple instances of words or phrases, see Han-

dling multiple text matches.

In addition, the following topics describe the natural language commands you can use to per-

form some common tasks using Microsoft Outlook:

Reading and sending e-mail

E-mail and Calendar commands

Making appointments

Adding contacts

Writing notes

Using other Microsoft Outlook commands

For information on using Microsoft Outlook Express, see Commands for Microsoft Outlook

Express, Windows Mail, and Windows Live Mail.

Reading and sending e-mail with Microsoft
Outlook
You can use the following voice commands to read, create, and send e-mail using Microsoft

Outlook:
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To Say

Send amessage without
havingMicrosoft Outlook
open

Say either of the following:

n "Send e-mail to <contact name>"

Or

n "Start Microsoft Outlook"

Read your e-mail 1. "Start Microsoft Outlook"

Instead of "start", you can also say "open", "launch" or

"show". For example, say "show Microsoft Outlook"

2. "Go To Inbox"

3. "Check for new mail"

4. "Open Mail Message" to read first unread message

5. "View Next Unread Message" to open the next message

Reply to a message 1. "Reply to Message" or "Reply to This Message" to reply

to the sender only, or "Reply to All" to reply to all recip-

ients of the message

2. Dictate your reply

3. "Send Message"

Create a new message 1. "Create E-mail"

2. Dictate the address of the recipient

3. "Subject"

4. Dictate the subject line

5. "Text Field" or "Move to Text"

6. Dictate the text of the message

7. "Send Message"

Miscellaneous e-mail com-
mands

n "Mark the Message as Unread"

n "Copy this Message to a Folder"

n "Flag Message for Followup"

n "Close All Items"

Tip: You can use the Send E-mail command even if Microsoft Outlook is closed. Here's how:

1. Say "Send E-Mail to <contact name>," where contact name is the name of someone in

your Outlook Contacts. Dragon opens an Outlook message with the contact name

entered in the To field.

2. Compose your message and send it as usual. Outlook remains closed after the mes-

sage is sent.
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Making appointments in Microsoft Outlook
You can use the following voice commands to make appointments in Microsoft Outlook:

To Say

Open your calendar 1. "Start Microsoft Outlook"
Instead of "start", you can also say "open", "launch" or "show".
For example, say "show Microsoft Outlook"
2. "View Calendar"

Create an event 1. "Create New All Day Event"
2. Dictate the subject line, for example, "Company Picnic"
3. "Set Start Time to <day>", for example "Set Start Time to
Monday" (Note: Available only in Microsoft Outlook 2000 and
Microsoft Outlook XP.)
4. "Press Tab Key" to move to the text box
5. Dictate any additional information you want for the event, for
example "Be sure to bring your choice of beverage"
6. "Invite People to This Event"
7. Dictate the e-mail addresses of all the people you want to
receive the invitation
8. "Send this appointment"

Other appointment
commands

"Make This an Online Event"
"Set Reminder On"
"Show Time as Tentative"
"Decline This Event"
"Mark This Appointment as Unread"
"Forward This Appointment"

Adding contacts in Microsoft Outlook
You can use the following voice commands to add contacts in Microsoft Outlook:

To Say

Open your address
book

1. "Start Microsoft Outlook"
Instead of "start", you can also say "open", "launch" or "show".
For example, say "show Microsoft Outlook"
2. "View Address Book"

Create a new contact 1. "Create New Contact"
2. Dictate a name in the Full name box, for example, "Joel Huff-
man"
3. "Press Alt Yankee" to open the Company field
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To Say

4. Dictate a company name, for example "Mega Products Lim-
ited"
5. "Click Business" to open the telephone number field
6. Dictate a telephone number, for example "7815551212" (if
"phone numbers" is selected on the Auto-formatting dialog box,
Dragon will format the number in standard telephone number for-
mat.)

Save the new contact "Save and Close This"

Writing notes in Microsoft Outlook
You can use the following voice commands to write notes in Microsoft Outlook:

To Say

Open the Outlook note-
pad

1. "Start Microsoft Outlook"
Instead of "start", you can also say "open", "launch" or "show."
For example, say "show Microsoft Outlook"
2. "Open New Note"

Create and format a
note

1. Dictate the text of the new note
2. "Right Align This", "Left Align This", "Justify This", or "Center
This" to set the text alignment
3. "Set This <text property>" where <text property> is any font
style or point size you want
4. "Find a Word" to perform a search

Using other Microsoft Outlook commands
You can use the following voice commands to access various features in Microsoft Out-

look:

Miscellaneous commands

To Say

Open the calendar view "View Calendar"

Open and view the jour-
nal properties

1. "View Journal"
2. "View Properties" or "View Properties of Journal"

Open Internet Explorer
from Outlook

"Switch to Web Browser"

152



Dragon 12 Installation and User Guide

Commands to use in dialog boxes when you are creating or editing
e-mail messages in HTML format

When you create or edit e-mail messages in HTML format, you must use the same voice com-

mands that you use in Internet Explorer to navigate in certain Outlook dialog boxes, such as

the Find, Picture, and Font dialog boxes. You can identify these dialog boxes by the Internet

Explorer symbol (a small document icon with the letter "e" in it) appearing in the upper-left

corner of the dialog box header. To allow Dragon to recognize these commands, you must

have the "Enable commands in HTML windows" option selected on the Commands tab of

the Options dialog box.

To Say

Click a button "Click<button name>", for example, "Click Apply". Saying
"Click" is optional.

Show all check boxes and go to the first
one

"Click Check Box"or "Check Box"

Show all option (radio) buttons on the
dialog box

"Click Radio Button" or "Radio Button"

Show all boxes with lists of choices "Click List Box" or "List Box"

Open a list of choices "Show Choices"

Close a list of choices "Hide Choices"

Choose an entry from a list of choices "Choose<text>", for example, "Choose Ariel bold". Saying
"Choose" is optional.

Select the item identified by a number
such as that appears if your choice
matches more than one thing

"Choose<number>", for example, "Choose Eight".

Select the next matching object on the
dialog box

"Next", "Next Match", or "Next Control"

Select the previous object on the dialog
box

"Previous", "Previous Match", or "Previous Control"

Click the selected edit box or other
object.

"Click That"

Moving around in a message window

See Scrolling in popular programs and Scrolling in windows and lists.
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Microsoft Outlook 2010 commands

To Command

Create an appointment "Create a new appointment at <time>" For example, "12:15
p.m."
See Times in Auto-formatting dialog box..

Copy information from
one contact to another

"Copy to new contact"

Ignore a conversation "Ignore conversation"

Clean up a con-
versation

"Clean up conversation"

Clean up a folder "Clean up folder"

Clean up a folder and
all it's subfolders

"Clean up folder and subfolders"
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Microsoft Excel
This section contains the following topics:

Working with Microsoft Excel 155

Dictating in Microsoft Excel with Full Text Control 155

Basic commands for Microsoft Excel 156

Formatting a Microsoft Excel spreadsheet 159

Working with cell contents in Microsoft Excel 160

Working with Microsoft Excel
Dragon provides a number of natural language commands to use with Microsoft Excel. Using

these commands, you can avoid the multiple menu-selection and mouse-movement steps

associated with the traditional Microsoft Windows interface. Because the number of valid

commands is so large, you should just try saying what you want to do. If you get unexpected

results, say "Undo That" to undo the action and try a different way to speak the command.

Alternatively, you can open the Command Browser or the Dragon Sidebar for more infor-

mation.

You can cancel a selection by saying "Unselect That", selecting different text, or moving the

insertion point to another part of the document.

In addition, the following topics describe the natural language commands you can use to per-

form some common tasks using Microsoft Excel:

Dictating in Microsoft Excel with Full Text Control

Basic Microsoft Excel commands

Formatting a Microsoft Excel spreadsheet

Working with contents in Microsoft Excel

Dictating in Microsoft Excel with Full Text
Control
You can use Full Text Control commands and built-in commands to enter and revise content

and to navigate between cells in Microsoft Excel. For a complete list of the commands you

can use in Microsoft Excel, use the Command Browser.

Dictation and Editing Modes

There are two modes for using voice commands in Microsoft Excel. The two modes are

described in the following table.
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Edition Mode Description

Quick Edition Mode Allows you to enter new content into a cell, overwrite the current
contents of a cell, or format the entire contents of a cell. When
you select a cell and begin dictating, a yellow background appears
to indicate that the dictated text will be inserted into the cell. If
the cell currently contains text, the new dictated text will over-
write the existing text. If you want to format the contents of a
cell, select the cell, or select a portion of the cell’s contents using
Full Text Control commands, and say a formatting command,
such as "Set Font Arial 10 Points Bold".

Full Edition Mode Allows you to edit the existing contents of a cell. If you want to
add to or edit the current contents of a cell, select the cell and say
"Edit Cell" or "Press F2" to open the cell for editing. When you
enter Full Edition Mode, the background color changes to blue.
Entering Full Edition Mode is analogous to double-clicking a cell.
Line and Paragraph commands, such as "New Line" operate within
the selected cell in Full Edition mode.

Using Full Text Control

In general, Full Text Control is available in cells except when you type something into a cell

before you dictate. For example:

n If you dictate into a cell, then type some characters, and dictate more text into that

cell, Full Text Control is available.

n If you type at the beginning of a cell and dictate some text or numbers, Full Text

Control is available only on the portion you dictated.

n Once you have edited a cell using any combination of typing and dictation, when you

move back to that cell by voice, Full Text Control is available in the entire cell.

n The commands that quote text from the screen (select <xyz>, correct <xyz>, insert

after <xyz>…) work thanks to a functionality called Full Text Control. This func-

tionality depends on Dragon’s ability to constantly obtain information from the text

field about its content—for instance, in order to know where words and sentences

begin and end, so Dragon can apply spacing between words and capitalization at the

beginning of sentences. Most standard text fields allow full Full Text Control capabil-

ities. For more information, see The Full Text Control Indicator.

Basic commands for Microsoft Excel
You can use the following voice commands to perform basic operations using Microsoft

Excel.
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Creating, opening, and closing a spreadsheet

To Say

Create a new spreadsheet "Create New File" or "Create New Workbook"

Open an existing spreadsheet 1. "Open File" or "Open Document"
2. "<file name>", for example, "My Spread-
sheet"
3. "Press Enter"

Close a spreadsheet "Close File" or "Close Document"

Editing in a spreadsheet

To Say

Create a new line within a cell "New Line"

Edit the contents of a selected cell "Edit cell"
Or
"Edit selection"

Complete a cell entry and stay in the cell "Apply"

Complete a cell entry andmove down one
cell (Quick Edition mode only)

"Press Enter"

Cancel a cell entry and remain in the cell "Press Escape" or "Cancel"

Saving, renaming, and moving to another a spreadsheet

To Say

Save a spreadsheet as a .xls file 1. "Save file"
2. Dictate a file name (only needed if this is the
first time the file has been saved)
3. "Click Save"

Save a spreadsheet in HTML format 1. "Save File as Web Page"
2. "Click Save"
3. (If a dialog box appears warning of a format
loss) "Click Continue"

Rename a spreadsheet "Rename the Worksheet"

Moving to another open spreadsheet "Go To the Next/Previous Worksheet"
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Setting up a spreadsheet

To Say

Set printing area 1. "Fit to <number> Pages Wide"
2. "Fit to <number> Pages Tall"

Viewing the spreadsheet

To Say

Enlarge or reduce the spreadsheet view "Zoom to <number> Percent", for example,
"Zoom to Fifty Percent"

Change the display - "Hide/Unhide This Row/Column"
- "Hide/Show the Drawing Toolbar"
- "Hide/Unhide the Formulas in This Col-
umn/Row"

Printing

To Say

Print a range of pages "Print Workbook"
"Print the Selection"
"Print Column <number> to Column <number>"
"Print Next <number> Rows"

Preview a printout "Go To Print Break Preview"

Print part of a page "Set Print Area to Selection"
"Set Print Area to the First/Next/Previous
<number> Rows/Columns"
"Print the Selection"

Moving around a spreadsheet

To Say

Move to new location "Next/Previous Row/Column"
"Start of This/Next/Previous Row/Column"
"Row/Column <number/letter>", for example, "Row
Five" or "Column A". If the column includes two or more
letters, say the alpha-bravo form of the letter, for exam-
ple to go to Column AB, say "Column Alpha Bravo"
"Start of Row/Column"
"Next/Previous Cell in the Row/Column"
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To Say

Start automatic downward scrolling "Start Scrolling Down"

Start automatic upward scrolling "Start Scrolling Up"

Move to the bottom of the spread-
sheet

"Scroll Down"

Move to the top of the spreadsheet "Scroll Up"

Stop automatic scrolling "Stop Scrolling"

Increase the rate of automatic scroll-
ing

"Scroll Faster"

Decrease the rate of automatic
scrolling

"Scroll Slower"

Move down one row "Line Down"

Move up one row "Line Up"

Switching between open spreadsheets

To Say

Switch between open spreadsheets 1. Say "List windows for Microsoft Excel"
Do one of the following:
Say "Choose n", where n is the number of the

window you want to switch to. For example, say
"Choose 2"
Or
Choose the number of the program from the

list and click OK

Formatting a Microsoft Excel spreadsheet
You can use the following voice commands to format a Microsoft Excel spreadsheet:

To Say

Change column width n "Set Column Width to <number>"

n "Set Width to <number> in Column

<number>"

Change row and column appear-
ance

n "Shade This Row/Column"

n "Apply Pattern to Current/This Row/Col-

umn"
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To Say

n "Center the Next/Previous <number>

Rows/Columns"

n "Indent the Next/Previous <number>

Rows/Columns <number>"

n "Bold/Italicize This Row/Column/Cell"

Working with cell contents in Microsoft Excel
You can use the following voice commands to work with content in Microsoft Excel. See

also Basic commands for Microsoft Excel.

To Say

Edit the contents of a
selected cell

"Edit cell"
Or
"Edit selection"

Sum or average a column
or row of numbers

1. Move the insertion point to the cell where you want the
sum to appear
2, "Sum/Average the Values on the Right/on the
Left/Above/Below"

Sort a column or row of
numbers

1. Select the row, column, or range of cells you want to sort
2. "Sort the Selection"

Change contents from dec-
imals to fractions

1. Move the insertion point to the row, column, or cell you
want to change
2. "Set this Row/Column/Cell to Fractions in <number>", for
example "Set this Cell to Fractions in Eighths"

Lock or unlock contents 1. Move the insertion point to the row, column, or cell you
want to lock or unlock
2. "Lock/Unlock This Row/Column/Cell"

Fill a cell, row, or column 1. Move the insertion point to the row, column, or cell you
want to fill
2. "Fill This Cell Up/Down/Right/Left <number>
Cells/Rows/Column", for example, "Fill This Cell Down Two
Rows"

Delete the contents of a
cell, row, or column

1. Move the insertion point to the row, column, or cell you
want to clear
2. "Clear All From This Row/Column/Cell"

Hide the contents of a cell,
row, or column

1. Move the insertion point to the row, column, or cell you
want to hide
2. "Hide This Row/Column/Cell"
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Chapter 8: Working with
Web applications

This section contains the following topics:

Using Rich Internet Application extensions 163

Browser requirements for Web application support 165

Enabling Web application support 165

How to tell if Web application support is active 167

Using Gmail 168

Using Hotmail 170

Editing text in a supportedWeb application 173

Using Dragon'sWeb capabilities without RIA 175

If you have problems using Web application support 176

Using Rich Internet Application extensions
This topic describes functionality made possible by Dragon's Rich Internet Application

(RIA) extensions at the time of the Version 12's releases.

RIA extensions enable you to use supported Web browsers to dictate content and com-

mands. The feature uses Full Text Control in supported browsers and Web applications to

help you perform common tasks by voice. For example, you can say "Click Inbox," or "Go to

Subject" or "Click Sent Mail." Also see Using Dragon's Web capabilities without RIA.

Supported Web applications

n Gmail

n Hotmail

Windows Live E-mail

Some Internet service providers rebrand Hotmail as Windows Live E-mail. Dragon's RIA

extensions are also available for those implementations.

Supported Web browsers

Rich Internet Application (RIA) extensions are available in the following Web browsers and

versions:
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n Internet Explorer, version 9 (32-bit mode only)

n Mozilla Firefox, version 12 or later

n Google Chrome, version 16 or later

If you don't have one of these browsers in the version listed, you can still use Dragon's

existing capabilities for commands and dictation on the Web, but you will not have the full

benefit of Web application support.

IMPORTANT

In the specific web applications it supports, the RIA feature adds to Dragon’s usual capabil-

ities in the particular supported Web browser.

Dragon's functionality differs significantly between Web browsers. Please see Working with

a Web browser. For example: In Chrome, you cannot select hyperlinks by name or use com-

mands like “refresh page” and “open new tab”. For these actions, you must use global com-

mands, such as mouse commands or press commands such as “press F5” and “press control

t”.

Before you begin

1. Make sure you have the right browser.

2. Launch Dragon and launch your browser. If the browser asks you to enable the exten-

sions, click "Yes."

3. Restart your browser.

4. Go to the site for the Web application you want to use and log in to your account.

5. Determine if the feature is active.

For more information, see Enabling Web application support.

Displaying the commands this feature adds

Use the following procedures to display, hide, or print the RIA commands available in a sup-

ported Web application.

To display a list of the commands for the current Web application

Say "[click] Show Site Commands" or click the link.

To hide the command list

Say "Hide Site Commands" or click the link.

To print the command list for reference

1. Say "Show Site Commands" to open the list.

2. Click the Printer icon on the Website commands window.

For information on commands you can use to edit text in Web applications, see Editing text

in a Web application.

Resolving problems

For more help with this feature, see If you have problems using Web application support.
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Browser requirements for Web application
support
Rich Internet Application (RIA) extensions are available in the following Web browsers and

versions:

n Internet Explorer, version 9 (32-bit mode only)

n Mozilla Firefox, version 12 or later

n Google Chrome, version 16 or later

If you don't have one of these browsers in the version listed, you can still use Dragon's exist-

ing capabilities for commands and dictation on the Web, but you will not have the full ben-

efit of Web application support.

IMPORTANT

In the specific web applications it supports, the RIA feature adds to Dragon’s usual capabil-

ities in the particular supported Web browser.

Dragon's functionality differs significantly between Web browsers. Please see Working with a

Web browser. For example: In Chrome, you cannot select hyperlinks by name or use com-

mands like “refresh page” and “open new tab”. For these actions, you must use global com-

mands, such as mouse commands or press commands such as “press F5” and “press control

t”.

Enabling the feature

After you install Dragon, and open a supported browser, the browser may prompt you to ena-

ble Dragon's Web application support. Click Yes to turn the feature on. For more infor-

mation, see Enabling Web application support.

After you enable the RIA extensions, restart your browser.

If you use Windows XP

Internet Explorer 9 is not available for Windows XP. To use RIA extensions with Windows

XP, use Firefox or Chrome.

If you use Google Chrome

The feature is not supported when you are in Chrome's Incognito mode.

Enabling Web application support
Use this topic to review or enable Dragon's Web application support and Full Text Control.

The easiest way to enable Web application support, also referred to as Rich Internet Appli-

cation (RIA) support, is by clicking "Yes" to the prompt to enable the browser extensions

after you install Dragon. The prompt may appear the first time you open a supported browser

after a fresh installation of Dragon.
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Say or click the links below for instructions about how to enable the extensions or to check

your Web browser's extension settings.

In Internet Explorer 9 (32-bit mode) or later

1. Click the cog icon  on the Title bar.

2. Click "Manage Add-ons."

3. Scroll the Add-ons list to the section for Nuance Communications, Inc., as shown

here.

4. If the Status column indicates that either the Plugin or Extension is "Disabled," do

the following:
n Select the name of the item from the list.

n Click "Enable"at the bottom of the Manage Add-ons dialog box.

5. Click "Close" to close the Manage Add-ons dialog box.

6. Close and reopen the browser. The feature will now be enabled. See also How to tell

if Web application support is active.

In Mozilla Firefox 12 or later

1. Click the Firefox button to open the Firefox file tab  (the example is

from Firefox 12.0).

2. Click "Add-ons" to open the Extensions pane. The Dragon RIA extension shows, sim-

ilar to the following example.

3. If the extension is disabled, click "Enable."

4. Click "Plugins" to open the Plugins screen, and look for the Dragon RIA plugin, as

shown in the following example.
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5. If the extension is disabled, click "Enable." See also How to tell if Web application sup-

port is active.

Be careful when you upgrade!

When you upgrade Firefox, you'll see a window prompting you to choose which add-ons

you want to keep active. You must select the Dragon RIA extension, or Firefox will

automatically disable it. If this happens, use the steps above to re-enable it.

In Google Chrome 16 or later

1. Click the Wrench icon  beside the Address bar to open the Google Customization

and Control menu.

2. Click "Settings."

3. Click "Extensions." The Dragon RIA Extension for Chrome displays, as shown:

4. Close and reopen the browser. If necessary, click "Enable" to enable the Dragon Rich

Internet Application extension. A checkmark appears in the "Enabled" checkbox when

the Dragon RIA extension is enabled, as shown. See also How to tell if Web appli-

cation support is active.

Resolving problems

Please see If you have problems using Web application support.

How to tell if Web application support is active
After you install Dragon, your Web browser may prompt you to enable Dragon's Rich Inter-

net Application (RIA) extensions. Click "Yes" to turn the feature on. Here's an example of

how the RIA extension displays in Google Chrome:
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If you need to turn on Dragon's RIA extensions or verify that they are turned on, please see

Enabling Web application support.

What you'll see in your Web application

When you are in a supported Rich Internet Application and the feature is enabled, you'll see

a small apostrophe icon to the left of interface elements that you can click by voice, as

shown here in Gmail:

You'll also know that the feature is enabled if you place your insertion point in a text field,

such as an e-mail subject field or message body and the Text Control Indicator on the

DragonBar is green.

Resolving problems

If this is the first time you've tried using a supported web application with Dragon, try

restarting your browser and reconnecting to the web application.

If you are using a Web application and browser that support RIA extensions, but the feature

is not active, please see If you have problems using Web application support.

If you can't use Rich Internet Application support, such as if you are using a Web appli-

cation or browser that is not supported, you can still use Dragon to enter text and dictate

commands.

For more information, see Using the Dictation Box, Web browser commands and Dictating

e-mail and Web addresses.

Using Gmail
Use Rich Internet Application (RIA) support when you write and send Gmail messages.
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RIA extensions enable you to use supported Web browsers to dictate content and com-

mands. The feature uses Full Text Control in supported browsers and Web applications to

help you perform common tasks by voice. For example, you can say "Click Inbox," or "Go to

Subject" or "Click Sent Mail." Also see Using Dragon's Web capabilities without RIA.

Before you begin

Before you begin, make sure

n The Gmail Web extension is active. Please see How to tell if Web application support

is active.

n You are logged into your Gmail account and have Gmail open.

n You're using Gmail's latest interface layout. Dragon's Gmail support only works with

the newest Gmail interface and not with Gmail "Classic."

Writing e-mail messages

Use the following steps to write e-mail messages. At any time you can say "Show Site Com-

mands" to display a list of commands.

1. To start a new message, say "Click New" or "Click Compose," as required.

2. Do the following in any order:
n When you're ready to enter the e-mail address you'll be sending to, say

"Go To To" and dictate the e-mail address of the person you'll be sending

the message to.

If you see a list of suggested addresses, choose one from the list by saying

"Choose <n>," where <n> is the number shown for the address you want

to use. If the address is not in the list, continue dictating the address.

n Say "Go To Subject" and dictate your subject text.

n Say "Go To Body" and dictate your message.

3. Click the Send button.

Using commands in Gmail

RIA extensions add the following voice commands to Gmail. See also Editing text in a sup-

ported Web application.

To Say

Open a pop-up window that lists avail-
able commands
To close the pop-up window

"Show Site Commands" or "Show Web Site Com-
mands"
"Hide Site Commands"

View your Inbox "Click Inbox" or "Go To Inbox"

View sent mail "Click Sent Mail" or "Go To Sent Mail"

View mail labeled Important "Click Important" or "Go To Important"
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To Say

View mail labeled Starred "Click Starred" or "Go To Starred"

View draft mail "Click Drafts" or "Go To Drafts"

Compose a new message "Click Compose" or "Compose New Email"

Reply to the current message "Click Reply"
"Click Reply To All"

Place your cursor in the To field "Go To To"

Place your cursor in the Subject field "Go To Subject"

Place your cursor in the Body field "Go To Body"

Select an e-mail address to insert in
the To field when you see the auto-com-
plete field

"Choose <n>" where <n> is the number shown
for the address you want.

Save your message as a draft "Click Save Now" or "Save Message"

Close and delete your message without
saving it

"Click Discard" or "Discard Message"

Print the list of commands "Show Site Commands" or "Show Web Site Com-
mands" and click the Print icon

Using Dragon's Web capabilities without RIA

If RIA extensions aren't available for your Web browser or Web application, you can still

use many of Dragon's features on the Web. For example, you can dictate in any text field,

such as commenting fields in Facebook and instant messaging programs, move around Web

pages, click links, and perform keyword or Web site searches. In Internet Explorer, you also

have Full Text Control without RIA.

When Dragon notices that you are dictating in an unsupported application, it opens the Dic-

tation Box, which also features Full Text Control.

You can also use keyboard commands such as “press Alt d,” “press Enter,” “press tab,”

“press F5,” “page down,” and commands for clicking and dragging the mouse, such as

“MouseGrid 3,” “mouse right-click.”

For more information about Dragon's Web capabilities, see Working with a Web browser.

Using Hotmail
Use Rich Internet Application (RIA) support when you write and send e-mail with Hot-

mail.
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RIA extensions enable you to use supported Web browsers to dictate content and com-

mands. The feature uses Full Text Control in supported browsers and Web applications to

help you perform common tasks by voice. For example, you can say "Click Inbox," or "Go to

Subject" or "Click Sent Mail." Also see Using Dragon's Web capabilities without RIA.

Windows Live E-mail

Some Internet service providers rebrand Hotmail as Windows Live E-mail. Dragon's RIA

extensions are also available for those implementations.

Before you begin

Before you begin, make sure

n The Hotmail Web extension is active. Please see How to tell if Web application sup-

port is active.

n You are logged into your Hotmail account and have Hotmail open.

Writing e-mail messages

Use the following steps to write e-mail messages. At any time you can say "Show Site Com-

mands" to display a list of commands.

1. To start a new message, say "Click New" or "Click Compose," as required.

2. Do the following in any order:
n When you're ready to enter the e-mail address you'll be sending to, say

"Go To To" and dictate the e-mail address of the person you'll be sending

the message to.

If you see a list of suggested addresses, choose one from the list by saying

"Choose <n>," where <n> is the number shown for the address you want

to use. If the address is not in the list, continue dictating the address.

n Say "Go To Subject" and dictate your subject text.

n Say "Go To Body" and dictate your message.

3. Click the Send button.

Using commands in Hotmail

RIA extensions add the following voice commands to Hotmail. See also Editing text in a sup-

ported Web application.

To Say

Open a pop-up window that lists
available commands
Close the pop-up window

"Show Site Commands" or "Show Web Site Com-
mands"
"Hide Site Commands"

View your Inbox "Click Inbox"

View sent mail "Click Sent"
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To Say

View draft mail "Click Drafts"

View flagged mail "Click Flagged"

View all mail, when filter menu is
active

"Click All"

View unread mail "Click Unread"

View mail from contacts "Click Contacts"

View mail containing social net-
work updates

"Click Social Updates"

View mail from groups and mailing
list subscriptions

"Click Groups"

View mail from businesses and
organizations

"Click Newsletters"

View all uncategorized mail "Click Everything Else"

Compose a new message "Click New"

Reply to the current message "Reply"
"Reply To All"

Place your cursor in the To field "Go To To"

Place your cursor in the Subject
field

"Go To Subject"

Place your cursor in the Body field "Go To Body"

Save your message as a draft "Click Save Draft"

Close and delete your message
without saving it

"Click Cancel"

Print the list of commands "Show Site Commands" or "Show Web Site Com-
mands" and click the Print icon

Using Dragon's Web capabilities without RIA

If RIA extensions aren't available for your Web browser or Web application, you can still

use many of Dragon's features on the Web. For example, you can dictate in any text field,

such as commenting fields in Facebook and instant messaging programs, move around Web

pages, click links, and perform keyword or Web site searches. In Internet Explorer, you also

have Full Text Control without RIA.
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When Dragon notices that you are dictating in an unsupported application, it opens the Dic-

tation Box, which also features Full Text Control.

You can also use keyboard commands such as “press Alt d,” “press Enter,” “press tab,”

“press F5,” “page down,” and commands for clicking and dragging the mouse, such as

“MouseGrid 3,” “mouse right-click.”

For more information about Dragon's Web capabilities, see Working with a Web browser.

Editing text in a supported Web application
Use this topic for examples of how you can edit text in any of the Web applications that

Dragon supports.

In supported browsers, you'll have Full Text Control, so that you can dictate content and use

a broad range of Dragon commands. You'll also be able to navigate between mail fields and

perform common tasks like "Click Inbox" and "Click Compose."
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Editing text

To Say

Delete the last text Dragon entered Scratch That

Correct selected text or the last text Dragon entered Correct That

Spell a word to add it to the vocabulary Spell That

Return the cursor back to where you last placed it in doc-
uments and e-mail messages

Go Back

Correct the previous correction Correct Previous

Correct the next correction Correct Next

Train Dragon about how you pronounce a new word Train That

Hyphenate selected words Compound Selection

Hyphenate a string of words Compound <text> through
<text> (North America)
Compound <text> to <text>
(Outside the U.S. and Can-
ada)

Inserts selected text before the last text that Dragon
entered

Insert Before That

Inserts selected text after the last text that Dragon
entered

Insert After That

Inserts selected text before some text that you quote from
your existing content

Insert Before [text]

Inserts selected text after some text that you quote from
your existing content

Insert After [text]
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Selecting text

To Say

Select text you specify in your document Select <text>

Selects the next text item, such as the next word, line or
paragraph, or the next instance when there are multiple
text matches

Select Again

Selects the previous text item, such as the next word, line
or paragraph, or the next instance when there are multiple
text matches

Select Previous

Selects the next text item, such as the next word, line or
paragraph, or the next instance when there are multiple
text matches

Select Next

Select the last text you dictated Select That

Capitalizing text

To Say

Capitalize the first letter of each word in the last text you
dictated

Cap That

APPLY ALL UPPERCASE All Caps That

apply all lowercase No Caps That

Capitalize the first letter of each word in selected text Cap Selection

Apply all capital letters to text you have selected All Caps Selection

Makes all capital letters lower case in selected text No Caps Selection

Using Dragon's Web capabilities without RIA
If RIA extensions aren't available for your Web browser or Web application, you can still use

many of Dragon's features on the Web. For example, you can dictate in any text field, such as

commenting fields in Facebook and instant messaging programs, move around Web pages,

click links, and perform keyword or Web site searches. In Internet Explorer, you also have

Full Text Control without RIA.

When Dragon notices that you are dictating in an unsupported application, it opens the Dic-

tation Box, which also features Full Text Control.
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You can also use keyboard commands such as “press Alt d,” “press Enter,” “press tab,”

“press F5,” “page down,” and commands for clicking and dragging the mouse, such as

“MouseGrid 3,” “mouse right-click.”

For more information about Dragon's Web capabilities, see Working with a Web browser.

If you have problems using Web
application support
If you're having problems using Dragon with a supported Web application, this list can help

you identify the cause and find a solution.

Is the Web application supported in your browser?

Rich Internet Application (RIA) extensions are available in the following Web browsers and

versions:

n Internet Explorer, version 9 (32-bit mode only)

n Mozilla Firefox, version 12 or later

n Google Chrome, version 16 or later

If you don't have one of these browsers in the version listed, you can still use Dragon's

existing capabilities for commands and dictation on the Web, but you will not have the full

benefit of Web application support.

IMPORTANT

In the specific web applications it supports, the RIA feature adds to Dragon’s usual capabil-

ities in the particular supported Web browser.

Dragon's functionality differs significantly between Web browsers. Please see Working with

a Web browser. For example: In Chrome, you cannot select hyperlinks by name or use com-

mands like “refresh page” and “open new tab”. For these actions, you must use global com-

mands, such as mouse commands or press commands such as “press F5” and “press control

t”.

Enabling the feature

After you install Dragon, and open a supported browser, the browser may prompt you to

enable Dragon's Web application support. Click Yes to turn the feature on. For more infor-

mation, see Enabling Web application support.

After you enable the RIA extensions, restart your browser.

If you use Windows XP

Internet Explorer 9 is not available for Windows XP. To use RIA extensions with Windows

XP, use Firefox or Chrome.

If you use Google Chrome

The feature is not supported when you are in Chrome's Incognito mode.
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Is the feature active?

When you are in a supported Rich Internet Application and the feature is enabled, you'll see

a small apostrophe icon to the left of interface elements that you can click by voice, as

shown here in Gmail:

You'll also know that the feature is enabled if you place your insertion point in a text field,

such as an e-mail subject field or message body and the Text Control Indicator on the

DragonBar is green.

Is your browser extension or plug-in enabled?

Your Dragon installation includes extension and/or plug-in and files that Web browsers use

to provide you with Rich Internet Application support. If you are having trouble, make sure

the RIA plug-in or extension is enabled for the browser you are using. Typically, you can do

this from a Tools or Options menu. After enabling RIA, restart your browser. For details, see

Enabling Web application support.

Be careful when you upgrade!

When you upgrade Firefox, make sure you choose to keep the Dragon RIA extension active

when prompted, or Firefox will automatically disable it. If this happens, you can re-enable it.

If you were running Internet Explorer 8 when you installed Dragon and you upgrade to Inter-

net Explorer 9, you need to install the RIA plug-in and extension files. To do so, go to your

original Dragon installation file (typically this is located on a DVD) and launch setup.exe.

When you see the installation wizard, select the Repair option and click Next.

Could there be an issue with the site?

Changes a site makes to its layout or functionality can cause compatibility problems for

Dragon. We make every effort to keep up with these changes, but if you encounter dif-

ficulties, please contact Dragon NaturallySpeaking Support.
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Are you using a different language?

To use Rich Internet Application (RIA) support, you must set the language of the Web

application to the same language as your the user profile. If your profile is set up in English,

you must have your Web application (Hotmail or Gmail) set up in English. RIA does not

require that your Web browser be in the same language as your profile, but it must be if you

want to use other Web browser commands.

If you want to work in a different language, you can create another user profile with that lan-

guage and load it into Dragon when you need it.

Is the Dictation Box behaving in an unexpected way?

Sometimes the Dictation Box misunderstands the context of what you're working on and it

displays text you didn't dictate, and that you can't edit. This can happen when the focus of

the application you're using is on a field you can't edit and:

n you intentionally open the Dictation Box, or

n you speak into your microphone, prompting the Dictation box to open automatically

For example, if you have your e-mail application open with an item in your message list

selected, the Dictation Box may display the header text of that message.

If this happens, just go to the Dictation Box and say or click "Cancel" to close it.

Are you trying to play back dictation?

To play back dictation in Web applications, please use voice commands such as "Play that

back," "Read that," and "Read selection." In Web applications, Dragon does not support

playback of dictation using menus and buttons.

Playback restricted to the current field

In a Web application like Gmail or Hotmail, playback is limited to the current dictation for

the current field. This means that when you move to another field, you can no longer play

back dictation for previous fields, even if you go back to them.

For example, if you dictate an address in a message's To field and then you go to the Sub-

ject field, you can't play back dictation for the To field. If you return to the To field and dic-

tate another address, you can play back the new dictation but not the original dictation.

Are you working offline?

Offline mode is not supported for working with Web-based documents.

Are you having trouble opening the Correction menu?

Dragon does not currently support the following methods for opening the Correction menu

when working in Web applications

n Using the hot key. By default, this is the Minus key (-)

n Double-clicking on selected text

n Clicking the Correction button on the DragonBar Extras toolbar
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Chapter 9: Working with
Web browsers

This section contains the following topics:

Working with a Web browser 181

Searching the Web by voice 182

Web browser commands 186

Internet Explorer commands 189

Using tabs in Firefox 191

Working with a Web browser
Dragon includes many commands designed specifically for use with Web browsers such as

Internet Explorer, Mozilla Firefox, and Google Chrome that enable you to surf the Web by

voice.

Important: Please keep in mind that Dragon’s capabilities differ significantly among Web

browsers, both in terms of commands and in terms of text control. Note in particular:

n In Firefox and Chrome, there is no Full Text Control outside of Web pages spe-

cifically supported by the Rich Internet Applications feature.

n Dragon has many commands specific to Internet Explorer, including commands to

open list boxes and activate text boxes or check boxes.

n In Chrome, you cannot activate hyperlinks by name.

n For Chrome, Dragon has no commands such as “go to Address bar”, “open new tab”,

“go home”, “refresh page”, etc. However, remember that you can take advantage of

Dragon’s global command capabilities: mouse-related commands (such as “MouseGrid

3 9”, “mouse click”, and “move mouse upper left”) and key-pressing commands (such

as “press Alt d”, “press Enter”, “press control t”, “press tab”, “press F5”, “press

Escape”, “page down”).

The following topics cover various Web-related capabilities:

Web browser commands

Internet Explorer commands
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Using tabs in Firefox

Using Rich Internet Application extensions

In the Dragon Help, see:

Following links and clicking buttons

Specifying Web addresses

Going to text boxes and selecting check boxes and option buttons

Notes

n You cannot select icons on the toolbar, Java ™ or ActiveX ® applets, or items in the

History, Search, or Channels panels by voice.

n The "Enable commands in HTML windows" box must be selected on the Com-

mands tab of the Options dialog box to use Internet Explorer and Firefox commands.

n You can use the same voice commands that you use with Internet Explorer to navi-

gate in other applications that run within an HTML window. This includes Help win-

dows based on HTML, such as this Help topic.

n On some versions of Windows, you can control Internet Explorer menus and dialog

boxes by voice only if the "Voice-enable menus, buttons, and other controls, exclud-

ing" box is selected on the Miscellaneous tab of the Options dialog box.

n On some versions of Windows, Microsoft Active Accessibility should be installed

before using voice commands with Internet Explorer. If Microsoft Active Acces-

sibility is not installed, you must always start Dragon before you start Internet

Explorer. If Internet Explorer is already running, close it, start Dragon, and then

restart Internet Explorer.

Searching the Web by voice
Use the Dragon Voice Shortcuts in this topic to perform the following types of Web

searches:

n Search the Web: Starts a Web search in your default browser. Dragon displays your

search string for editing if needed, and then uses your default search provider to

search the Internet for your search terms. See Search the Web for details.

n Search a specific Web site: Starts a Web search of a specific site in your default

browser. Dragon displays your search string for editing if needed, and then uses your

default search provider to search a specific Web site for your search terms. See

Search a specific Web site for details.

n Search a category on the Web: Starts a Web search of a specific category of infor-

mation in your default browser. Dragon displays your search string for editing if

needed, and then uses your default search provider to search a specific category for

your search terms. See Search a category on the Web for details.
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You can also Search the Web using dates, times, names, or currencies and Directly open a

Web site with Google's "I'm feeling lucky".

Notes

n The option to edit the search string before it is sent to your browser is configurable,

so you can turn it off if you prefer. See Display search text before performing search

for details in the Dragon Help.

n Depending on your Web browser and the complexity of the search, displaying the

results may take a few moments.

n Your Web browser does not have to be open to start a Web search by voice. Dragon

recognizes when you use a voice search command and opens your default browser for

you. See your browser's documentation for information on setting the default browser.

The following table lists the types of Web searches you can perform, the commands that

Dragon supports, examples of how to use the commands, and descriptions of what happens

after you say them.

Search
type Syntax

Example
commands What happens

Search the
Web

Search [the]
Web for
[the] <dic-
tation>

"Search the Web for
Italian restaurants in
Boston"

Optionally, Dragon displays
your search string so that you
can edit the keywords if nec-
essary.
Your default Web browser
opens and displays the results
of a search for the phrase "Ital-
ian restaurants in Boston"
using your default search
engine.

Search a
specific
Web site

Search
<Web site>
for [the]<dic-
tation>

"Search eBay for waf-
fle irons"
or
"Search Yahoo for
movies in Boston"

Optionally, Dragon displays
your search string so that you
can edit the keywords if nec-
essary.
Your default Web browser
opens and displays the results
of searching eBay for the
phrase "waffle irons".
Dragon supports this Web site
searches for the following Web
sites:
About (for about.com)
AltaVista
Amazon
Answers (for answers.com)
AOL
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Search
type Syntax

Example
commands What happens

Ask
Bing
Creative Commons
eBay
Facebook (login required)
Google
IRS
MSN
MySpace
Twitter
Wikipedia
Yahoo!
YouTube

Search a
category on
the Web

Search <cat-
egory> for
<dictation>

"Search video for JFK
inaugural address"

Optionally, displays your
search string so that you can
edit the keywords if nec-
essary.
Your default WDragoneb
browser opens and displays
the results of a search on the
words "JFK inaugural address"
in your default search engine's
video category.
Dragon recognizes the fol-
lowing search categories:
Search (images | pictures |
photos) for <dictation>
Search (video | movies) for
<dictation>
Search (news | events) for
<dictation>
Search (products | shops) for
<dictation>
Search (maps | places) for
<dictation>

Search the
Web using
dates,
times,
names, or
calculations

Search the
Web for
<date, time,
name, or cal-
culations>

Remember to say the
words without pausing.
Also, you can leave out
punctuation and Dragon
adds it for you. For
example, say:

Optionally, Dragon displays
your search string so that you
can edit the keywords if nec-
essary.
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Search
type Syntax

Example
commands What happens

“Search Google for 87
divided by 12”
"Search the Web for
11 o'clock am
November 11 1945"
(Dragon displays the
search terms as "11:00
AM November 11 ,
1945")
"Search the Web for
57 Euros in US dollars"
"Search the Web for
Winston Churchill"

Dragon searches the Web as
requested using your default
browser and search engine.

Directly
open the
top-ranked
Web site
for your
search
term

"Open top
Web site (on
| about | for
) [the] <spe-
cific topic or
Web site>"

"Open top Web site for
University of Kansas"
You can also substitute
"Web page" or "site" for
"Web site"

Optionally, Dragon displays
your search string so that you
can edit the keywords if nec-
essary.
Dragon opens your default
Web browser and displays the
top-ranked page for the phrase
"University of Kansas"

Note:

The "Find a Web site (on | about | for ) [the] <specific topic or Web site>" command has

been removed from Version 12. You can continue to use "Open top Web site (on | about |

for ) [the] <specific topic or Web site>" command.

Using Google's I'm feeling lucky
To find Google's top-ranked Web site for a search term using "I'm feeling
lucky":

1. Open the Google home page, for example, www.google.com.

2. Dictate or type your search terms in the search box.

Enabling or disabling searching the Web by voice

To enable or disable searching the Web by voice, open the Options dialog box, Commands

Taband do one of the following:

Select or deselect the "Enable Web search commands" check box.

The option is enabled by default.
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Web browser commands
Important: Please keep in mind that Dragon’s capabilities differ significantly among Web

browsers, both in terms of commands and in terms of text control. See Working with a Web

browser.

Text in italics represents words or numbers that can change. For demonstrations of how to

use these commands, see the Dragon tutorial.

Starting your browser

To Say

Start Internet Explorer "Start Internet Explorer"
"Start Microsoft Internet Explorer"

Start Mozilla Firefox "Start Firefox"
"Start Mozilla Firefox"

Start Google Chrome "Start Google Chrome"

"Start Chrome"

Instead of "start," you can also say "open," "launch" or "show.

Navigating the Web
Please note that not all of these commands work in all browsers.

To Say

Move the insertion point
to the Address Bar

"Go to Address Bar"
See also New commands for Internet Explorer 9

Go to the Web address in
the Address Bar

"Click Go" or "Go There"

Refresh the current page
from the Web

"Refresh page" or "Reload page"

Click a button The button name or part of the button name. You can also say
"Click" followed by all or part of the button name.
or
"Click <button>," where button represents the text shown on
a button on an HTML window. If there are multiple buttons with
similar names on a page, Dragon displays a number next to
each link that appears. For example, "2." Next, you say the
number of the button you want to click. A vertical red arrow
points to your choice and then Dragon opens the link to open
the associated Web page.
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To Say

Follow a link that is a
word or phrase

"Click" plus the link text or part of the text.
or
"Click <link text>," where link text represents the text shown
on a button on an HTML window.If there are multiple text links
on the page, say the number of the link you want to click, or
say the text for the link. A vertical red arrow highlights your
choice and then Dragon opens the link to open the associated
Web page.

Click on an image that is
a link

Say "Click" and the text that appears when the mouse pointer
moves over the image, for example, "Click Dragon" when
"Dragon" is the text that appears.

Stop loading a Web page "Stop Loading"

Load the previous page in
the history list

"Go Back"

Load the next page in the
history list

"Go Forward"

Load your home page "Go Home"

Open a browser tab in a
new browser window

"Open this in a new window"

Open a currently dis-
played Web page in
another browser tab that
stays in the background

"Open this in a background tab"

Entering text and data

The following commands work only in Internet Explorer:

To Say

Show all places on the
page where you can enter
text

"Click Type Text"
or
"Click Edit Box"

Show all check boxes on
the page and go to the
first one

"Click Check Box"

Show all images on the
page with links

"Click Image"
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To Say

Show all option (radio)
buttons on the page

"Click Radio Button"

Show all boxes on the
page with lists of choice

"Click List Box

Show all boxes on the
page with lists of choices
where you can also type in
text.

"Click Combo Box"

Open a list of choices "Show Choices"

Close a list of choices "Hide Choices

Choose an entry from a
list of choices

"Choose <text>," for example, "Choose Hardware Com-
patibility Guide." Saying "Choose" is optional.

Click the selected link,
edit box, or other object.

"Click That

Notes

n If you're using Dragon with Gmail or Hotmail, make sure your browser's

Rich Internet Application support is enabled. A component of Dragon, this

feature gives you important commands as well as Full Text Control in those

Web applications. For more information, see Using Rich Internet Appli-

cation extensions.

n You can use most text selection commands when you work with text that you enter

in a Web form.

n Use the "Choose <n>," "Next Match, "Previous Match," and "Click That" com-

mands listed under Navigating the Web to select among multiple choices.
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Moving around a Web page

To Say

Move the page down by a screen "Page Down"

Move the page up by a screen "Page Up"

Move down to the bottom of the page "Scroll Down"

Move up to the top of the page "Scroll Up"

Move the page down by a few lines of
text

"Line Down"

Move the page up by a few lines of text "Line Up"

Go to the next frame in a multiframe
page

"Next Frame"

Go to the previous frame in a mul-
tiframe page

"Previous Frame"

Go to the next pane in a multipane page "Next Pane"

Go to the previous pane in a multipane
page

"Previous Pane

Display the top of the current page "Go To Top"

Display the bottom of the current page "Go To Bottom"

Start automatic downward scrolling "Start Scrolling Down"

Start automatic upward scrolling "Start Scrolling Up"

Stop automatic scrolling "Stop Scrolling"

Increase the rate of automatic scrolling "Scroll Faster"

Decrease the rate of automatic scroll-
ing

"Scroll Slower"

Internet Explorer commands
The following commands are specific to Internet Explorer 7, 8, and 9. To see lists of Dragon

commands supported in Internet Explorer, open the Dragon Sidebar or Command Browser.

New commands for Internet Explorer 9

Dragon works with Internet Explorer 9 to provide voice support for pinning Web sites or

specific Web pages to the Windows Start menu. Then, when you open the Web site or page
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from there, it displays as a separate browser icon on the Windows taskbar.

To pin a Web site or page to the Start menu

1. Say "Pin this [web] site | page to Start menu." A dialog box displays, where you can

update the address for the Web page to be added.

2. Say or click Add to complete the command.

Internet Explorer 9 supports entering Web search terms in the same box that displays the

Internet address of the page you are viewing. The box is called the One Box or Address

Bar.

To move the cursor to the One Box

n Say "go to the One Box."

Notes

Home button and Home menu

Internet Explorer 9 has both a Home button , which displays in the top-right corner of

the browser window, and a separate Home menu, available from the Command bar as

shown here:

If both are displayed, Dragon usually recognizes the Home button when you say the

"Home" command.

Tools menus

Internet Explorer 9 has a main Tools menu, which displays when you click the cog icon in

the top-right corner of the browser window, and a secondary Tools menu on the Command

bar, shown here:

If both are displayed, Dragon usually opens the main Tools menu when you say the "Tools"

command.

Using tabs

n open new tab

n open last tab

n open next tab

n open previous tab

n close tab

n switch to the last tab

n switch to the next tab
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n switch to the previous tab

n view the next tab

n view the last tab

n view the previous tab

n view the [nth] tab

(can use the numbers one to eight)

Using Quick tabs

n display quick tabs

n hide quick tabs

n unhide quick tabs

n open quick tabs

n show quick tabs

n turn quick tabs on

n turn quick tabs off

n view quick tabs

Using feeds

n open feeds

n close feeds

n show feeds

n display feeds

n view feeds

n hide feeds

n unhide feeds

n toggle feeds

n switch to feeds

Using tabs in Firefox
The following commands are specific to Mozilla Firefox. To see lists of Dragon commands

supported in Firefox, open the Dragon Sidebar or Command Browser.

Using tabs

n add a new tab

n open a new tab

n click the next tab

n click the previous tab

n goto to the next tab
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n goto the previous tab

n close tab
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Chapter 10: Working on
Your Desktop

This section contains the following topics:

Starting and exiting programs 193

Using WindowsDesktop commands 195

Controlling menus 197

Selecting buttons and dialog box options 198

Selecting tabs in a dialog box 199

Resizing and closing windows 199

Selecting and opening icons 200

Scrolling in windows and lists 200

Searching your Desktop by voice 201

Switching between programs and windows 202

Starting and exiting programs
Use the following voice commands to start programs that appear anywhere on your Start

menu or your Desktop.

Attention

The "Start <program name>" command can be turned off to reduce computer memory use

and eliminate misrecognitions of dictation as commands. See Enable launching from the Start

menu in the Dragon Help.

To start a program

Say "Start" followed by the program name.

Instead of "start," you can also say "open," "launch" or "show." For example, say "open Note-

pad."

Shorter names for popular programs

For the popular Windows programs listed here, you can use shorter program names in addi-

tion to the standard program label shown on the Start menu or under the program icon on the

Desktop. For other programs you'll need to say the standard program label.
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n MS Word, Microsoft Word, Microsoft Office Word

n MS Excel, Microsoft Excel

n MS Outlook, Microsoft Outlook

n Outlook Express

n MS PowerPoint, Microsoft PowerPoint

n MS Access, Microsoft Access

n MS InfoPath, Microsoft InfoPath

n Internet Explorer, Microsoft Internet Explorer

n Firefox, Mozilla Firefox

n Chrome, Google Chrome

n Corel WordPerfect, WordPerfect

n Acrobat Reader

n Lotus Notes

Examples:

Say "Start Microsoft Word"

Or

Say "Start Acrobat Reader"

Notes

You can also start your standard desktop email client by saying "Start Mail." See Working

in e-mail programs for details.

To start any other programs

To start other Windows desktop programs, you need to know the name of the program

shortcut or icon. Say "start" and then the text on the program icon label.

Examples:

Microsoft Visual Basic, listed in Windows like this:

Say "Start Microsoft Visual Basic 2008 Express Edition"

OR

Adobe Acrobat Pro, listed in Windows like this:

Say "Start Adobe Acrobat 9 Pro"

Tip

To simplify start commands or to run programs using names of your choice, you can rename

Desktop icons or create new Windows Shortcuts. See your Windows documentation for

details.
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To exit a program

With any window that has the active focus on your screen, say "Close Window," or say

"Click Close"

Notes

n To access some built-in items on the main section of the Windows Start menu, includ-

ing Shut Down, Help, Run, and the Favorites, Find, and Settings menus, you must say

"Click Start" or "Click Start Menu" and then say the menu names you want until you

reach the program. For example, to start the Find Files or Folders tool, say "Click

Start" and then "Find Files or Folders."

n In some versions of Windows you must close any open applications before you can

use the voice command "Shut Down Windows" to exit Windows.

n On some versions of Windows, you can control Internet Explorer menus and dialog

boxes by voice only if the "Voice-enable menus, buttons, and other controls, exclud-

ing" box is selected on the Miscellaneous tab of the Options dialog box.

n To use Dragon to operate Windows menus and dialog box controls by voice, the

option Voice enable menus, buttons and other controls must remain enabled in the

Miscellaneous tab of the Options dialog box. The setting ensures that the Windows

Active Accessibility feature allows voice control of Windows menus and controls.

This option is turned on by default.

Using Windows Desktop commands
You can use voice commands to perform many actions on the Windows Desktop, as shown

in the table below.

Notes

n Instead of dictating the verb "open," you can also say "start," "launch" or "show." For

example, say "start Notepad."

n For details about how to say program names, see Starting and exiting programs.

n See About the Command Browser for more variants of all commands listed here and

see Creating new commands in the Dragon Help for information about how to create

your own commands.

n Items in square brackets are optional.

To do this You can say

Open Windows special folders

Open your My Computer window "Open My Computer"

Open your My Documents folder "Open My Documents"

Open your My Pictures folder "Open My Pictures"
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To do this You can say

Open your My Music folder "Open My Music"

Open your My Videos folder "Open My Videos"

Start applications and utilities

Start a program by name "Open <program name>"

Note: This command can be turned off to reduce computer memory use and eliminate mis-
recognitions of dictation as commands. See Enable launching from the Start menu in the
Dragon Help.

Open Windows Explorer "Open Windows Explorer"

Open Windows Help and Support
Center

"Open Windows Help"

Open the Windows Task Manager "Open Task Manager"

Open the Windows Run dialog box "Open Run dialog"

Open the Windows System Con-
figuration Utility (msconfig)

"Open System Configuration Utility"

Open the Windows Control Panel "Open Control Panel"

Open the Windows Print Manager "Open Print Manager"

Add a printer to your Windows
system

"Add a new printer"

Add or remove programs to your
Windows system

"Open Add or Remove Programs window"

Change the Windows Display Set-
tings

"Change Display Settings"

Change the Windows screen res-
olution

"Change screen resolution"

Change Windows Power Settings "Change power settings"

Navigate between windows

Switch between windows "List programs" or "List all windows" or "List windows
for Dragon" and then "Choose n," where n is the number
of the window you want to switch to. For example, say
"Choose 2"
OR
"Switch to previous window"

OR
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To do this You can say

"Switch to next window."

Switch to a specific program or
document

"Switch to <program name>" For example, say
"Switch to Microsoft Word"
OR
"Switch to <document name>"

OR
"List windows for <program name>" See Switching

between programs and windows

Work with windows

Enlarge the active window to the
size of your monitor's screen

"Maximize window"

Minimize the active window "Minimize window"

Close the active window "Close window"

Minimize all windows and display
the Windows Desktop

"Show Desktop"
"Minimize [all] windows"

Return a maximized window to its
original size

"Restore window"

Restore all minimized windows "Restore [all] windows"

Controlling menus
You can open, close, and choose items from the menus in most programs by voice. To con-

trol the menus in a window, the window must be active.

To open a menu

Say one of the following:

"Click" followed by the name of the menu.

Just say the menu name.

Example:

"Click File" or "File"

Dragon's default setting is to require that you say "Click" to select menus and controls. See

Require "Click" to select menus in the Dragon Help.

To choose an item from an open menu

Just say the item (you can still say "Click" but Dragon doesn't need you to).
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Example:

If the File menu is open, say "New"

To close a menu

Say "Cancel"

Notes

n Say "Click Start Menu" or "Click Start" to open the Start menu. You must say "Click"

to open the Start menu. By default, you must say "Click" before the name of menus

in commands. To change the setting, see Require "Click" to select menus in the

Dragon Help.

n Saying "Cancel" is equivalent to pressing the ESC key.

n In some versions of Windows, a feature called Active Accessibility allows you to con-

trol certain windows menus and controls by voice. If your version of Windows sup-

ports Active Accessibility, the "Voice-enable menus, buttons, and other controls,

excluding" option on the Miscellaneous tab of the Options dialog box must be on in

order to use voice commands to control menus. When you first install Dragon, this

option is on by default.

n When using Microsoft Office XP applications running on the Microsoft Windows

XP operating system you may not be able to control certain menu items by voice if

those menu items have changed their position as a result of an automatically expand-

ing menu. If you need voice control of menu items at all times, then you can turn off

the expanding menu feature in the Customize dialog box of the Microsoft Office XP

application you are using. Open the Customize dialog box from the Toolbars sub-

menu of the View menu. In the Options tab of the Customize dialog box, select the

"Always show full menus" option.

Selecting buttons and dialog box options
You can select buttons and dialog box options by voice.

The dialog box must be the active window.

To select a button or option

Say "Click" followed by the name of the button or option, as it appears in the window, or

just say the name.

Saying "Click" before the name of the button or option is optional. If you want to require it,

for example, to improve recognition accuracy of commands over dictation, you can specify

that "Click" must be spoken on the Commands tab of the Options dialog box.

Example

To change the measurement units in a Microsoft Word document:

n say "Click Office Button"

n say "Click Word Options" (to open the Microsoft Word Options dialog box)
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n say "Click Advanced" (to open the Advanced tab)

n scroll down to Display > Show measurements in units of: <choose one option>

n say "Click OK" (to accept the new measurement unit and close the Options dialog

box.)

To open a list

If the list is selected (the item displayed is highlighted), say "Expand List" or "Drop List." If

the list is not selected say the name of the list. To open the next list, say "Press Tab" and

then either "Expand List" or "Drop List."

To click the Close or OK buttons

Say "Close" or "Click Close," "OK" or "Click OK."

Notes

n You cannot say the following items: file names in dialog boxes, folder names in dialog

boxes, names of items within list boxes, and toolbar icons.

n On some versions of Windows, you can control Internet Explorer menus and dialog

boxes by voice only if the "Voice-enable menus, buttons, and other controls, exclud-

ing" box is selected on the Miscellaneous tab of the Options dialog box.

Selecting tabs in a dialog box
You can select tabs on a tabbed dialog box (such as the Options dialog box in Dragon) in the

following manner:

To Say

Select the next tab "Move to Next Tab"
"Go to Next Tab"
"Click Next Tab"

Select the previous tab "Move to Previous Tab"
"Go to Previous Tab"
"Click Previous Tab"

Note

If the tab has a caption with a shortcut key (underlined character) you can say "Click" fol-

lowed by the name of the tab.

Resizing and closing windows
You can resize and close windows by voice.
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To resize a window

1. Make the window you want to resize active.

2. Say "Maximize Window," "Minimize Window," or "Restore Window."

To close a window

1. Make the window you want to close active.

2. Say "Close Window."

Note

These commands only work when you are using an English version of your operating sys-

tem. If you have a different version of the operating system, you must say "Click" and the

command used by that system in place of "Maximize," "Minimize," or "Restore."

Selecting and opening icons
You can select icons on the Desktop in the following manner:

To select a desktop icon

1. Point to the Windows desktop and say "Mouse Click" to make the desktop active.

2. Say the name of an icon. For example, "My Documents."

The icon becomes highlighted to indicate that it is selected.

3. To select another icon, say "Move" followed by a direction (Left, Right, Up, or Down)

and the number of icons (up to 20) you want to move. For example, "Move Right 1" or

"Move Up 3."

You can open icons on the desktop in the following manner:

To open a desktop icon (including an application)

1. Point to the Windows desktop and say "Mouse Click" to make the desktop active.

2. Say "Open" and the name of an icon. For example, "Open My Documents."

You can close an open window in the following manner:

To close an open window

1. Point to the open window and say "Mouse Click" to make the window active.

2. Say "Close Window."

Scrolling in windows and lists
With Dragon you can scroll within a window or list in a dialog box.
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To scroll vertically

Make sure the insertion point is in the list of a dialog box and say "Move Down" or "Move

Up" followed by the number of lines (up to 20) you want to scroll. This presses the Up or

Down Arrow key the number of times you specify. You can also say "Page Up" or "Page

Down" to press the Page Up or Page Down key.

Examples:

"Move Up 10"

"Move Down 4"

"Page Up"

To scroll horizontally

If the list or window has a horizontal scroll bar, make sure the insertion point is in the list

or dialog box and say "Move Left" or "Move Right" followed by a number up to 20. This

presses the Left or Right arrow keys the number of times you specify.

Examples:

"Move Left 10"

"Move Right 5"

Note

You can use these commands to scroll Help windows by voice.

Searching your Desktop by voice
Use the Dragon Voice Shortcuts in this topic to search your Desktop by voice.

The search commands require that you have third-party indexing/search software installed.

Dragon supports the following search software:

n Google Desktop

n Windows Vista search

n Windows 7 search

The following table lists the types of Desktop commands that Dragon supports, an example

command, and a description of what happens after you say the command:
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Command
Type Syntax

Example
command What happens

Search your com-
puter

search [the]
computer for
[the] <dic-
tation>

"Search the
computer for
budget spread-
sheets"

The search engine displays all
indexed items with the keywords
"budget spreadsheets".

Search e-mail search e-mail
for [the] <dic-
tation>

"Search e-
mail for the
budget"

The search engine displays all
indexed email with the keyword
"budget "
Note: You can use the terms e-
mail, mail, or message inter-
changeably.

Find the top-
ranked email

find [an] email
(about | on)
[the] <dic-
tation>

"Find an
email about
the vacation
schedule"

The search engine displays the
top-ranked email for the keyword
"vacation schedule".

Search documents search [the]
(documents |
files) for [the]
<dictation>

"Search doc-
uments for
budget"

The search engine displays all
indexed documents with the key-
word "budget".
Note: You can use the terms doc-
uments and files interchangeably.

Search your Web
history, favorites,
or bookmarks

search [the]
<category> for
[the] <dic-
tation>

"Search the
Web history
for the budget
forecast"

The search engine displays search
results containing all pages from
your Web history that use the key-
word "budget".
Valid search categories are:
- favorites
- bookmarks
- Web history

Enabling or disabling searching the Desktop by voice

To enable or disable searching the Desktop by voice, open the Commands tab of the

Options dialog box and do one of the following:

Select or deselect the "Enable Desktop search commands" check box.

The option is enabled by default.

Switching between programs and windows
Use this procedure to do any of the following:

n List and switch between open programs or windows.

n List and switch between windows of multi-document applications.
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n List and switch between open Dragon windows.

Note

You can use this command to switch to your Web browser, but this command does not list

open tabs in your web browser. For information on browser tabs, see Working with a Web

Browser.

To switch between open programs or windows

1. Do any of the following:

To list all open programs, say "List Programs" or "List all windows." The List of Open

Applications window opens. For example,

Or

To list open windows of multi-document applications, say "List windows for <program

name>" For example, say "List windows for Microsoft Word" The List of Windows opens.

For example,
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To list all open Dragon windows, say "List windows for Dragon" or "List Dragon win-

dows". The list of Dragon windows opens. For example,

For information about dictating program names, see Starting and exiting programs.

2. To switch to an open program or window:

Say "Choose n," where n is the number of the program or window you want to switch

to, or just say the number next to the word. For example, say "Choose 2" or "2"

OR

Choose the number of the program or window from the list and click OK.
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Chapter 11: Controlling the
Mouse and Keyboard

This section contains the following topics:

Controlling the keyboard 205

Moving the mouse pointer 207

Positioning the mouse pointer withMouseGrid 208

Clicking and dragging the mouse 209

Controlling the keyboard
When Dragon is running, you can control the keyboard by voice.

Say Then say

"Press" "Tab"

"Press
Key"

"Backspace"
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Say Then say

"Type" "Caps Lock"

"Enter"

"Escape"

"Space Bar"

"Print Screen"

"Scroll Lock"

"Pause"

"Num Lock"

"Up Arrow"

"Down Arrow"

"Right Arrow"

"Left Arrow"

"Home"

"End"

"Page Up"

"Page Down"

"Insert"

"Delete"

"Function 1" to "Function 12"

"Keypad" followed by any numeric keypad key: 0...9, ., /, *, -, +, Enter).

"Shift," "Control," or "Alt" (alone or in combination) followed by any other
key.

Notes

n You can say "Press" or "Type" followed by any combination of modifier keys (Shift,

Control, Alt), and then any letter, number, symbol, arrow key, and so on.

n You can say "Press Tab" to move around a dialog box or a list and "Press Enter" to

select items.
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n You cannot undo a keystroke by saying "Scratch That." For example, if you say "Press

Cap A" then "Scratch That," "A" remains in the document. You can, however, say

"Undo That."

Moving the mouse pointer
You can move the mouse pointer up, down, left, or right using the mouse pointer com-

mands.

Click here for Dragon's Top 5s: Mouse and keyboard

Move commands

The following commands are always available and can move the pointer a short distance (up

to 10 units):

Say Then say Then say

"Mouse" "Up"
"Down"
"Left"
"Right"

"<1—10>"

Examples:

"Mouse Down Two"

"Mouse Right Eight"

Optional move commands

You can use the following movement commands if the "Enable mouse motion commands"

box on the Commands tab of the Options dialog box is selected.

Say Then a direction Then a speed (optional)

"Move Mouse" or "Up" "Faster"

"Mouse Move" "Down" "Very Fast"

"Left" "Much Faster"

"Right" "Slower"

"Upper Left" "Very Slow"

"Lower Left" "Much Slower"

"Upper Right"

"Lower Right"
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You can say a speed command at any time while the pointer is moving to speed the move-

ment up or slow it down.

Examples:

"Move Mouse Down Faster"

"Mouse Move Lower Right Very Fast"

"Mouse Move Up Very Fast (pause) Slower (pause) Stop"

Stopping mouse movement

While the mouse pointer is moving, you can stop the movement by saying one of the fol-

lowing commands:

n "Stop"

n "Cancel"

Notes

n You can combine moving the mouse pointer with clicking the mouse or marking and

dragging the object in a single voice command.

n You can disable the mouse motion commands by clearing the check box "Enable

mouse motion commands" on the Commands tab of the Options dialog box.

n The default mouse motion speed is 2 (on a scale from 1 to 25). You can change the

default speed by clicking the Speed button on the Commands tab of the Options

dialog box and selecting a new speed.

Positioning the mouse pointer with MouseGrid
You can position the mouse pointer anywhere on the screen using MouseGrid. The move-

ment can be relative to the full screen or the active window.

To position the pointer with MouseGrid

1. Say "MouseGrid" to place the MouseGrid over the full screen or say "MouseGrid Win-

dow" to place it over the active window.

MouseGrid divides the screen or window into nine numbered areas.

2. Say the number (from 1 to 9) to position the pointer in that numbered area. To position

it again, say another number.

You can pause slightly after each number you say.

Examples:

"MouseGrid 3 2 5"

"MouseGrid Window 7 8"
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Notes

n To have MouseGrid close automatically, end the MouseGrid command with "Go."

For example, say "MouseGrid 5 3 Go."

n To undo the last MouseGrid action, say "Undo That."

n To close MouseGrid, say "Cancel."

n MouseGrid will close when the microphone is turned off, or when you say the com-

mand "Go To Sleep."

n You can combine the MouseGrid command with clicking the mouse or marking and

dragging the object in a single voice command. For example, you can say "MouseGrid

5 3 Double-Click."

Clicking and dragging the mouse
You can click and drag the mouse by voice.

Click here for Dragon's Top 5s: Mouse and keyboard

Clicking the mouse

Say Then say Then say

"Mouse" "Click" –

"Double-Click" –

"Right-Click" –

"Left-Click" –

"Press" or "Type" "Shift" "Right Click"

"Left Click"

"Control" "Right Click"

"Left Click"

Examples:

"Mouse Double-Click"

"Mouse Right-Click"

"Press Shift Right Click"

"Type Control Left Click"

Dragging the mouse
You can use the following movement commands if you select the Enable mouse motion com-
mands check box on the Commands tab of the Options dialog box.
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Say Then a direction Then a speed (optional)

"Drag Mouse" (to move) "Up" "Faster"

"Mouse Drag" (to move) "Down" "Very Fast"

"Control Mouse Drag" (to copy)
or
"Control Drag Mouse"

"Right" "Much Faster"

"Left" "Slower"

"Upper Right" "Very Slow"

"Upper Left" "Much Slower"

"Lower Right"

"Lower Left"

You can say a speed command at any time while the pointer is moving to speed the move-

ment up or slow it down.

Examples:

"Drag Mouse Down Faster"

"Mouse Drag Lower Right Very Fast"

"Mouse Drag Up Very Fast (pause) Slower (pause) Stop"

"Shift Drag Mouse Up"

Stopping mouse movement

While the mouse pointer is moving, you can stop the movement by saying one of the fol-

lowing commands:

n "Stop"

n "Cancel"

Notes

n You can combine dragging the mouse pointer and clicking the mouse. For example,

to open an application from the Desktop, you can say "Mouse Drag Lower Left" and

when the Desktop icon is selected, say "Double-Click."

n You can disable the mouse motion commands by clearing the check box "Enable

mouse motion commands" on the Commands tab of the Options dialog box.
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Chapter 12: Improving
recognition accuracy

There are many things you can do to improve recognition accuracy.

n Positioning the microphone correctly

n Speaking clearly and continuously

n Run the Accuracy Assistant

n Run the Acoustic Optimizer

n Use recognition modes

n Train misrecognized commands

n Train individual words and phrases

n Run General Training again

n Run the Let Dragon search for words tool

n Personalize your Vocabulary

Top 10 ways to improve accuracy
Here's our top 10 list of ways to optimize Dragon's ability to recognize your speech.

1. Use careful dictation practices Dictating with Dragon is different than talking to some-

one. When we talk, we often hesitate, mumble, slur words, or leave words out altogether,

but we're still able to understand each other. And people can easily filter out noise, which

lets us understand each other, even in noisy environments, like restaurants, but speech

software needs help separating dictation from other sounds. With dictation, the idea is to

speak in a consistent speed and volume - try not to hesitate, exaggerate your pro-

nunciation, or talk loudly or slowly. So make sure background noise doesn't drown you

out and that you have the microphone close enough for Dragon to hear you properly,

usually about an inch from your mouth and to one side. Also, remember to dictate using

complete phrases, so that Dragon gets the context. For example, we use our experience

and common sense to decide whether someone said "I Scream," or "Ice Cream." But

Dragon doesn't understand what words mean, so it can't use common sense the way we
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do. Instead, Dragon interprets your speech by using its knowledge of words that tend to

appear together. Dragon calculates how frequently you use words and phrases and can

offer you suggestions when it makes mistakes. Try to think about your whole phrase or

sentence before you start dictate it, and you'll be on your way to dictation mastery. For

more information, see Dictation Basics.

2. Import lists of words or phrases Rather than adding words or phrases one at a time,

you can import one or more lists. The lists can even include spoken forms. This method

can be particularly useful for businesses that have a lot of people dictating similar names

or words or if you need to use more than one user profile. For more information, see Pre-

paring a list of custom words to add to a Vocabulary.

3. Learn from specific documents You can select specific documents or entire folders

containing typical documents, your own or those of others, that reflect the type of dic-

tation you will typically do. You can then train Dragon how you pronounce unusual

words or about proper names you need to dictate. For example, if you were an academic

and ran the tool to add words from essays and articles in your field of study, or a blogger

using a lot of new acronyms, Dragon would automatically learn your words, word

frequency and contexts, and make better guesses about your speech. Dragon also moves

words from its backup dictionary to its active vocabulary based on the scan. If there are a

lot of words to train, you'll need to plan this activity when you have a few minutes to

spend adding the words.

4. Learn from sent e-mails Similar to Learn from specific documents, this tool helps

refine your profile by analyzing representative text, only in this case it analyzes e-mail

messages sent from your installed email program. In addition to analyzing frequency of

word use and typical word sequences, it can suggest contact names you may want to add

to the vocabulary. Note: For the first run, plan this activity when you can let Dragon use

your computer for 5 to 30 minutes. Subsequent scans build on the first one, however,

and are much faster.

5. Run Accuracy Tuning This process refines your user profile by analyzing audio and

text data that Dragon archives from your dictation. You can launch Accuracy Tuning

from the DragonBar Audio menu or schedule it to run later. Choose a time when your

computer is on but you can close Dragon – for example, when you typically have a meal

or a meeting.

6. Perform additional training Dragon learns about how you pronounce words and your

vocal tones when you create your user profile, but it can learn more if you read one or

more of the supplied training texts. If you skipped the General Training step when you

created your profile, we recommend that you read a training text after a few hours of

using Dragon. On the DragonBar, select Audio > Read Text to Improve Accuracy.

7. Turn off what you don't use Visit the Performance Assistant for useful strategies for

optimizing accuracy and speed with Dragon. For example, you can turn off the ability to

"voice-click" menus, buttons and other controls in some or all programs, or the ability to

open items from the Windows Start menu or desktop. Turning off these options reduces

Dragon's use of computer resources and reduces the possibility of isolated words or

phrases being executed as commands, such as "Click Send" or "Open Network."

8. Use Smart Format Rules to have Dragon recognize when you change a custom or

built-in auto-formatting option or word property for alphanumeric text or a word. Dragon
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automatically applies formatting to many common spoken forms of text, such as Web and

e-mail addresses, street addresses, dates, numbers, units of measure, and so on. The Smart

Format Rules feature recognizes your changes to rules and offers to customize the settings

to suit your needs as you work. You can also add custom word properties to words to

make Dragon's text entry more intuitive and efficient. By setting word properties, you

specify a variety of options that can be associated with vocabulary entries. You can specify

that a word be preceded or followed by specific characters and customize properties for

placement or handling. For example, question marks and exclamation marks have default

properties of "Precede by (nothing)" and "Format the next word capitalized."

Or, you can specify one or more for words. If the Use Alternate Written Form checkbox

is selected for "meter," when you dictate the word after a number Dragon enters only "m."

For example, of the Alternate Written Form checkbox is not selected, and you dictate

"meter," Dragon types the full word, "meter."

9. Make corrections You can prevent many errors using the methods listed above, but if an

error does happen, correcting it will help Dragon to learn. Redictating or retyping words

or phrases are sometimes the fastest approach, but Dragon provides a lot of flexibility

about how and when you correct errors.

10. Save your user profile Remember that as Dragon works on your documents with you, it

needs to save what it learns. Whenever you correct dictation with the keyboard, train

words, or perform any of the other accuracy optimization operations, you must to save

your user profile to save your changes for your next dictation session.

Using Smart Format Rules
Smart Format Rules may display when Dragon notices that you corrected dictated text cor-

responding to an Auto-Formatting option or Word Property.

Through this optional feature, Dragon displays reaches out to offer one or more adjustments

to its settings.

When Dragon presents a Smart Format Rules box, you can choose one of the adjustments it

offers. Or you can just ignore the dialog box and continue working, or say “cancel” and the

box will close.

Here is an example of the Smart Format Rule for units of measure that appears if you change

the standard abbreviation for kilograms, which is kg:

What to do when a Smart Format Rules box displays

When Dragon displays a Smart Format Rule, you can usually do any of the following:
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n If you don't want Dragon to auto-format the text using this rule now and in future

dictation, say choose 1 - Never <apply rule>, where apply rule represents the auto-for-

matting rule you changed with your dictation.

n If you want Dragon to use the same auto-formatting setting the next time you dictate

it and in the future, say choose 2 - Always <apply rule>.

n If you don’t want to adjust any rule, ignore this box. It will go away when you con-

tinue dictating or working in your document. You can also say “Cancel” to dismiss

the box.

For Smart Format Rules about entering zeros rather than the word "million," for numbers

greater than or equal to 10, and for word properties, the choices are slightly different. The

Smart Format Rules display the applicable choices in those cases. For details and examples,

see Options controlled by Smart Format Rules below.

When the Smart Format Rules box display

The Smart Format Rules box displays when you edit auto-formatted text using

n the Correction menu

n the Spelling window

or

n the keyboard.

Showing the last Smart Format Rule

If a Smart Format Rules box displays and you continue dictating or cancel it accidentally,

you can redisplay it by saying the command "Show Smart Format Rule." Previously

accepted rules can not be displayed.

Disabling Smart Format Rules

If you want to turn off the Smart Format Rules feature,

1. Select Tools menu > Options from the DragonBar. For example, say "Switch to Drag-

onBar," then "Click Tools," then "Options."

2. On the Options dialog box, Correction tab, say "click Show Smart Format Rules" to clear

the checkmark beside the option.

3. Say "Click OK" to close the dialog box and apply your changes.

Restoring a Smart Format Rule

You can restore a default in the Auto-formatting dialog box or Word Properties dialog box.

Another way to restore a setting: correct the text to the format you want and pick the cor-

responding rule from the Smart Format Rules box that your correction triggered.

Options controlled by Smart Format Rules

Auto-formatting Web and e-mail addresses

Turns on automatic e-mail and Web address formatting, so that you can dictate them as

you would normally say them out loud. For example, if you say "jane dot smith at my

adventure travel dot com" Dragon enters "Jane.Smith@myadventuretravel.com." Dragon
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substitutes the @ sign for the spoken "at," uses a period for "dot," and omits spaces. Or if

you say "www dot nuance dot com," Dragon enters www.nuance.com.

Auto-formatting street addresses

Turns on automatic formatting of postal addresses. For example, if you say "49 orchard

lane boston massachusetts oh two four four six," Dragon enters "49 Orchard Lane, Bos-

ton, MA 02446."

Certain addresses can be hard for Dragon to interpret. For example, "Two Hundred Forty

Fifth Street" could be interpreted as 245th Street, 200 45th Street, or 240 5th Street. In a

situation like this, Dragon uses context to try to determine what you meant. In some

cases, using the word "And" can help to narrow down the choices. In the example above,

saying "Two Hundred And Forty Fifth Street" would eliminate 200 45th Street as a pos-

sibility.

For user profiles whose region setting is UK or Canada: This option also enables the

proper formatting of UK postcodes and Canadian postal codes. For example, you could

format a postcode for London by saying "W Two Four R J" to enter W2 4RJ, and format a

postal code for Toronto by saying "M Five H Two L Two" to enter M5H 2L2."

See Choose your region and vocabulary in the Dragon Help.

For user profiles whose region setting is United States: If you are using a U.S. Eng-
lish user profile, you can enable UK postcodes and Canadian postal codes from the UK
and Canadian postcodes option in this dialog box.

See Choose your region and vocabulary in the Dragon Help.

Auto-formatting titles

Inserts abbreviated versions of any title in Dragon's Abbreviated titles list. For example,

"Mr." for "Mister," or "Pres." for "President."

Auto-formatting dates

Controls how Dragon formats dates when you dictate the day, month, and year together. 

Use the drop-down button to select the format you want to use most often. Available for-

mats are:

n Dates As Spoken

n Month D, YYYY

n Month DD, YYYY

n Mon D, YYYY

n Mon DD, YYYY

n M/D/YYYY

n M/D/YY

n MM/DD/YYYY
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n MM/DD/YY

n MM-DD-YY

n DMonth, YYYY

n D/M/YYYY

n D/M/YY

n DD/MM/YYYY

n DD/MM/YY

n DD-Mon-YY

n YYYY-MM-DD

NOTES

n If you clear the "Dates" checkbox, Dragon will not apply automatic date for-

matting. For example, after clearing the checkbox, if you dictate "July twenty sev-

enth," Dragon will write "July 27th."

By default, Dragon does not use the numeral form of numbers smaller than 10,

whether for cardinal numbers (one, two, three...) or ordinal numbers (first, sec-

ond, third...). If the "Dates" checkbox is cleared, Dragon writes "the 10th of

June" and "the seventh of June" unless you change the default setting "Numbers,

if greater or equal to" on the Auto-Formatting Options dialog box.

n If you use the "Dates As Spoken" setting, Dragon needs you to dictate dates in an

unambiguous way, using the name and not the digit for the month. For example,

with "Dates As Spoken" selected, Dragon will correctly format "January eleven

two thousand nine" and "the seventh of February two thousand four" using date

formats, but will format "eleven one two thousand nine" as a number.

If you dictate dates differently, for example you use digits to say the month, try

selecting the value that best matches how you dictate the date. For example, if

you normally say "eleven one two thousand nine", setting the date format to

"D/M/YYYY" will cause Dragon to correctly transcribe the date.

n If you omit the year, for example, you say "July twelve", Dragon transcribes "July

12" ("The twelfth of July" becomes "12 July") regardless of which date formatting

you select.

Auto-formatting common abbreviations

Enables Dragon to recognize most standard abbreviations while transcribing your dic-

tation. For example, Dragon would rewrite "versus" as "vs.", "Institute" as "Inst.", and

"Department" as "Dept." For more information about dictating abbreviations, see Dic-

tating abbreviations and acronyms.

Auto-formatting contractions

Enable this option if you want Dragon to expand contractions when you dictate them.
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For example, if you say "Don't go near the water", Dragon transcribes "Do not go near the

water".

If you leave this option turned off, Dragon enters contractions the way you dictate them.

Note: In some situations, the formal expression of a contraction may be ambiguous. For

example, the phrase "It's always" could either mean "It is always" or "It has always,"

depending on the tense of the verb that follows. In this situation, Dragon always expands

the contraction, regardless of how this option is set.

Auto-formatting “ million” instead of ” ,000,000”

Enable this option to have Dragon enter the word "million" rather than zeros and commas

(",000,000") when you dictate round numbers in the millions. For example, Dragon

enters "8 million" rather than "8,000,000."

If a number in the millions range is not rounded to the nearest million, Dragon enters the

number as digits. For example, if you dictate "eight million one hundred thousand"

Dragon enters "8,100,000".

Auto-formatting numbers, if greater than or equal to

Enters numbers as numerals if they are equal to or greater than the value shown in the

drop-down list. If the number is less than the chosen value, the number is spelled out.

For example, using the value of "10", Dragon will write "five" when you dictate "five" and

"11" when you dictate "eleven".

The available values are:

n 0

n 2

n 10

n 100

Note: You can also use Dragon to enter numbers as Arabic or Roman numerals. See Dic-

tation commands.

Auto-formatting units of measure

Turns on automatic formatting of standard units of measure, such as feet and inches. For

example, if you say "Six Foot Three Inches", Dragon enters 6' 3".

If a unit of measure is not formatted in the way you expect, you can also use the Word

Properties dialog box to use an alternate form for that particular unit of measure.

Auto-formatting ISO currency codes

If you have selected the Prices option, then you can select "ISO currency codes" to dis-

play currency amounts with the International Standards Organization currency symbol
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corresponding to the region and language set for your Windows operating system or, if

different, for your user profile (see How region and language affect number and currency

punctuation).

For example, if your profile's region is set to United States and you enable both the

Prices and ISO currency codes Auto-Formatting options, when you dictate "Ten Dol-

lars" Dragon enters "USD10".

Auto-formatting phone numbers

Turns on automatic formatting of telephone numbers.

For U.S. English User Profiles using the United States or Canada for the Region:

Turns on automatic formatting North American telephone numbers when you speak a

sequence of seven or ten numbers. For example, if you say "7815551234", Dragon will

transcribe "781-555-1234". 

NOTES

n Vanity phone numbers such as 1-800-EXAMPLE are not supported.

n The automatic formatting of U.S. telephone numbers is not supported for user

profiles with a UK Region setting.

For User Profiles using the UK for the Region: Turns on automatic formatting of

UK telephone numbers.

NOTES

n Country code +44 can be dictated as "four four", "forty four" or "double four"

with a preceding plus sign. For example, if you say "plus-sign four four two nine

two oh seven four seven seven four seven", Dragon transcribes "+44 29 2074

7747".

n Area codes that are dictated without the preceding country code must be dictated

with a leading zero. For example, if you say "zero two nine two oh eight seven

nine three two seven", Dragon transcribes "029 2087 9327".

n When you dictate a 6-digit number, Dragon transcribes the number with no

spaces. When you dictate a 7-digit or 8-digit number, Dragon transcribes the

number with a space before the last 4 digits.

n The automatic formatting of UK telephone numbers is not supported for U.S. and

Canadian-based user profiles.

Auto-formatting prices

Inserts prices and currencies in the proper format with the appropriate currency symbol.

For example, "$10" instead of "10 dollars", or "€50" instead of "50 euros".

Supported currencies are:
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ISO code Symbol Name

USD $ Dollars
Cents

USD US$ U.S. dollars

CAD C$ Canadian dollars

EUR € Euros

JPY ¥ Yen

GBP £ Pounds Sterling Pence/Penny

CHF F Swiss francs

Auto-formatting times

Turns on automatic formatting of standard time formats. For example, if you say "Six

Thirty PM", Dragon will transcribe "6:30 PM". Dictating standard time runs on a 12 hour

clock, letting you make the distinction between AM and PM.

Military time: With the Time option enabled, you can also dictate times in military format.

For example, if you say "sixteen hundred hours", Dragon transcribes "1600 hrs". If you

say "oh three oh five hours" or "zero three zero five hours", Dragon transcribes "0305

hrs".

Dictating Military time uses a 24-hour clock and abbreviates "hours" to "hrs".

Auto-formatting UK and Canadian postcodes

Turns on proper formatting of UK postcodes and Canadian postal codes. For example,

with the option on, format a London postcode by saying "W Two Four R J" to enter W2

4RJ, and format a Toronto postal code by saying "M Five H Two L Two" to enter M5H

2L2.

Auto-formatting other numbers

Enables the formatting of all numbers not covered by other options on this dialog box,

such as negative numbers, numbers with punctuation, fractions, decimals, and Roman

numerals.

Note: Dragon applies Auto-formatting for mixed numbers and also for fractions where

the denominator is 5 or greater, but not for simple fractions like "one half," "two thirds,"

and "three quarters."

For more information, see Dictating numbers.
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Auto-formatting US social security numbers

Turns on automatic formatting of U.S. Social Security Numbers when you speak a

sequence of 9 numbers. For example, if you say "123456789," Dragon enters "123-45-

6789."

Auto-formatting using Word Properties

Use Word Properties to customize how Dragon enters words or phrases as you dictate

them. Word Properties can add custom spacing before and after, next word cap-

italization, settings for numbers before and after, or apply alternate written forms, such

as abbreviations.

To add or edit Word Properties, see Creating Word Properties.

Note

n If you make a correction that corresponds to an auto-formatting option and a word

property, only the smart format rule prompt for the word property displays.

Adjusting Speed vs. Accuracy
You can increase product speed or, alternatively, increase recognition accuracy by using the

Speed vs. Accuracy slider.

The Speed vs. Accuracy slider lets you control the number of words and phrases that the

program examines in order to find a word match. The more words examined, the greater the

possibility of an accurate match at the expense of using more memory and taking a longer

time to recognize your speech.

Moving the slider can influence the performance of Dragon. Dragging the slider toward

accuracy sometimes increases the accuracy of the matches at the expense of additional time

in transcribing your dictation. Moving the slider to the right normally increases recognition

accuracy but may also slow system performance. As a general rule, you should move the

slider farther to the right on faster machines than on slower ones.

To use the Speed vs. Accuracy slider

1. On the Tools menu of the DragonBar, click Options.

2. In the Options dialog box, click the Miscellaneous tab.

3. Drag the Speed vs. Accuracy slider to tune performance.

4. Test the new setting by using Dragon. If you are not satisfied with the result, try a dif-

ferent setting.

Notes

n Running other programs while Dragon is running will also affect accuracy and speed,

since other programs compete for system resources.

n If you get a "The recognizer has encountered an utterance that is too long to proc-

ess" error, try setting the slider more towards "Fastest Response".

220



Dragon 12 Installation and User Guide

The Dragon Accuracy Center
This section contains the following topics:

Using the Accuracy Center 221

About the Accuracy Assistant 222

Running the Acoustic and Language Model Optimizer 222

Using the Accuracy Center
You can use the Accuracy Center to refine the accuracy of your User Profile or to learn more

about Dragon. For example, you'll find tools or information in the Accuracy Center for the

following kinds of tasks:

n Personalize your Vocabulary

n Adjust your acoustics

n Find or train commands

n Set options and configure formatting

n Find out more about Dragon

To open the Accuracy Center

n say "Open Accuracy Center" or click Help > Improve My Accuracy on the Drag-

onBar.

To use the Accuracy Center

Click or say the first few words of a link to start it.

Accuracy Center options

Click the following link to learn about the specific features of the Accuracy Center:

The Accuracy Center options

Notes

n One feature of the Accuracy Center is the Accuracy Assistant, which helps you deter-

mine which tool in the center to use. The Accuracy Assistant does this by asking a

series of questions and, depending on the answers, provides links to the proper tool.

To open the Accuracy Assistant, first open the Accuracy Center and then click or say

"Which tool should I use?"

n When you start the Accuracy Center option that checks your audio settings, the

Check Microphone wizard starts and the Dragon microphone is automatically turned

off if it is on. This is necessary in order to facilitate the audio tests.
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About the Accuracy Assistant
The Accuracy Assistant is a screen that helps you determine which tool to use to improve

the recognition accuracy on your system. The Accuracy Assistant does this by asking a

series of questions and, depending on the answers, provides links to the proper tool.

To run the Accuracy Assistant

1. Click Help > Improve My Accuracy on the DragonBar.

2. In the Accuracy Center, click or say "Which tool should I use?"

3. In the Accuracy Assistant window, click or say the link that best matches the accuracy

problem you are trying to solve and follow the directions on the screen.

Running the Acoustic and Language Model
Optimizer
Use this procedure to increase Dragon's accuracy with the Acoustic and Language Model

Optimizer.

As you make and train corrections, train new words, use commands, and perform additional

training, Dragon stores the acoustic and language data in an archive and uses it to enhance

recognition accuracy. The Acoustic and Language Model Optimizer accumulates this data

from session to session.

Acoustic Optimization

Perform Acoustic Optimization to update your User Profiles with accumulated acoustic

data from any corrections and additional training you do.

Language Model Optimization

Perform Language Model Optimization to update your language model. The language model

contains statistical information that predicts which words are most likely to occur in the

context of the user’s speech. Language Model Optimization uses text extracted from a

user's .DRA files to add commonly used word sequences to the language model. Based on

the speech data collected, Language Model Optimization may change the language model

you selected when you created your User Profile. For example, Dragon may change Best-

Match III to Inland Northern US (Great Lakes area) - BestMatch III.

Before you begin

n Because it can take up to an hour to incorporate the analyzed data into your User Pro-

file, you may want to schedule the optimization when you are not using your com-

puter. You can schedule optimization using the Acoustic and Language Model

Optimizer Scheduler. If you are part of an organization or company and you do not

have Dragon administrator rights, you can request that your Dragon administrator

schedule optimization.
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n Be sure that the "Store corrections in archive" option is selected on the Data tab of

the Options dialog box. Otherwise you may see a message that there is not enough

data for the Acoustic and Language Model Optimizer to process. The "Store cor-

rections in archive" option should be selected whenever you use Dragon for an

extended period of time.

n If you have a User Profile set to the Correction Only Mode (for example, a tran-

scriptionist), you must disable the Correction Only Mode option on the Miscellaneous

Tab of the Administrative Settings dialog box before running the Acoustic and Lan-

guage Model Optimize on this User Profile.

To run the Acoustic and Language Model Optimizer

1. Say "Switch to DragonBar," then "Audio," then "Launch Accuracy Tuning," or click

Audio > Launch Accuracy Tuning on the DragonBar.

The Acoustic and Language Model Optimizer dialog box opens with Perform Acoustic

Optimization and Perform Language Model Optimization selected. Nuance recommends

that you run both optimizations at the same time to maximize accuracy.

2. Click or say "Go" to start the Acoustic and Language Model Optimizer.

3. The Acoustic and Language Model Optimizer may ask if you want to save your current

User Profile. Click or say "Yes" if you made corrections since the last time you ran the

Acoustic and Language Model Optimizer, or if you have not run the Acoustic and Lan-

guage Model Optimizer since you started using Dragon.

The Acoustic and Language Model Optimizer dialog box shows Dragon's estimate of how

long it will take to finish adapting your User Profile. How long this takes depends on the

amount of Acoustic Data stored in your User Profile.

Notes

n By default, the amount of acoustic data saved is limited to 180 minutes (the max-

imum). You can reduce this amount on the Data tab of the Options dialog box.

n If you attempt to run the Acoustic and Language Model Optimizer before you have

trained any corrections (even if you have corrected errors without training the cor-

rections), or before you have performed any additional training, you will see an error

message saying that there is not enough data for the Acoustic and Language Model

Optimizer to process.

n Training multiple words or phrases rather than training individual words is generally

more effective at increasing accuracy. Most people have a tendency to over enunciate

when saying individual words as opposed to the more normal speech patterns of say-

ing a complete phrase.

n The Acoustic and Language Model Optimizer automatically makes a backup of the old

User Profile before it begins modifying them. Your User Profile is automatically

restored if you click Cancel before the Acoustic and Language Model Optimizer is fin-

ished.
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Recognition Modes
This section contains the following topics:

Using Recognition Modes 224

Switching recognition modes 226

Using Recognition Modes
Dragon allows you to use different Recognition Modes in your dictation. The following

describes ways you can use these modes while you dictate. Click the links to display the

related procedures.

Normal Mode

To dictate and say commands interchangeably

The most flexible mode in Dragon is the default Normal Mode. In Normal Mode, Dragon

distinguishes dictation from commands by analyzing what you say between pauses. For this

reason, you should always pause before and after you say a command.

For example, to bold the word "exciting" in the sentence: "Speech recognition is an exciting

technology".

1. Say "Start Normal Mode" or "Normal Mode On".

"Normal Mode" appears in the status box of the DragonBar.

2. Say "Speech recognition is an exciting technology period"

3. Pause briefly.

4. Say "Select exciting".

5. Pause again.

6. Say "Bold That".

You need to pause only briefly. You can adjust the length of the pause required before

Dragon recognizes commands on the Commands tab of the Options dialog box.

Dictation Mode

To dictate rapidly without looking at your computer monitor

In Dictation Mode, Dragon interprets everything you say as dictation and only Dictation

Commands are recognized. Dictation Mode can be helpful if you want to dictate as quickly

as possible, or dictate without looking at the words Dragon transcribes. Say "Start Dictation

Mode" or "Dictation Mode On."

1. Say "Start Dictation Mode" or "Dictation Mode On".

"Dictation Mode" appears in the status box of the DragonBar.
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2. Dictate a few paragraphs. You can dictate without looking, knowing that everything will

be transposed as text and no commands will be executed. You can also dictate sentences

that contain words that Dragon normally interprets as commands, such as "I really liked

your novel. No, scratch that - I loved your novel!" Or "The FBI has countless open files".

Dragon should transcribe the words as text and not execute commands as it normally would.

Command Mode

To format an existing document

In Command Mode Dragon interprets everything you say as a command and nothing is inter-

preted as dictated text.

1. Say "Start Command Mode" or "Command Mode On".

"Command Mode" appears in the status box of the DragonBar.

2. Use commands to format a document. For example, to capitalize the last five words you

dictated, say "Capitalize the Last Five Words". 

For more examples, see Formatting text in Microsoft Word or Formatting text in Corel

WordPerfect in the Dragon Help.

Numbers Mode

To insert numeric characters

In Numbers Mode Dragon interprets almost all of your dictation as numbers. This is useful

in certain applications, such as spreadsheets.

1. Say "Start Numbers Mode" or "Numbers Mode On".

The DragonBar shows the Numbers mode indicator and "Numbers mode" in the status

box.

2. Dictate only numbers. The numbers can include currency or percentages. For example,

say "5 percent sign" to enter "5%" or say "Seven hundred twenty three dollars and sixty

eight cents" to enter the dollar amount "$723.68".

Spell Mode

To spell words or insert alphanumeric characters

In Spell Mode Dragon allows you to say any combination of letters, digits, or sym-

bols. For example, use Spell Mode to dictate part numbers, license plate numbers,

or proper nouns that are not in Dragon's Vocabulary. You can also say keystrokes

such as "space bar" or "backspace key", or Internet or Web addresses.

1. Say "Start Spell Mode" or "Spell Mode On".

"Spell Mode" appears in the status box of the DragonBar.

225



Chapter 12: Improving recognition accuracy

2. Dictate an alphabetic string, such as a homophone alternative you need to use.

For example, say the letters "F O R E" to have Dragon enter the word "fore".

When Spell Mode is on, you will not be able to dictate words.

You can still use commands while in Spell Mode.

Switching recognition modes
You can use the following techniques to switch recognition modes:

To switch to Normal Mode
n Say "Switch to Normal Mode" or "Start Normal Mode" or "Normal Mode On".

n On the Modes menu of the DragonBar, click Normal Mode.

To switch to Dictation Mode
n Say "Switch to Dictation Mode" or "Start Dictation Mode" or "Dictation Mode On".

n Hold down the Shift key as you dictate.

n On the Modes menu of the DragonBar, click Dictation Mode.

To switch to Command Mode
n Say "Switch to Command Mode" or "Start Command Mode" or "Command Mode

On".

n Hold down the Control key as you dictate.

n On the Modes menu of the DragonBar, click Command Mode.

To switch to Numbers Mode
n Say "Switch to Numbers Mode" or "Start Numbers Mode" or "Numbers Mode On".

n On the Modes menu of the DragonBar, click Numbers Mode.

To switch to Spell Mode 
n Say "Switch to Spell Mode" or "Start Spell Mode" or "Spell Mode On".

n On the Modes menu of the DragonBar, click Spell Mode.

Notes

n On the The Options dialog box Hot keys tab, you can change the hot keys assigned

to force Dragon to use Dictation Mode (force dictation recognition) or Command

Mode (force command recognition).

226



Dragon 12 Installation and User Guide

Teaching Dragon to Understand You
Better

This section contains the following topics:

Training misrecognized commands 227

Training individual words and phrases 228

Using punctuation with written and spoken forms 228

Supplemental training 229

Training misrecognized commands
If Dragon consistently misrecognizes a specific voice command (for example, it hears "Cor-

rect That" as "Correct dot"), you can train it to recognize your pronunciation of the com-

mand.

To train commands

1. Say "Open Command Browser" or click Command Browser on the Tools menu of the

DragonBar.

2. Say "Click Browse", then "Context", then "<Application name>" (the program in which the

command is available) or click Browse > Context > <Application name>.

3. Say or click "Keyword Filter."

4. Say or type a keyword for the command you want to train in the Choose Word box.

5. Say or click "Add" to move the word to the "Current list of filter words." Repeat until you

have as many keywords as you need to find the command in question.

6. Say or click "Done."

7. If more than one command appears in the list, select the command you are looking for,

expanding it with the Optional, Ellipsis, or Refine buttons if necessary.

8. Do one of the following:
l Say or click "Train" and follow the directions on the Train Words dialog box

that appears.

Or

l Say or click "Train Later." Dragon adds the command to the Train List. Open

it to train the commands you stored there.

If you have untrained commands in the Train List when you close the Com-

mand Browser, Dragon offers you the choice to train them before you exit.

Notes

n When you train words or phrases, be careful to speak in your normal voice. Avoid the

natural tendency to over enunciate when speaking single words or short phrases as it

could actually reduce recognition accuracy.
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n When you train a command using the Train Words dialog box, you add to the acous-

tic data stored for later use by the Acoustic Optimizer. This data, including your pro-

nunciation and the acoustic differences between the trained correction and the

misrecognized word or phrase, are used by the Acoustic Optimizer to enhance rec-

ognition accuracy.

Training individual words and phrases
If Dragon is not recognizing certain words or phrases, and you have tried correcting the mis-

recognition at least twice, then you should consider training that word or phrase to teach

Dragon exactly how you pronounce it.

The following procedures describe two different ways to train words or phrases:

To train individual words and phrases immediately after dictating
them

1. Correct the misrecognized word or phrase you want to train and say "Train That."

2. Click Go in the Train Words dialog box and record your speech saying the word or

phrase you want to train.

3. When you have finished recording the text, click Done.

To train individual words and phrases at any time

1. Say "Open Vocabulary Editor", or click Vocabulary > Open Vocabulary Editor on the

DragonBar.

2. In the Vocabulary Editor, say or click Train.

3. Type the word or phrase you want to train in the Training dialog box.

4. Click Go in the Train Words dialog box and record your speech saying the word or

phrase you want to train.

5. When you have finished recording the text, click Done.

Using punctuation with written and spoken
forms
If the written form of a word contains any punctuation, you should provide a spoken form

so that there is no doubt as to how the item will be pronounced. Do not use abbreviations,

symbols or punctuation in the spoken form.

Examples:

Written form Spoken form

The Man from U.N.C.L.E. the man from uncle

Soddy-Daisy, TN Soddy Daisy Tennessee

Trenton-Mercer Airport Trenton Mercer Airport
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If you want to add punctuation to a word that already exists in the Vocabulary for use in a

specific setting, you can create a new written form with the punctuation included and a

unique word or phrase for the spoken form.

For example, if you wanted Dragon to type the word "U.N.C.L.E." in the header of your

letters, the written form could be "U.N.C.L.E." and the spoken form could be "UNCLE."

That way, Dragon would still type only the word "uncle" when you dictate it as usual,

because it also exists in the Vocabulary.

Alternately, if you wanted to add punctuation to a word that already exists in the Vocabulary

every time you used that word, you would change the properties of the existing word. For

more information, see Word Properties in the Dragon Help.

Notes

n When you train words or phrases, be careful to speak in your normal voice. Avoid the

natural tendency to over-enunciate when speaking single words or short phrases as it

could actually reduce recognition accuracy.

n A word or phrase must exist in the Vocabulary (that is, have been created previously)

before you can train it.

n You can also use the Train button in the Vocabulary Editor dialog box.

n When you train a word or phrase using the Train Words dialog box, you add to the

acoustic data stored for later use by the Acoustic Optimizer. This data, including your

pronunciation and the acoustic differences between the trained correction and the mis-

recognized word or phrase are used by the Acoustic Optimizer to enhance recognition

accuracy.

Supplemental training
Supplemental training is any additional training done after your first required General Train-

ing session to help improve your recognition accuracy. You can do supplemental training at

any time, but it is most useful when:

n You have used Dragon for a few days. By then, you will be accustomed to dictating,

and supplemental training should reflect how you actually dictate.

n You move to an environment that is significantly noisier or quieter or that has dif-

ferent background sounds.

n You have changed your microphone or sound card.

To train Dragon some more

1. Do one of the following:
n Say "Switch to DragonBar," then "Audio" then "Read Text to Improve

Accuracy."

Or

n Say "Open Accuracy Center" then "Read text to train Dragon to your

voice."
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2. Follow the same guidelines as when you trained the first time.

3. When you are finished, click Finish.

You can read as much or as little as you want, but you should train for 3 to 6 minutes or

longer. The longer you train, the more likely you will notice improvements in recognition

accuracy.
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Personalizing your Dragon
Vocabulary

This section contains the following topics:

About personalizing your Vocabulary 231

Adding words or phrases to your Vocabulary 232

Using punctuation with written and spoken forms 232

Learning from specific documents 233

Importing lists of words or phrases 234

Adding words with the Spelling window 235

Learn From Sent E-mails 235

Adding contact names to the Vocabulary 236

Deleting words 237

Using the Don't Recognize That Word Command 239

About personalizing your Vocabulary
You can personalize a Vocabulary to more closely match your writing style and to recognize

any special words which you dictate. You can do this in several ways, by adding individual

words, or by adding entire documents that you write or lists of words that you prepare, and

by using Smart Format Rules. Dragon can add these new words to the Vocabulary and update

the Vocabulary with information about your word usage. This improves the likelihood that

Dragon will correctly recognize what you say.

You can use the following methods to add or delete words in the Vocabulary.

Adding words or phrases to your Vocabulary

Learning from specific documents

Importing lists of words or phrases

Adding words by spelling

Deleting words

Using the Don't Recognize That Word Command

Notes

n You are not required to train new words because Dragon automatically "guesses" the

pronunciations based on their spelling. If, however, your new words are not rec-

ognized correctly, you should train them.

n Be sure to save your User Profile after adding new words or the new words will not be

saved.

n If you make unwanted changes to a Vocabulary, you can create a new one or restore

your User Profile from a backup copy.

231



Chapter 12: Improving recognition accuracy

n If you use multiple-word phrases with unusual capitalization (for example, "Com-

puterWeek"), you can improve recognition accuracy by adding these phrases to the

Vocabulary before Dragon analyzes your documents. Add these phrases by using the

(say "Open Vocabulary Editor" or click Vocabulary > Open Vocabulary Editor on

the DragonBar.) or by including them in lists of items you import into the Vocab-

ulary.

n Dragon can auto-format text and numbers using standard writing conventions or

apply Word Properties to words as you dictate. For information about these settings,

see Auto-formatting dialog box and The Word Properties dialog box.

n Dragon's Smart Format Rules appear when you correct auto-formatted alphanumeric

text or Word Properties using the Correction menu, the Spelling window, or the key-

board. For details, see Using Smart Format Rules and Setting Auto-Formatting

Options.

Adding words or phrases to your Vocabulary
If Dragon gets a word wrong, it may be that the word is not in Dragon's Vocabulary. When

this is the case, you can use the following procedure to add that word so that it is rec-

ognized in the future.

To add individual words

1. Do one of the following:
l Say "Switch to DragonBar" then "Vocabulary" then "Add New Word or

Phrase".

l Click Vocabulary > Add New Word or Phrase on the DragonBar.

2. In the Add Word or Phrase dialog box, spell (by voice) or type the word you want to

add.

3. Include a Spoken form of the new word if necessary. For example, if the word contains

an accent, such as "Gaspé," you would add a Spoken form like "gas pay" so that Dragon

recognizes the pronunciation and enters the Written form when you dictate the word.

4. Optionally, select "I want to train the pronunciation of this word or phrase".

5. Click Add.

If you chose to train the word, the word you entered appears in the Train Words dialog box,
and you will be able to teach Dragon your pronunciation of that word.

See also Automatically add words to Vocabulary in the Dragon Help.

Using punctuation with written and spoken
forms
If the written form of a word contains any punctuation, you should provide a spoken form

so that there is no doubt as to how the item will be pronounced. Do not use abbreviations,

symbols or punctuation in the spoken form.

Examples:
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Written form Spoken form

The Man from U.N.C.L.E. the man from uncle

Soddy-Daisy, TN Soddy Daisy Tennessee

Trenton-Mercer Airport Trenton Mercer Airport

If you want to add punctuation to a word that already exists in the Vocabulary for use in a

specific setting, you can create a new written form with the punctuation included and a

unique word or phrase for the spoken form.

For example, if you wanted Dragon to type the word "U.N.C.L.E." in the header of your

letters, the written form could be "U.N.C.L.E." and the spoken form could be "UNCLE."

That way, Dragon would still type only the word "uncle" when you dictate it as usual,

because it also exists in the Vocabulary.

Alternately, if you wanted to add punctuation to a word that already exists in the Vocabulary

every time you used that word, you would change the properties of the existing word. For

more information, see Word Properties in the Dragon Help.

Learning from specific documents
You can use the Learn from Specific Documents wizard to personalize your profile by adding

words from specific folders or documents to your vocabulary. Dragon analyzes the doc-

uments to update the vocabulary with information about your word usage.

Caution

To maintain accuracy, Dragon must only analyze content in the language in which your user

profile was created. Be sure to select only documents in the language of your current profile.

To add words from specific documents

1. Say "Open Accuracy Center" and then "Learn From Specific Documents" or click Vocab-

ulary > Learn From Specific Documents on the DragonBar.

2. In the Learn from Specific Documents wizard, select from the following options:
n Find Known Words with Unknown Capitalization: Select this option to

have Dragon look for words on your system that are in its Vocabulary but

which use different capitalization, such as Desktop. This option is turned

off by default.

n Adapt to Writing Style: Select this option to have Dragon analyze word

combinations to improve its capacity to anticipate your writing and dic-

tation style. This option is turned on by default.

3. Click Next to continue. The Learn from Specific Documents screen opens.
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4. Do any of the following:
n Click Add Folder if you want Dragon to scan a specific folder, such as

your My Documents folder. Click Include Subfolders in the Browse for

Folders dialog box if there are subfolders you want to analyze.

n Click Add Document if you want Dragon to scan specific documents.

n Click Remove Document if you add a document and then decide that

you don't want Dragon to include it in the scan.

n Click View Document if you want to review a document you added

before proceeding.

5. Click Next to continue. A Document Analysis window opens, displaying a status bar dur-

ing the scan. Dragon confirms whether new words were found and displays a summary of

the results.

6. Click Next to continue. If you selected words to add to the Vocabulary, a Train Words

screen opens.

7. You can click Train to train Dragon about how you pronounce each added word.

8. When you finish training new words, click Next. The Adapt to Writing Style screen

opens, indicating whether the adaptation was successfully completed.

9. Click Next to continue. The Summary screen opens, showing the results of the scan. For

example, "1 new word was found" and "1 word was added to your Vocabulary".

10. Click Finish to close the wizard.

11. Say "Switch to DragonBar" and then "Profile" and then "Save User Profile", or click

Profile > Save User Profile on the DragonBar to finish adding the words.

Notes

n If you make a mistake and do not want to add the words, avoid making additional

changes to the Vocabulary that you want to save, and then exit Dragon without sav-

ing.

n When adding words from documents, you will get the better results if you remove all

formatting from the documents you use. For information about how to prepare doc-

uments, see the topic Preparing documents to add to the Vocabulary.

Importing lists of words or phrases
Use the Import list of words or phrases wizard if you want to add multiple-word phrases to

your Vocabulary, even if they are used in documents that you will process using the Learn

from Specific Documents wizard. You should do this because the Import list of words or

phrases wizard adds words from documents as phrases, not single words.

For information about how to prepare a list, see the topic Preparing documents to add to

the Vocabulary.

To import lists of words or phrases

1. Say "Accuracy Center," or click Help > Improve My Accuracy.

2. On the Accuracy Center, click or say "Import a list of words or phrases".
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3. Follow the steps on the Import list of words or phrases wizard.

Adding words with the Spelling window
If Dragon misrecognizes a word, it may be that the word is not in the program's Vocabulary.

When this is the case, you can use the following procedure to add the word so that it is rec-

ognized in the future.

To add words with the Spelling window

1. Say "Spell That," followed by the first four to six letters of the desired word.

The Spelling window opens.

2. In the the Spelling window, finish typing the word or spell it by voice.

3. If you wish to train the pronunciation of the word, click Audio > Improve Recognition of

Word or Phrase and follow the instructions in the Train Words dialog box.

Note

You cannot use the Spelling window to add a word that has hyphens or spaces. The program

recognizes each part of such a word as separate pieces. For example, if you tried to use the

Spelling window to add the name "Havisham-Smythe," you would actually be adding the

names "Havisham" and "Smythe". The next time you spoke the name you would get "Hav-

isham Smythe" without the hyphen. To add such a word or name, use the Vocabulary Editor

dialog box (say Open Vocabulary Editor).

Learn From Sent E-mails
Use the Learn From Sent E-mails tool to add the names of people to whom you have sent e-

mail to your Dragon Vocabulary. You have the option to edit and train these names and you

can also have Dragon scan the contents of your sent e-mail and add it to Dragon's Language

Model.

CAUTION

To maintain accuracy, Dragon must only analyze content in the language in which your user

profile was created. If you have Sent e-mail in other languages, only use this tool to add e-

mail contacts to your profile.

Note

It's best to run the Learn From Sent E-mails tool only when you are not using your computer

for other purposes because the tool uses large amounts of computer memory and processing

power.

To open the Learn From Sent E-mails tool

n Say "Open Accuracy Center," then "Learn From Sent E-mails."

Or

n Click Vocabulary > Learn From Sent E-Mails on the DragonBar.
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Tip

You can also start the Learn From Sent E-mails tool by saying "Add Contacts".

Once you start the Learn From Sent E-mails wizard, proceed by clicking Next. The tool

leads you through the following screens:

n Choose options

n Scan e-mail

n Add contacts to Vocabulary

n Train words

n Adapt to Writing Style

n Report

Adding contact names to the Vocabulary
The Learn From Sent E-mails tool lets you add the names of people to whom you have sent

e-mail to your Dragon Vocabulary. Using this tool, you can edit and train the names you

add. You can also have Dragon scan the contents of your sent e-mail and adapt the language

model to more accurately recognize your writing style.

Dragon supports adding contacts in the following e-mail programs:

n Microsoft Outlook

n Microsoft Outlook Express

n Windows Mail

n Windows Live Mail

n Lotus Notes

To add contact names from your sent e-mail to your Vocabulary

1. Start the Learn From Sent E-mails tool by saying "Add Contacts".

2. On the first screen of the Learn From Sent E-mails wizard, click Next.

3. On the Choose Options screen, select the e-mail programs from which you would like to

add contact names and select the "Add contact names from e-mail to the Vocabulary"

box.

4. Optionally, you can select the "Improve my speech files from my e-mail writing style" if

you want Dragon to better understand your Vocabulary and word usage by analyzing your

e-mail messages. You can also have the program rescan your sent e-mail to add new con-

tact names since the last time you used the Add Contacts dialog box.

5. Click Next and wait for the wizard to scan the selected e-mail programs for contact and

word usage data. When the wizard is finished, click Next again.

6. On the Add contacts to Vocabulary screen, select the words you want to add, and click

Next.
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7. On the Train Words screen select the contact names for which you want to train the pro-

nunciation and click Next. You can also check and uncheck all contact names to train.

8. Use the Train Words dialog box that appears to train the words you selected.

9. When you finish training words, wait for the program to adapt your language model. A

report screen will inform you of the success of the wizard.

Notes

n (Lotus Notes only) New contact names will be detected for everyone to whom you

have sent e-mail, except those contacts to whom you have sent Reply messages.

n Nicknames can only be added to your Vocabulary if your e-mail program supports nick-

names.

n Do not use the "Improve my speech files from my e-mail writing style" if you write e-

mail messages in foreign languages. The result of trying to analyze a language other

than the language in which you trained the User Profile may decrease recognition accu-

racy.

Deleting words
Use this procedure to delete words from the active Vocabulary. Deleting words is not nor-

mally necessary, but you can use this procedure to do it if Dragon tends to substitute a word

you never use for a word you want to use.

To delete words

1. Say "Open Vocabulary Editor," or click Vocabulary > Open Vocabulary Editor on the

DragonBar.

The Vocabulary Editor dialog box opens with the Written form box selected, as shown:
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2. To highlight the word you want to delete, do one of the following:

say "Spell <word>" where word represents the letters of the word you want to delete

type the letters of the word

or

scroll the list to find the word and select it

3. When the word appears and is highlighted, say or click "Delete".

4. Close the Vocabulary Editor dialog box.

To restore words

Use this procedure if you have deleted a word from the Dragon Vocabulary and want to

restore it later.

1. Say "Open Vocabulary Editor," or click Vocabulary > Open Vocabulary Editor on the

DragonBar.

2. In the Vocabulary Editor dialog box, click Display > Deleted Words Only. The displays

shows any words you have deleted.

3. Choose a Deleted word, and say or click Add. Dragon adds the word back into your

Vocabulary. If you want to view the restored word in the Vocabulary, click Display >

All Words and enter the word in the Written Form box.

Note

If you delete a word using the Vocabulary Editor dialog box, but that word exists in the cur-

rent document, the word may be automatically added back into your active Vocabulary.
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Using the Don't Recognize That Word Command
Dragon lets you to turn off recognition of words using the Correction menu and the "Don't

recognize that word" command.

Don't Recognize That Word removes the selected word from your active Vocabulary, so that

Dragon won't recognize it again. This can save you time if Dragon repeatedly replaces words

you dictate with words you don't use.

For example, if you dictate the name "Cassity" often and Dragon always hears "Cassidy", you

could use Don't Recognize That Word from the Correction menu to turn off recognition of Cas-

sidy. If you decide later that you do need to use the word, you can add it back using the

Vocabulary Editor.

When you use the "Don't recognize that word" command or Don't Recognize That Word from

the Correction menu to turn off recognition of a word, you will be presented with one of the

following messages to confirm a deletion of the word:

Are you sure you want to delete the following word from the Vocabulary?

This message is displayed when you use the "Don't Recognize That Word" command to

delete a word or phrase from the Vocabulary.

The following word can only be removed from the Vocabulary using the Vocab-
ulary Editor.

This message is displayed when you use the "Don't Recognize That Word" command to try

to delete a custom word or frequently used word such as "the" from the Vocabulary. You can

use the Vocabulary Editor to delete the word.

The following word can't be deleted because it does not exist in the Vocab-
ulary.

This message is displayed when you use the Don't Recognize That Word command to try to

delete a word or phrase that is not in the Vocabulary.

For more information, see the Correction menu.
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Managing Vocabularies
This section contains the following topics:

About Vocabularies 240

Opening Vocabularies 250

Adding a Vocabulary to a User Profile 251

Deleting Vocabularies 252

Renaming Vocabularies 252

Importing Vocabularies 253

Exporting Vocabularies 254

About Vocabularies
Dragon uses one or more Vocabularies with your User Profile to help it to recognize words

and phrases correctly, based not only on the sound of the words and phrases, but also on

their context.

When you create a new User Profile, you select a Base Vocabulary that Dragon then updates

as it adapts to your speech. When you create a new User Profile or add a Vocabulary to an

existing User Profile, Dragon bases the new Vocabulary on an existing Vocabulary.

Language

The languages available for your Vocabulary. Some editions of Dragon support multiple lan-

guages.

Vocabulary type

In most cases your User Profile will be based on the General Vocabulary, a large Vocabulary

providing excellent recognition accuracy for general, business, and professional dictation.

The following specialized Vocabularies are also available:

n Legal (Dragon Legal Edition)

A large Vocabulary providing excellent recognition accuracy for legal terms.

n Medical (Dragon Medical Edition)

A set of specialized large medical Vocabularies providing excellent recognition accu-

racy for medical terms. The Vocabulary names are: Surgery, Radiology, Pediatrics,

Pathology, Orthopedics, Oncology, Obstetrics/Gynecology, Neurology, Mental

Health, Medical Dictation, General Practice, Emergency, Gastroenterology, and Car-

diology.

Advanced

On the Review Your Choices screen of the New User Profile wizard, you can click the

Advanced button to display the Advanced Choose Models dialog box. On this dialog box

you can choose a different speech model and Vocabulary Type. Dragon automatically deter-

mines the best speech model and Vocabulary Type for your computer when you create a

User Profile, so you do not generally need to change these options.
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Speech model

You can associate the following speech models with your Dragon Vocabulary, depending on

your accent, and the type of microphone and computer you are using:

Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

General N N < 2
GB

Any
approved

BestMatch III

BestMatch III
Medical

Bluetooth Bluetooth 8Khz

16-kHz
Bluetooth

Enhanced Blue-
tooth BestMatch
III

Bluetooth
microphone
for medical
dictation

Medical - Blue-
tooth 8Khz

Y ≥ 2
GB

Any
approved

BestMatch IV

Bluetooth Bluetooth Best-
Match IV

16-kHz
Bluetooth

Enhanced Blue-
tooth BestMatch
IV

Y Y ≥ 4
GB

Any
approved

BestMatch V

16-kHz
Bluetooth

Bluetooth 8Khz
BestMatch V

Enhanced Blue-
tooth BestMatch
V
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Australian N N < 2
GB

Any
approved

Australian
accented English
- BestMatch III

Bluetooth Australian
accented English
- Bluetooth 8Khz

16-kHz
Bluetooth

Australian
accented English
- Enhanced Blue-
tooth BestMatch
III

Y ≥ 2
GB

Any
approved

Australian
accented English
- BestMatch IV

Bluetooth Australian
accented English
- Bluetooth Best-
Match IV

16-kHz
Bluetooth

Australian
accented English
- Enhanced Blue-
tooth BestMatch
IV

Y Y ≥ 2
GB

Any
approved

Australian
accented English
- BestMatch V

16-kHz
Bluetooth

Australian
accented English
- Enhanced Blue-
tooth BestMatch
IV

≥ 4
GB

Bluetooth Australian
accented English
- Bluetooth 8Khz
BestMatch V
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

British N N < 2
GB

Any
approved

British-accented
English - Best-
Match III

Bluetooth British accented
English - Blue-
tooth 8 KHz

Y ≥ 2
GB

Any
approved

British-accented
English - Best-
Match IV

Bluetooth British accented
English - Blue-
tooth BestMatch
IV
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Indian N N < 2
GB

Any
approved

BestMatch III
Medical Indian

Indian accented
English - Best-
Match III

Bluetooth Indian accented
English - Blue-
tooth 8Khz

Y ≥ 2
GB

Any
approved

Indian accented
English - Best-
Match IV

Bluetooth Indian accented
English - Blue-
tooth BestMatch
IV

16-kHz
Bluetooth

Indian accented
English -
Enhanced Blue-
tooth BestMatch
IV

Y Y ≥ 2
GB

Any
approved

Indian accented
English - Best-
Match V

Bluetooth Indian accented
English - Blue-
tooth 8 kHz Best-
Match V

16-kHz
Bluetooth

Indian accented
English -
Enhanced Blue-
tooth BestMatch
V

≥ 4
GB

16-kHz
Bluetooth

Indian accented
English -
Enhanced Blue-
tooth BestMatch
V
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Inland Northern US (Great
Lakes area)—if your accent is
from upstate New York
through the Chicago area

N N < 2
GB

Any
approved

Inland Northern
US (Great Lakes
area) - Best-
Match III

Bluetooth Inland Northern
US (Great Lakes
area) - Bluetooth
8Khz

16-kHz
Bluetooth

Enhanced Blue-
tooth BestMatch
III

Y ≥ 2
GB

Any
approved

Inland Northern
US (Great Lakes
area) - Best-
Match IV

Bluetooth Inland Northern
US (Great Lakes
area) - Bluetooth
BestMatch IV

16-kHz
Bluetooth

Inland Northern
US (Great Lakes
area) - Enhanced
Bluetooth Best-
Match IV
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Southeast Asian N N < 2
GB

Any
approved

Southeast Asian
accented English
- BestMatch III

Bluetooth Southeast Asian
accented English
- Bluetooth 8Khz

16-kHz
Bluetooth

Southeast Asian
accented English
- Enhanced Blue-
tooth BestMatch
III

Y ≥ 2
GB

Any
approved

Southeast Asian
accented English
- BestMatch IV

Bluetooth Southeast Asian
accented English
- Bluetooth Best-
Match IV

Southeast Asian
accented English
- Enhanced Blue-
tooth BestMatch
IV

Y Y ≥ 2
GB

Any
approved

Southeast Asian
accented English
- BestMatch V

Bluetooth Southeast Asian
accented English
- Bluetooth 8 kHz
BestMatch V

16-kHz
Bluetooth

Southeast Asian
accented English
- Enhanced Blue-
tooth BestMatch
V
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Southern US—if you have a
Southern U.S. accent (includ-
ing Texans)

N N < 2
GB

Any
approved

Southern US -
BestMatch III

Bluetooth Southern US
Bluetooth 8Khz

16-kHz
Bluetooth

Southern US
Enhanced Blue-
tooth BestMatch
III

Y ≥ 2
GB

Any
approved

Southern US -
BestMatch IV

Bluetooth Southern US
Bluetooth Best-
Match IV

16-kHz
Bluetooth

Southern US
Enhanced Blue-
tooth BestMatch
IV
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Spanish—if you have an Amer-
ican-Hispanic accent

N N < 2
GB

Any
approved

Spanish-
accented English
- BestMatch III

Bluetooth Spanish
accented English
- Bluetooth 8Khz

Y ≥ 2
GB

Any
approved

Spanish-
accented English
- BestMatch IV

Bluetooth Spanish
accented English
- Bluetooth Best-
Match IV

16-kHz
Bluetooth

Spanish
accented English
- Enhanced Blue-
tooth BestMatch
III

Spanish
accented English
- Enhanced Blue-
tooth BestMatch
IV
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Accent or age criteria
64-
bit
OS?

Multiple
processors? RAM Microphone

Speech model

Teens up to the age of 13 N N/A N/A Any
approved
non-Blue-
tooth

Teens Best-
Match III

Bluetooth Teens Bluetooth
8Khz

N < 2
GB

16-kHz
Bluetooth

Teens Enhanced
Bluetooth Best-
Match III

Y ≥ 2
GB

Any
approved
non-Blue-
tooth

Teens Best-
Match IV

Bluetooth Teens Bluetooth
BestMatch IV

16-kHz
Bluetooth

Teens Enhanced
Bluetooth Best-
Match IV

For a list of supported devices, including handheld and Bluetooth microphones, see the Hard-

ware Compatibility list ( http://support.nuance.com/compatibility) on the Nuance Web site.

Vocabulary Type 

If you click the Advanced button, you can specify a different Vocabulary type from among

the following choices:

Vocab-
ulary

Processor
speed

Number of
processors

RAM Recommended Acoustic Model

Large ≥ 2 GHz 1 1 GB BestMatch III

> 1 > 1 GB BestMatch IV
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Vocab-
ulary

Processor
speed

Number of
processors

RAM Recommended Acoustic Model

Medium 2 GHz 1 < 1 GB BestMatch III
or
BestMatch V
Note: BestMatch V acoustic models
are not recommended for use with
the large vocabulary in U.S. English
profiles due to the larger file size of
the vocabulary in RAM (552 MB). You
can choose the large vocabulary
from the Choose Models - Advanced
dialog box.

Note: If you don't need to use an extensive vocabulary, you can increase rec-
ognition speed by choosing the medium vocabulary.

Empty Dic-
tation

Designed for use by value-added resellers who want to create specialized
Vocabularies from scratch. Consists of a Vocabulary with a language model with
no words.

Note

Some Dragon editions or add-on products may install additional Vocabularies.

Opening Vocabularies
Use the following procedure to open another Vocabulary associated with your User Profile.

You can have only one Vocabulary open at a time. See Adding a Vocabulary for more infor-

mation.

To open a Vocabulary

1. Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the Drag-

onBar.

2. On the Manage Vocabularies dialog box, select the name of the Vocabulary you want to

open and click Open. If you made changes to the current Vocabulary, the system

prompts you to save your speech files before the selected Vocabulary opens.

To open a recently used Vocabulary

Use the following procedure if you have one or more Vocabularies associated with your

User Profile and you want to switch to the most recent one you used.

n Say "Open Recent Vocabulary" or click Vocabulary > Open Recent Vocabulary on

the DragonBar. Dragon opens the most recent Vocabulary associated with your User

Profile.
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Notes

n Any phrases you add to a Vocabulary are available in that Vocabulary only, but custom

voice commands are always available no matter which Vocabulary you are using.

n Switching Vocabularies has no effect on the text in the document window. It does,

however, close any open dialog boxes, such as General Training and Vocabulary

Editor.

n Vocabularies that you have created and opened appear in the Profile menu on the

Open Recent Vocabulary submenu. You can quickly switch between Vocabularies by

selecting the appropriate Vocabulary name from this submenu.

Adding a Vocabulary to a User Profile
With Dragon Professional, Legal and Medical editions, you have the option of creating new

Vocabularies and adding them to your existing User Profile to improve recognition accuracy.

This may be helpful if you use specialized terminology when you dictate into documents and

e-mails. You can only have one Vocabulary open at a time.

Note
Creating a Vocabulary can take from 5 to 30 minutes depending on the options you select,
the speed of your processor, the amount of RAM in your system, and the amount of e-mail
and data to be scanned. Progress bars display the time remaining in this procedure. If you
include the E-mail option, it is best to create new Vocabularies only when you are not using
your computer for other purposes.

To add a Vocabulary to a User Profile

1. Do one of the following:
n Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on

the DragonBar.

n Say "Switch to DragonBar," then "Profile," then "Add Vocabulary to Cur-

rent User Profile," or on the DragonBar click Profile > Add Vocabulary to

Current User Profile. Go to step 3.

2. On the Manage Vocabularies dialog box, click New.

3. From the Based On list in the New Vocabulary dialog box, select the name of a Vocab-

ulary on which you want to base the new Vocabulary.

All available Vocabularies are listed. Those beginning with the word "Base" are the unmod-

ified Vocabularies shipped with Dragon. The Vocabulary you select will be copied to the

new Vocabulary and supplemented with words from your documents, emails, and added to

your User Profile.

2. Enter a descriptive name for the Vocabulary.

A Vocabulary name can contain up to 128 characters, including spaces.

3. Click OK to create the Vocabulary. The Let Dragon search for words tool opens and

prompts you to allow Dragon to improve recognition accuracy by adapting the Vocabulary

based on e-mail messages and documents.
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4. Make your selections and click Start to begin the optimization.

Note: If you need to save time, you can deselect E-mail adaptation and run it later. See

Let Dragon search for words tool for details

5. Optionally, before using the Vocabulary, you can personalize it further using the Accu-

racy Center. For more information, click See Also below.

Notes

n Any Vocabularies you create are saved along with the files that are part of your

User Profile.

n Keep in mind that creating many specialized Vocabularies can make it difficult to

keep track of which words are available when you dictate.

n Also keep in mind that each new Vocabulary uses hard-disk space.

Deleting Vocabularies
Additional Vocabularies can improve recognition accuracy in Dragon, but multiple Vocab-

ularies can take up a lot of disk space. If you no longer need a Vocabulary, use the following

procedure to delete it.

To delete a Vocabulary

1. On the Vocabulary menu of the DragonBar, click Manage Vocabularies.

2. On the Manage Vocabularies dialog box, select the Vocabulary you want to delete and

click Delete.

3. Click Close on the Manage Vocabularies dialog box.

Notes

n Deleting a Vocabulary cannot be undone.

n You cannot delete the Vocabulary that is currently in use. To remove it, you must

first open a different Vocabulary.

n Always use the Delete button to delete Vocabularies. Do not remove Vocabulary

folders from Dragon Users directory on your hard disk.

Renaming Vocabularies
If you have multiple Vocabularies, you should give them descriptive names that help you

identify their purpose.

To rename a Vocabulary

1. Say "Manage Vocabularies" or click it on the Vocabulary menu of the DragonBar.

2. On the Manage Vocabularies dialog box, say or choose the name of the Vocabulary you

want to rename.

3. Click or say "Rename."
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4. On the Rename Vocabulary dialog box, enter a new name and click or say "OK."

5. On the Manage Vocabularies dialog box, click or say "Close."

Note

A Vocabulary name can contain up to 128 characters, including spaces.

Importing Vocabularies
You can share Vocabularies among different User Profiles by first exporting a Vocabulary

from one User Profile and then importing it to another User Profile. If you have exported a

Vocabulary from another User Profile (for example, if you have created a User Profile with a

custom word list), use the following procedure to import it.

To import a Vocabulary

1. Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the DragonBar.

2. On the Manage Vocabularies dialog box, click or say "Import."

3. Use the Open dialog box to locate and open the folder containing the Vocabulary you

want to import (it must be a Vocabulary that was exported).

4. Select the desired Vocabulary (.TOP) file and click or say "Open."

5. In the Import Vocabulary dialog box, enter a name for the imported Vocabulary.

To import the Vocabulary so that it replaces an existing Vocabulary, enter the name of the

existing Vocabulary. To import the Vocabulary as a new one, enter a new name that you have

not used before.

A Vocabulary name can contain up to 128 characters, including spaces.

6. Click or say "OK" to save the Vocabulary.

7. Click or say "Close" on the Manage Vocabularies dialog box to close it.

Notes

n An exported Vocabulary consists of six files with the same name but different exten-

sions. These six files must remain in the same directory. To import the Vocabulary,

you specify only the file with the extension .TOP. Dragon then imports all six files

that together make up a Vocabulary.

n You may want to keep a master copy of an imported Vocabulary and create a copy of it

to work with.

n Vocabularies can be shared only by exporting and importing them using the pro-

cedures described here. It is not possible to share Vocabularies by copying Vocabulary

folders from one User Profile to another.

n Creating and personalizing a Vocabulary with documents you choose as representative

of your writing style may be more effective than using a Vocabulary created by some-

one else.

n If you create a User Profile on a dual core machine that uses a custom vocabulary,

make sure that the User Profile uses the BestMatch IV speech model (BestMatch IV

has the greatest recognition accuracy on dual-core systems with more than 2 GB of
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RAM). To check this, select the Advanced button on the Creating a User Profile

screen of the New User Profile wizard and make sure that BestMatch IV is selected.

Exporting Vocabularies
You can share Vocabularies among different User Profiles by first exporting a Vocabulary

from one User Profile and then importing it to a new User Profile. Use the following pro-

cedure to export a Vocabulary.

To export a Vocabulary

1. Create a folder in which to save the exported Vocabulary files (this step is optional).

2. Open the User Profile and the Vocabulary(s) you want to export as follows:
i. Click Profile > Open User Profile on the DragonBar.

ii. Select the User Profile you want to export and click Open.

3. Say "Manage Vocabularies" or click Vocabulary > Manage Vocabularies on the Drag-

onBar.

4. On the Manage Vocabularies dialog box, select the Vocabulary you want to export and

then click or say "Export."

5. Locate and open the folder where you want to save the file and then click or say "Save."

Dragon gives Vocabulary files the extension ".Top."

6. Click or say "Close" on the Manage Vocabularies dialog box to close it.

Notes

n Vocabularies can be shared only by exporting and importing them. It is not possible

to share them by copying Vocabulary folders from one User Profile to another.

n When the Vocabulary is imported, it can be renamed.

n Exporting a Vocabulary creates a copy of the six files that make up the Vocabulary in

the new location. All six files have the same name but different extensions. When

importing a Vocabulary, select only the Vocabulary file with the extension .TOP.
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Chapter 13: Using the
Command Browser

This section contains the following topics:

About the Command Browser 255

Opening the Command Browser 256

Finding commands in the Command Browser 257

Training commands in the Command Browser 259

About the Command Browser
The Command Browser is a window where you can locate voice commands that Dragon rec-

ognizes, including commands that are provided with the software as well as any commands

that you or your system administrator might have added (custom commands). The Command

Browser is the most comprehensive place to see the commands that are available in each

application.

You use the Command Browser to:

n View and train commands

n Create and modify commands

n Import and Export commands

n Change the availability of custom commands

Some commands are not available in Dragon Premium and lower editions.

Command Browser modes
Browse

Browse mode allows you to search for a specific command. For more information see the

topic Finding commands in the Command Browser.

Script

Script mode allows you to create new commands and select commands to delete, edit, copy,

or preview.
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Manage

Manage mode allows you to import, export, delete, or edit the properties of selected cus-

tom commands. (Some of these functions are available in only Dragon Professional, Legal,

and Medical editions.)

To make the Command Browser appear always on top

n Say "Mode > Always On Top," or on the Mode menu, click Always On Top.

n On the Command Browser shortcut menu, click Always On Top.

n Click on the Command Browser icon on the left side of the Command Browser

or right-click anywhere on the Command Browser to open the Command Browser

shortcut menu.

Note

When you set the Command Browser to "Always On Top" it will cover secondary Dragon

windows, such as the DragonPad and Help screens. In these cases, you will have to turn off

the "Always On Top" state or move the windows around so that they are not obscured.

Opening the Command Browser
The Command Browser displays commands that Dragon recognizes in the current context,

whether you are working in a specific program or on the Windows Desktop.

To open the Command Browser

Say "Open Command Browser" or "Start Command Browser" or, on the Tools menu of

the DragonBar, click Command Browser.

You can also open the Command Browser from the Accuracy Center.

Some commands are not available in Dragon Premium and lower editions.

Global Commands

When the Command Browser first opens, it displays a list of Global Commands available in

every application.

But if you want to view commands for individual applications, Dragon shows only com-

mands applicable in that context. Use the Context box to select a specific application and

Dragon displays only the commands that work in that application. If you were viewing com-

mands for the Dragon Sidebar (as shown), initially a subset of commands that apply only to

the Sidebar appear. See Finding commands in the Command Browser for details.
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To display Global Commands for a specific application

Use "Include Global" if you want to display all of the Dragon commands that are available in

every application.

In the Command Browser, say "Include Global" or, on the Command Browser Ribbon Bar,

click Include Global.

Finding commands in the Command Browser
If a command exists for a specific application or context, you can use the Command Browser

to find it.

To find a specific command

1. Use the list in the Context box to select the application context you want to see com-

mands for.
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2. Select the Include Global checkbox.

When the Include Global checkbox is selected, the Command Browser
displays all the commands available in the current command context,
including any commands available in all (global) contexts. Note that the
Command Browser initially opens with Global Commands selected in the
Context list box so that the Include Global checkbox is not active. You
must select a different command context to make the Include Global
checkbox active.

3. Click Keyword Filter to display the Keyword Filter dialog box.

4. Say or type a letter or word of the command you are looking for in the Choose word box.

The list below the box scrolls to the first instance of that letter or word in the list. (If the

letter or word exists, it is selected. If the letter or word does not appear, then there is no

command in the current context that uses them.)

5. Double click on the word in the list or click Add to add the word to the Current list of

filter words box.

6. If necessary, continue to enter words into the Choose Word box and add them to the

Current list of filter words box until you have added as much of the specific command as

you can.

7. Click or say "Done." The Command Browser displays the commands containing the

words you entered, if any command containing all of those words exists.

Example

To see if there is a command that changes a font to bold in Microsoft Word 2010:

1. Select Microsoft Word 2010 from the Context list box.

2. Click or say "Keyword Filter."

3. Say or type the word "Bold" and then say "Add" or click the Add button to add it to the

Current List of Filter Words box.

4. Say or type the word "Set" and then say "Add" or click the Add button to add it to the

Current List of Filter Words box.

5. Click or say "Done."

The Command Browser displays all the commands that will turn text bold in Microsoft

Word 2010. For example,
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Some complex commands may not be fully visible at first. See the topic Expanding com-

mands for information on how to view all parts of a command.

Note: Previous command searches appear in the Keyword Filter list .

You can select a previous search from this list to automatically display the results of that

search, without having to open the Keyword Filter dialog box and set up the search criteria

again.

Training commands in the Command Browser
If Dragon consistently misrecognizes a specific voice command (for example, it hears "Paste

That" as "Paste dot"), you can train it to better recognize your pronunciation of the com-

mand.

To train a command

1. Open the Command Browser (say "Command Browser" or click Command Browser on

the Tools menu of the DragonBar).

2. Select the command context from the "Context" list.
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3. Locate the command you want to train and select it. See the topic Finding Commands in

the Command Browser for information on how to find a specific command.

4. Click or say one of the following buttons on the Command Browser task pane:

Button Result

Lets you immediately train the selected command. Follow the directions on the Train
Words dialog box that appears.

Adds the command to a list of commands of the Train List for later training. By select-
ing Train Later, you activate the Train List button.

Displays the Train Words dialog box with a list of commands to be trained. If you have
untrained commands in the Train List when you close the Command Browser, Dragon
offers you the choice to train them before you exit.
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The Dragon Glossary

Use this glossary for a list of terms specific to Dragon.

.DRA files (definition)
Dragon Recorded Audio (DRA) files. If your edition supports it, Dragon automatically saves

audio and text transcripts of your dictation in the DRA files.

Dragon Accuracy Center (definition)
Offers a central location for tools you can use to personalize your vocabulary, improve acous-

tics, find or manage commands, or get more information about improving your accuracy.

Click the links to open the related Dragon tools.

To open the Accuracy Center, say “display Accuracy Center” or click Help > Improve My

Accuracy on the DragonBar.

Accuracy Slider (definition)
A sliding control that Dragon uses to adjust speed relative to accuracy as it performs speech

recognition. A higher accuracy setting means that Dragon may take longer to display your

text, while a higher speed setting means that Dragon displays the text more quickly.

Accuracy Tuning (definition)
A process Dragon can use to adapt to your usage. Once you have been dictating for a period

of time, Dragon uses Accuracy Tuning to automatically refine your User Profile, analyzing

your dictation, corrections, commands, and any other acoustic training you have done. Accu-

racy Tuning uses two of Dragon's accuracy tools, the Acoustic Optimizer and the Language

Model Optimizer, and you can schedule them to run automatically.

Acoustic and Language Model Optimization
(definition)
Increases User Profile accuracy based on
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n accumulated acoustic data from your corrections and any additional training you have

performed

n commonly used word sequences extracted from your User Profile's .DRA files.

Acoustic Optimizer (definition)
Looks for any corrections you have made or additional training you may have performed

since you created your User Profile or ran the optimizer. Optimization enhances recognition

accuracy and helps predict words most likely spoken in a given context by a speaker (the lan-

guage model).

Active vocabulary (definition)
A list of about 150,000 words that Dragon loads into your computer’s random access mem-

ory for immediate use during dictation. These are the words that Dragon is most likely to

recognize on the first try, without requiring you to do anything extra such as correcting the

words with the Correction menu.

The number of words in the active vocabulary always remains the same. When new words

are added, words that have not been used recently are removed from the active vocabulary,

but remain on the computer's disk in the backup dictionary.

Advanced Scripting (definition)
Supports using programming languages such as Microsoft® VBA to create commands that

can perform virtually any function on the computer with voice commands.

Anchored (definition)
Indicates that the Dictation Box is attached to the an unknown text field where you are dic-

tating. You can reposition the Dictation Box as required. When using Anchored Mode, Hid-

den Mode is disabled.

AutoTranscribe Folder Agent (definition)
A feature of Dragon Professional, Legal and Medical editions which automatically detects

and transcribes recordings copied to a specified directory. Use the AutoTranscribe Folder

Agent to specify which Dragon User Profile to use for transcribing the recordings found in

the specified directory, and to specify where to put the text files created from the record-

ings.

Base Vocabulary (definition)
The initial Vocabulary a User Profile is based on. Vocabularies can be the following sizes.

Specialized medical and legal vocabularies are also provided in the Dragon Medical and

Legal editions.
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Vocab-
ulary

Processor
speed

Number of
processors

RAM Recommended Acoustic Model

Large ≥ 2 GHz 1 1 GB BestMatch III

> 1 > 1 GB BestMatch IV

Medium 2 GHz 1 < 1 GB BestMatch III
or
BestMatch V
Note: BestMatch V acoustic models
are not recommended for use with
the large vocabulary in U.S. English
profiles due to the larger file size of
the vocabulary in RAM (552 MB). You
can choose the large vocabulary
from the Choose Models - Advanced
dialog box.

Note: If you don't need to use an extensive vocabulary, you can increase rec-
ognition speed by choosing the medium vocabulary.

Empty Dic-
tation

Designed for use by value-added resellers who want to create specialized
Vocabularies from scratch. Consists of a Vocabulary with a language model with
no words.

Basic Text Control (definition)
The level of dictation control available in programs or windows that are not fully compatible

with Dragon. Normally you can dictate and use Dragon voice commands in any text window

of any application. However, you may occasionally find an application or a specific window

in an application where some voice commands won’t work or won't work consistently.

When the insertion point is in a window that has Basic Text Control, the Text Control Indi-

cator on the DragonBar turns gray .

Backup dictionary (definition)
A store of about 150,000 additional words in Dragon's vocabulary. A typical large Dragon

vocabulary consists of about 300,000 words and Dragon loads about half of those it under-

stands that you are more likely to dictate into your computer's random access memory for

immediate use. The list of words Dragon loads into memory is called the "active vocabulary."

You can move frequently used words from the backup dictionary into the active vocabulary

or add new specialty words, proper names, acronyms, and unusual abbreviations using any of

the following methods:
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n Add new or frequently used words and teach Dragon about how frequently you'll use

them with the Learn from Specific Documents, Learn From Sent E-mails, and

Import lists of words or phrases tools

n Use the Correction menu to correct the error

n Correct dictation errors using the mouse or keyboard (the microphone can be on, off,

or asleep)

n Use the Spelling window to spell the word

Remember to save your User Profile to keep your changes. will

Command Browser (definition)
A window showing voice commands that Dragon recognizes, including commands that are

provided with the software as well as any commands that you or your system administrator

might have added (custom commands). The Command Browser is the most comprehensive

place to see the commands that are available in each application.

Command Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as a com-

mand and nothing is interpreted as dictated text. Say "Start Command Mode" or "Command

Mode On."

Correction menu (definition)
Shows Dragon’s best guess for alternatives to words you dictated and selected. Choose the

correct word from the Correction menu by saying “Choose” and the number next to your

choice.

Correction-only mode (definition)
Enables transcriptionists to play back a Dragon user's dictation without having their User

Profile loaded. Note that dictation is disabled if you select this option.

Dictation is not available in Correction Only Mode.

Custom word (definition)
A new word you add to the base Vocabulary using the Train command or the Add com-

mand in the Vocabulary Editor. You can also add words to the Vocabulary using the Spell-

ing Window or the Add New Word or Phrase command on the Vocabulary menu.

In the Vocabulary Editor, a red cross next to a word indicates that it is a custom word

that has been added to the Vocabulary.

Data Collection (definition)
Helps to improve the accuracy of future versions of Dragon NaturallySpeaking and Dragon

Medical. By enabling Data Collection, you can allow Dragon to collect up to 500 MB of
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acoustic data and text from your dictation sessions. If you agree, the data can be sent to

Nuance at a time scheduled by your network administrator. Data Collection does not include

any personal data, and participation is completely voluntary.

Data Distribution Tool (definition)
Enables developers to interactively create new words, customized Vocabularies or com-

mands, and to make them available to all User Profiles on a particular Dragon Nat-

urallySpeaking installation.

Dictation Box (definition)
Provides full support for dictating and editing text in an unknown text field. The

DictationIBox supports voice commands like Delete, Correct, and Insert, and custom com-

mands as well. When you are finished, the content is transferred to your cursor position

when you opened the Dictation Box.

Dictation Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as dictation

and only Dictation Commands are recognized. Dictation Mode can be helpful if you want to

dictate as quickly as possible, or dictate without looking at the words Dragon transcribes. Say

"Start Dictation Mode" or "Dictation Mode On."

Dictation Source (definition)
An audio input device or multiple devices associated with a User Profile. For example, you

can select a headset microphone at one computer and a portable recorder or another style of

mic at other computers. This way, Dragon supports users who need to move, or “roam”,

from computer to computer regardless of the microphone type or differences in ambient

noise.

Direct Editing commands (definition)
Voice formatting and correction commands such as “italicize <XYZ>” or “bold <XYZ>”.

Direct Editing commands (formerly called Quick Voice Formatting commands) are faster

than conventional commands, because they tell Dragon to go to other places in your doc-

ument, apply formatting there, and return the cursor back to where you are working.

DragonPad (definition)
Dragon’s built-in word processor, optimized for dictation and includes basic text formatting

features as well as the ability to save and print documents.

Dragon Templates with Voice Fields (definition)
A special kind of custom form available to paste into applications by voice, providing fields

for common variable information that you can fill in by voice.

265



The Dragon Glossary

Dragon Voice Shortcuts (definition)
Dragon voice shortcuts collapse common multi-step tasks into direct voice commands that

you can say at anytime, no matter what is active on your screen.

For example, you can immediately switch to and start a new task, such as search the Web or

your computer, or compose an e-mail or set up an appointment.

Enterprise Profile Management (definition)
Enables you to dictate with Dragon from different network locations and on different com-

puters without having to create and train individual User Profiles at each location. When

Enterprise Profile Management (also known as Roaming) is enabled and a Dragon user

creates a new User Profile, the new profile is a Master Roaming User Profile, which is then

available from a network location. When you open the Roaming Master User Profile,

Dragon downloads it to the local system and maintains it locally during your dictation ses-

sion. Dragon synchronizes the local copy of the Roaming User Profile with the Master

Roaming User Profile when you save and close a dictation session.

Field (definition)
A field, also referred to as a variable field, is an alphanumeric string enclosed by text delim-

iters. For example, the following sentence appears in the Dragon CCU fellow admit tem-

plate included in Dragon Medical: The patient was seen in conjunction with Dr.

[ProviderName]" In the example, "[ProviderName]" is the variable field, the square brackets

are the default delimiters, and the text string "ProviderName" is the variable that the

Dragon User Profile will replace with a provider name when using the template to complete

a report.

Full Text Control (definition)
Refers to the level of dictation control available in Web and desktop programs and windows

when Dragon fully supports creating, editing, and formatting content. When a program or

part of a program has Full Text Control, you can move the cursor reliably – for example, to

the beginning or end of a line or paragraph. You can also select, format, and revise text as

needed using Direct Editing commands or the Correction menu.

For support Web applications, Full Text Control is activated using Rich Internet Appli-

cation extensions in supported browsers.

The Text Control Indicator displays on the DragonBar and is green when all of Drag-

on's selection and dictation capabilities are supported.

Hidden Mode (definition)
A recognition mode that causes Dragon to send all recognized text to the Dictation Box,

which is active but does not display. All recognized text is added to the Dictation Box,

regardless of the cursor location. Hidden Mode is often used by healthcare providers who
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are dictating medical reports to be sent to a medical transcriptionist/editor. Say "Start Hid-

den Mode" or "Start Hidden Mode."

Language Model (definition)
Contains statistical information that predicts which words are most likely to occur in the con-

text of the user’s speech.

Language Model optimization (definition)
Updates the language model of the current Vocabulary. Language Model Optimization uses

text Dragon extracts from the .DRA files that are created when you correct words. Based on

the speech data collected, Language Model Optimization applies modifications to the lan-

guage model to reflect your word usage.

Language Model Optimizer (definition)
Performs Language Model Optimization from the Accuracy Center. Any Dragon user with

administrator privileges can schedule Dragon to perform optimization periodically.

Local Roaming User Profile (definition)
A copy of the Master Roaming User Profile that Dragon downloads to your local computer

and temporarily maintains during dictation sessions. Dragon's Roaming feature synchronizes

the Local Roaming User Profile with the Master Roaming User Profile when you save and

then close your local profile.

Master Roaming User Profile (definition)
A User Profile stored on a network computer accessible using the Dragon Roaming feature.

Dragon users can have one or more Master Roaming User Profiles that can be opened from

multiple networked machines that run Dragon. When a user on a local computer opens a

Master Roaming User Profile from a central network computer, Dragon transfers a copy of

the Master Roaming User Profile to the local computer. The local copy is called the Local

Roaming User Profile.

MSI (definition)
Delete this text and replace it with your own content.

Multiple Dictation Sources (definition)
Delete this text and replace it with your own content.

NaturalText (definition)
Delete this text and replace it with your own content.
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Natural Language Commands (definition)
Provide greater flexibility in the wording you use to perform common actions in a variety of

applications such as Microsoft Word, Internet Explorer, and Mozilla Firefox. Instead of

requiring users to memorize specific commands, such as "bold that," the Natural Language

Commands give you a wide range of words you can say to execute a command. For exam-

ple, "make that bold," "bold the last paragraph," "set font bold" all do the same thing, as do

many more conversational commands. To know which commands work in an application,

open the application and say “What Can I Say?”.

Normal Mode (definition)
Dragon's default mode of dictation. In Normal Mode, Dragon distinguishes dictation from

words, numbers, and commands by analyzing what you say between pauses. Say "Start Nor-

mal Mode" or "Normal Mode On."

Nothing But Speech (definition)
Suppresses recognition of non-word fillers like “ums” and “ahs” that you don’t normally

intend to include in your dictation.

Numbers Mode (definition)
A restricted recognition mode that causes Dragon to recognize only numbers. If you are dic-

tating only numbers (including currencies), working in this mode increases recognition accu-

racy. Say "Start Numbers Mode" or "Numbers Mode On."

Performance Assistant (definition)
A resource available from the Help menu that offers suggestions for optimizing Dragon’s

speed on your computer. As you click or say the corresponding links to answer questions

about how you normally use Dragon, the PerformanceIAssistant provides suggestions and

methods for optimization.

Press <key> command (definition)
Used to make keystrokes by voice. To type characters by voice, say "Press," "Press Key," or

"Type" followed by the name of the key or keys you want to press. For example, say “Press

Escape” or “Press Enter”, or “Press Ctrl Right”.

QuickStart (definition)
Allows Dragon to load in the background when you start your computer or log in to your

operating system, depending on your version of Windows. When Dragon is launched in

QuickStart mode Dragon is available for use more quickly than when you start in normal

mode. The microphone icon appears in the system tray.
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Recognition Modes (definition)
By default, Dragon functions in Normal Mode, distinguishing dictation from words,

numbers, and commands, and analyzing what it hears between pauses. Dragon also offers

restricted recognition modes for dictating only commands, numbers, characters (Spell Mode),

or words (Dictation Mode).

Results Box (definition)

A floating display box that Dragon can provide as it listens to

you and processes your speech. You can set options to move the Results Box anywhere on

the screen, keep it in one place, change its color and font size, or make it disappear after a rec-

ognition.

See About the Results Display for details.

Results Display (definition)
The on-screen feedback that Dragon displays during dictation. While Dragon listens, the Rec-

ognition in Progress icon displays. When you pause, Dragon finishes processing your

speech and enters dictation into the document or executes your command. When recognition

is complete, the Dragon idle icon displays. See also Results Box.

Rich Internet Application (RIA) extensions
(definition)
Provide Web application extensions in supported Web browsers to enable commands and

Full Text Control in selected browser-based applications. With RIA extensions, you can dic-

tate content and use commands just as you would in a desktop program.

Roaming User Profile (definition)
See Master Roaming User Profile.

Sample Commands (definition)
Displays a selection of the most useful commands that Dragon recognizes for the current con-

text, whether it is a particular program you are using or the Windows Desktop. The Sample

Commands are contained in the Dragon Sidebar. You can open the Sample Commands by say-

ing “What Can I Say?” or by clicking Help > Dragon Sidebar.

Say What You See (definition)
"Say What You See" means that you can say whatever commands you see labeled on your

screen to control applications by voice. For example, you can say the names of menus, menu

commands, or items in a dialog box. To display the Insert menu in Microsoft Word or
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Microsoft Excel, you would say "Insert," and then say the name of any of the available com-

mands, as required. Another example is the ability to open a Desktop item (a folder, for

instance), by saying “open” followed immediately by its name.

Scripting (definition)
Dragon scripting language extensions provide a set of tools for creating voice commands.

Creating scripting commands requires familiarity with the Microsoft Visual Basic pro-

gramming language.

Section 508 certified (definition)
Delete this text and replace it with your own content.

Unknown text field (definition)
An editable window or field that does not support all of Dragon's selection and correction

capabilities. When the cursor is positioned in an unknown text field, the DragonBar displays

the message "Unknown text field; consider using 'show Dictation Box' - See Help.'" In

those cases, Dragon's Full Text Control indicator, the colored ball next to the volume meter

on the DragonBar, is grey. You can usually select, correct, and use various commands in

unknown text fields, but if you have trouble, use the Dictation Box and transfer text from it

into the application.

Windows shortcut (definition)
You can use Windows Shortcuts and command lines to open User Profiles and Vocabularies

directly.

Spell Command (definition)
Delete this text and replace it with your own content.

Spell Mode (definition)
A restricted recognition mode that causes Dragon to recognize only letters, numbers, com-

mands, and punctuation. Spell mode is useful for dictating unpronounceable alphanumeric

strings, such as part numbers and license plate numbers, and other terms you anticipate

Dragon won’t know, such as Web addresses, words in a foreign language, or unusual prod-

uct names. Say "Start Spell Mode" or "Spell Mode On." You can still use commands while

in Spell Mode.

Spoken Form (definition)
Refers to words that are spoken one way but written a different way (the Written Form).

This feature lets you add a word that, for example, types your phone number whenever you

say “phone number line,” or automatically adds punctuation, such as "UK" or "USA," which

would normally include punctuation in the written forms (U.K. and U.S.A.).
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Structured Commands (definition)
Used to control the action of a command based on the existence of a state in the application

the command is used for. For example, when you assign a state to each field in a form, the

same command can perform different actions, depending on which field is activated. You can

use Advanced Scripting methods to control the states within structured commands or to set

the initial state from a non-structured command. You can also create structured commands

that prompt the user to select values from a predefined list. Structured Commands are avail-

able only in Dragon Professional, Legal, and Medical editions.

Text Control Indicator (definition)
The check mark icon that appears next to the volume meter on the DragonBar. The Text

Control Indicator changes color to show the level of dictation support in your current appli-

cation. The Text Control Indicator is green when all of Dragon's selection and dictation

capabilities are supported and gray when the insertion point is in a window that has less

support for dictation. The current Recognition mode is indicated by the icon to the right of

the check mark.

Templates (definition)
Delete this text and replace it with your own content.

TTS (definition)
Delete this text and replace it with your own content.

Unanchored (definition)
An administrative setting for using the Dictation Box in unknown text fields. When the Dic-

tation Box is unanchored, to capture text it must be either the active, visible window in the

foreground with the cursor placed there, or, when it is not visible, you must use Hidden

Mode.

User Profile (definition)
A User Profile is a set of files that store the following information:

n Audio system settings selected by the Check Microphone wizard

n Acoustic information about your voice gathered during initial product training, ongo-

ing usage and when you train specific words

n Ongoing adaptations to your Vocabulary words and word usage as you use Dragon and

from analysis of your writing style

n Your settings in the Options dialog box

n Any custom voice commands
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Utterance (definition)
Dictation or commands Dragon recognizes between pauses in your speech.

Variable (definition)
See Field

Vocabulary (definition)
Contains all of the words that Dragon recognizes and a Language Model. The Vocabulary

includes all of the words in the active vocabulary and the backup dictionary, and any words

added as you customize your User Profile.

Vocabulary Editor (definition)
Delete this text and replace it with your own content.

VocTool
Delete this text and replace it with your own content.

Voice Notations (definition)
Delete this text and replace it with your own content.

Wave Data (definition)
Delete this text and replace it with your own content.

Web application support (definition)
Provides Rich Internet Application (RIA) extensions in supported Web browsers to enable

commands and Full Text Control for selected browser-based applications. With RIA sup-

port, you can dictate content and use commands just as you would in a desktop program.

Word Category (definition)
Delete this text and replace it with your own content.

Word Properties (definition)
Word Properties specify a variety of options that can be associated with Vocabulary entries.

You can specify that a word be preceded or followed by specific characters and customize

properties for placement or handling. For example, question marks and exclamation marks

have default properties of "Precede by (nothing)" and "Format the next word capitalized."

You can also specify one or more alternate written forms for words. If the Use Alternate

Written Form checkbox is selected for "meter," when you dictate the word after a number,
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Dragon enters only "m." If the Alternate Written Form checkbox is not selected, and you dic-

tate "meter," Dragon types the full word, "meter."

Written Form (definition)
Specifies the word or words that Dragon enters when you dictate. The spoken form can be

an easier or shorter variant or something completely different from the written form.
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formatting text 159

scrolling in 128

working with 155

working with content 160

Microsoft Hotmail 170

Microsoft Infopath

scrolling in 128

Microsoft Office

scrolling in 128

using the ribbon 128

Microsoft Outlook 149, 151-152

adding contacts 151

commands for 149, 151-152

Email and Calendar commands 145

making appointments 151

reading and sending e-mail 149

scrolling in 128

working with 149

writing notes 152

Microsoft Outlook Express 147

commands for 147
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reading and sending e-mail 147

Microsoft PowerPoint

scrolling in 128

Microsoft Windows

system requirements 26

Microsoft Word 134, 140

basic document commands 134

commands for 134, 140

formatting text 140

selecting text in 139

working with 134

Military time 219

minimum and recommended system requirements 26

minimum processor cache 27

minimum RAM 27

minimum system requirements 26

misrecognized commands 96

mobile device

choosing a speech device 63

modes

recognition

definition 269

using 224, 226

recognition (using) 224

mouse

clicking 209

mouse pointer 207-208

dragging 209

moving 207

moving with MouseGrid 208

MouseGrid 208

using to position the mouse pointer 208

Move to

commands 108

moving 106, 207-208

around a document

quick reference 106

the cursor 106, 108

the mouse pointer 207

the mouse pointer with MouseGrid 208

to the beginning or end of a document or line108

Mozilla Firefox

commands 186

switching between frames 186

using tabs 191

MSI (definition) 267

Multiple Dictation Sources (definition) 267

multiple text matches

correcting and editing 99

Multiple text matching commands

applying to multiple words 99

N
naming 252

Vocabularies 252

Natural Language Commands 132

definition 268

NaturalText (definition) 267

navigating 197-200

between windows 196

buttons and dialog box options 198

going back to your last location 109
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icons 200

in documents 108

menus 197

opening programs and documents 193

tabs in a dialog box 199

Web applications commands 163

Windows Desktop commands 195

new words 231, 235

adding a list of to the Vocabulary 28

adding to the Vocabulary 231

adding with the Spelling window 235

Non-standard (definition) 270

Non-standard windows 83

dictating text in 83

Normal Mode 224, 226

switching to 226

using 224

Normal Mode (definition) 268

Nothing But Speech (definition) 268

numbers 80, 120

changing format 120

dictating 80

forcing recognition of 80

Numbers Mode 225-226

switching to 226

using 224

Numbers mode (definition) 268

O
Office

scrolling (in Microsoft) 128

using the ribbon 128

Office ribbon

using Microsoft 128

online Help

opening and using by voice 51

opening

a different Vocabulary 250

icons by voice 200

menus 197

programs (and exiting) 193

the Command Browser 256

OpenOffice.org Writer

commands for 139

selecting text in 139

Operating systems 27

optimizing

acoustics and language model 222

Outlook 149, 151-152

adding contacts 151

commands for 149, 151-152

E-mail and Calendar commands 145

making appointments 151

reading and sending e-mail 149

scrolling in 128

working with 149

writing notes 152

Outlook Express 147

commands for 147

P
paragraphs 121

adding new 121

selecting 112
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Paste command 115

Performance Assistant (definition) 268

personalizing Vocabularies 231, 234

phrases

correcting and editing multiple matches99

pointer 207-208

moving with mouse commands 207

moving with MouseGrid 208

positioning

text in a document 121

postal codes 215

dictating 80

postcodes 215

PowerPoint

scrolling in 128

Press <key> command 205

Press <key> command (definition) 268

processor cache 27

programs

exiting 193

starting 193

switching 195

switching between open programs and windows202

Q
Quick Voice Formatting commands (definition)265

QuickStart (definition) 268

R
Read text to train Dragon to your voice 229

reading and sending e-mail

Gmail 168

Hotmail 170

Microsoft Outlook 149

Windows Live Mail 147

recognition 211, 220-222

accuracy 222

improving 211

using the Speed vs. Accuracy slider 220

accuracy: improving 211, 221

modes

using 224

recognition errors 75, 78, 93

correcting by spelling 78

correction (quick reference) 93

recognition modes

definition 269

switching 226

using 224

recommended system requirements 26

recorder

choosing 63

removing 118, 122, 237, 252

spaces between words 122

text formatting 118

Vocabularies 252

words from the Vocabulary 237

renaming 252

Vocabularies 252

requirements

minimum and recommended system for Dragon26

resizing windows 199

restoring 118

plain text 118
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Results Box

about 53

Results Box (definition) 269

Results Display

about 53

Results display (definition) 269

resuming dictation 109

resuming editing 109

revising text 103, 109, 115

deleting text 115

quick reference 103

replacing what you last dictated 109

revising multiple instances of words 99

RIA (definition) 269, 272

RIA Support

enabling 165

resolving problems with 176

using 163

using with Gmail 168

using with Hotmail 170

ribbon

using Microsoft Office 128

Rich Internet Application Support

enabling 165

resolving problems with 176

using 163

using with Gmail 168

using with Hotmail/Windows Live Mail170

Rich Internet Application support (definition) 269,

272

right aligning text 121

Roman numerals

dictating 80

S
Sample Commands

Dragon Sidebar (definition) 269

using 67

Say What You See (definition) 269

Scratch That command 115

Scripting (definition) 270

scrolling

in Microsoft Office programs 128

in popular programs 128

in windows and lists 200

searching

the online Help by voice 51

the Web 182

your Desktop 201

Section 508 certified (definition) 270

Select Again command 113

selecting 198-200

buttons by voice 198

icons by voice 200

menus 197

tabs in a dialog box 199

selecting text 110-111, 113

again 113

characters and words 110

correcting incorrectly selected text 113

handling multiple text matches 98-99

in Microsoft Word 139

in OpenOffice.org Writer 139
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lines and paragraphs 112

quick reference 110

specific words 111

using Direct Editing 98

using multiple text matching 99

sharing 253-254

Vocabularies with other people 253-

254

shortcuts

see Dragon Voice Shortcuts (definition)266

Shortcuts

Dragon Voice, Desktop searches 201

Dragon Voice, e-mail and calendar commands145

Dragon Voice, Web searches 182

Show Web Site Commands 164

Sidebar

definition 269

showing and hiding 67

tabs 70

Tips 72

using 67

sites

searching 182

size

setting font 120

Smart Format Rules

disabling display 213

using 213

sound card

audio requirements 28

spaces

removing between words 122

special folders

opening 195

speech

status, results display 53

speech device

choosing 63

speed 220

increasing recognition 220

Speed vs. Accuracy slider 220

Spell Mode 225-226

switching to 226

using 224

Spell Mode (definition) 270

Spell That command 78

spelling 78

with the Spell That command 78

words 78

Spelling window 77, 95, 235

adding words 235

choosing correct text in 95

typing the correct text into 77

Spoken Form (definition) 270

Start menu, using 193

starting programs 193

supplemental training 229

switching 251

between open programs and windows202

between windows 195

to a different Vocabulary 250
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system requirements 26

T
tabs 199

selecting in a dialog box 199

telephone numbers 80, 218

dictating 80

text 93, 115-116, 118, 121

aligning 121

capitalizing 119

correcting 75

correcting (quick reference) 93

correcting and editing multiple matches99

cutting and pasting 115

deleting 116

formatting 118

selecting 110, 139

Text Control indicator 59

Text Control Indicator (definition) 271

text wrapping 89

The recognizer has encountered an utterance that is too long to process220

time 82

dictating 80

Tips

Dragon Sidebar 72

in the Sidebar 67

using word processors 132

tools 47

training 227-228

additional 229

commands 227

supplemental 229

training individual words and phrases 228

Tray Icon only mode 62

troubleshooting

with RIA Support 176

Type <key> command 205

U
UK postcodes 215

underlining 118

applying with Direct Editing 98

applying with multiple text matching 99

undoing actions 74

USB microphones

connecting 63

User Profiles

creating recorder-based 63

using online Help with voice commands 51

utilities

starting 196

V
variants

correcting or formatting variants 99

Vocabularies 231, 234, 251-253

adding 251

adding individual words to 232

base 262

creating new 231, 234, 253

deleting 252

exporting 254

importing 253

opening 250

personalizing 231, 234
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renaming 252

restoring words to 238

sharing with other people 253-254

types of 240

voice commands

Dragon Sidebar 70

Voice Shortcuts

Desktop searches 201

e-mail and calendar commands 145

Web searches 182

W
Web 144, 181, 189, 191

applications 163

browser compatibility 165

commands 163

controlling Internet Explorer 181

dictating addresses 144

Firefox commands 186

Internet Explorer commands 186

Mozilla Firefox commands 186

searching 182

searching by voice 182

switching between frames 186

troubleshooting 164

Web application support

using with Gmail 168

using with Hotmail 170

Web application support (definition) 272

What can I say? (definition) 269

windows

navigating between 196

switching between open programs and windows202

Windows

controlling 195

Desktop commands 195

moving in 200

open special folders 195

resizing and closing 199

scrolling in by voice 200

switching between 195

system requirements 26

Vista

searching by voice 201

Windows 7

searching by voice 201

working with 197

Windows Live E-mail, using 170

Windows Live Mail 170

commands for 147

reading and sending e-mail 147

Windows shortcut (definition) 270

Word 134, 140

basic document commands 134

commands for 134, 139-140

formatting text 140

scrolling in 128

selecting text in 139

working with 134

word categories

adding 232

word processors 132

tips for using 132
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Word Properties

creating 123

Word Properties (definition) 272

words 30, 110-111, 121-122, 231-232,

235

adding to the Vocabulary 232

adding with the Spelling window 235

alternate written forms

creating 123

correcting and editing multiple matches99

deleting from the Vocabulary 237

formatting 98-99

hyphenating 121

joining 122

restoring to the Vocabulary 238

revising 98-99

selecting 110-111

spelling 78

word properties

creating 123

workflow 90

correcting text 91

working with content

Microsoft Excel 160

working with Microsoft Excel 155

working with Microsoft Outlook 149

working with Microsoft Word 134

wrapping

text 89

writing notes

Microsoft Outlook 152

Written Form (definition) 273

Z
Zip codes

dictating 80
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